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PREFACE 

This book has been written to meet the requirements of Matric-Tech to train the students in Media 

Production. This book covers various aspects and kinds of media production including 

photography, videography, script writing, and video editing. Matric-Tech in media production has 

been introduced for the first time in Pakistan. This textbook is the first effort at national level to 

describe all the topics related to media production in one book. A key attempt has been made to 

make this book interesting and useful. This book covers basic details about media production for 

students of Matric-Tech. Major objective to write this book is to prepare a technical workforce in 

the field of Media Production. Any improvements and suggestions for the betterment of this book 

will be highly acknowledged.  

This book covers all the topics to train students in the field of media production. All the topics are 

explained in a convenient way i.e., understandable to the students of Matric-Tech. The book starts 

with the basic introduction of media production, the scope of media production, and the concept 

of health & safety issues at the workplace. Afterward, hands-on knowledge of photography and 

videography is provided. Later on, scriptwriting for the media production is introduced. Video 

editing using Adobe After Effects software is also discussed in this book. Lastly, basic concepts 

related to media production management have been introduced. All chapters include assessments 

in the form of MCQs, short questions, and long questions. 

The book has been designed in such a way that the students not only can get sufficient knowledge 

about the field of media production but also can get hands-on (practical) knowledge as well. 

Students have to perform activities and tasks to get hands-on experience about different phases of 

media production. The sequence of chapters is continuity and is very convenient for the instruction 
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CHAPTER 1 

INTRODUCTION TO MEDIA PRODUCTION 

 

 

After completing this chapter, students will be able to: 

 define media 

 describe media production 

 learn about the role of media production in society 

 describe different platforms for media production 

 describe different software applications of media production. 

 understand about history of electronic media (radio, tv channels, social media, etc.) 

 know about the transformation of print media 

 learn about career opportunities in different industries 

 learn about job roles for media production 

 know about collaboration of media production with other industries (education, textile, 

fashion, etc.) 
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1.1. Media 

Media is defined as a way of communication. Word media is plural of ‘medium’. The medium can 

be anything like newspaper, radio, television, and social media. This wide term also covers digital 

data as well as other forms of information. 

Anything that can affect or influence people, including the telephone, television, and the Internet, 

can be considered a form of media. For example, watching news on TV or watching an ad of 

shampoo is considered as media.  

Media can be used to share information and communicate between people. People use several 

forms of media every day. Digital newspapers, internet magazines, podcasts, and blogs all fall 

under the category of digital media. Everything that you see on the internet constitute digital media. 

It also includes social sites for example Facebook and Twitter, etc. Categories of media are as 

under: -  

 Print Media 

 Electronic / Digital Media 

 

The definition of media is not limited to digital media. This term of media is also known as Mass 

media. Mass Media can be well-defined as a technology which is used to communicate or reach a 

mass audience. Mass media is the primary means of communication for the general public to 

communicate with each other like film, radio, books, music, or television. This kind of media 

Figure 1: Media in abstract terms 
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Activity 

list few examples of mass media being 

used in your locality. 

 

involves engaging the community by means of listening and watching the desired message.   The 

audience is not required to respond immediately through any source. 

Mass Media is important in modern cultures. Sociologists refer to this as a ‘mediated culture’ 

where media reflects and creates the culture. The purpose of mass media is to influence the 

community that is watching it. 

1.1.1. Types of Mass Media 

The Following are the types of mass media. 

1. Traditional Media 

2. Print Media 

3. Electronic/Broadcasting Media 

4. Outdoor Media or Out of Home Media (OOH) 

5. Transit Media 

6. Digital Media/New Media/Internet 

 

 

Figure 1.2: Mass Media 
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1.2. Media Production 

Media production generally means the making of a motion picture, television show, video, 

commercial, internet video, or other viewable product provided to viewers via a movie theater or 

transmitted through broadcast radio wave, cable, satellite, wireless, or internet. 

Mass production is about understanding how to produce media for public. Media of any kind needs 

proper guidance so that the viewer can get the proper message. The meaningfulness of media 

content will help in building a good society. 

The process of production refers to the phases required to complete a media product, from the idea 

to the final product. The process can be applied to any type of media production including film, 

video, television, or audio recording.  

The phases in each medium may vary according to the demands of the producer and audience as 

well. Students should be trained on software tools to make them more skillful in the field of media 

production. 

1.1.2. Phases of Media Production 

Phases are steps that are used by media producers to produce good content. In media production, 

one has to go through three phases. Each phase has its sub-phases from idea to creation. Here are 

the three main phases of media production: 

Pre-production: Pre-production includes Planning, scripting & storyboarding, etc. Planning is 

drafting the rough ideas. The early thoughts you get from a topic need organization. When you 

organize your initial ideas, then you can start a scripting process. A script requires detailed 

knowledge of the subject matter. The more knowledgeable you are, the better scripting can be 

performed. After scripting, a good storyboard is prepared. A storyboard is a minimized version of 

your plan. It is created using a model or software program. As shown in Figure 1.3 below: 
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Figure 1.3: Pre-Production Phase 

Production: The production phase is about shooting the actual idea that was planned during the 

pre-production phase. The shooting of your idea requires multiple types of equipment. The people 

who are involved in a production scene are known as the production crew. As shown in Figure 1.4 

below: 

 

Figure 1.4:  Production Phase 

Post-production: Everything between production and creating the final product. The post-

production phase has a lot of people involved. There are editors, sound directors, musicians, 

production directors, and scriptwriters. This phase is the longest because the product needs to be 

reviewed well. Figure 1.5 represents the post-production phase. 
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Figure 1.5: Post-Production Phase 

 

1.3. Role of Media Production in Society 

Media is the most important aspect of our society. People living in a society are interacting with 

each other every single day. They communicate their ideas, interests, and hobbies with others. 

Media shapes the thinking patterns of people in a society. 

1.3.1 Print Media and Society 

Print media has impact on people to think about certain things in ways they never think before. 

Journalists write columns to highlight problems in society. The power of journalism is really strong 

in our society. Journalists are experts in particular fields. They have experience of culture of 

society and also have sufficient knowledge that helps the reader. A good journalist conveys the 

message without getting harsh.  In order to enjoy credibility in the society, a journalist has to be 

well informed as well as unbiased. 

  

Do You Know: 

Other notable stages include Financing, Screenplay and Distribution 
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1.3.2 Radio and Society 

Radio was invented in 1896 by Guglielmo Marconi. It is a faster medium for conveying long 

distance messages as compared to print media. Since its invention, Radio has played an important 

role in spreading knowledge and awareness among the masses. It also became a powerful tool for 

entertainment purposes. In these roles, Radio has been playing a key role in framing a mindset of 

the overall society. Radio is also used as a powerful tool for spreading agendas. Advertisement is 

yet another use of this powerful medium.  

Radio has been listened in both urban and rural areas of Pakistan but with the spread of TV and 

internet, its popularity is becoming on lower scale. Radio programs are designed to fulfill the 

cultural, religious, social, and political needs of the public. The programs are aired in different 

regional languages spoken in different parts of Pakistan.  

1.3.3 Electronic Media in Society 

Television is yet another powerful medium in our society. TV has become a necessity of every 

home these days. Many people have direct or indirect jobs associated with electronic media. The 

programs on TV are carefully designed to address the social, cultural, religious or entertainment 

needs of the society. Religion and culture are usually shown to instill the ideology of the state 

among the masses. Pakistan Electronic Media Regulatory Authority (PEMRA) is responsible for 

monitoring and regularization of the content of electronic media in Pakistan. 

1.3.4 Media as a Promotion Tool  

Media is often used for promotional purposes. Media industry contributes to build the image of 

Pakistan among the league of nations. People around the world know about a certain place through 

media.  

Media is also a powerful tool to spread education in different parts of a state. In the case of 

disasters, role of electronic media becomes more important. During and after COVID-19, role of 

electronic media in spreading awareness has boosted a great deal.  Government and private 

organizations run their advertisements to spread awareness in public. Covid-19, awareness and 

precautions were successfully spread using the TV. People can understand the conveyed messages 

easily through media.  
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The polio eradication campaign has also been initiated by the media under government policy. 

Another example is the dengue fever awareness program that is being run with the help of the 

media. We can say that media is the pool of all modern information resources.  

1.3.5 Social Media and Society 

During the past two decades, social media has grown a great deal. A variety of social media 

platforms are very popular today. These platforms serve the purpose of entertainment, information, 

connectivity and even business. Communication can be formal or informal. A lot of people can 

also formally establish businesses on social media.  

Social media marketing is an emerging field and contains all the tools that help novices to sell 

products.  

 

 

 

1.3.6 Disadvantages of Media in Society 

There are also some disadvantages of media as mentioned below:-  

 People can waste their time watching unnecessary programs. 

 Sitting for hours may affect viewers’ health. 

 Media is sometimes used to propagate the false political / religious agenda among the 

people. 

 Some media programs may be inappropriate for different grade and age levels 

 All the media news and information may not be reliable and valid. For authentic and 

reliable information, we must validate its integrity using other authentic resources. 

Stage1

• Print Media

• Radio (Early 1900s)

Stage 2
• Television / Electronic Media(Late 1940s)

Stage 3
• Social Media(Late 1990s)
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1.4. Platforms for Media Production 

A media platform is a service, site, or method that delivers media to an audience. This involves all 

major types of media, Print media, electronic media, and social media. These all are used to 

disseminate information among people. Social media nowadays is popular. People have cellular 

connections, and they can reach information in a fraction of seconds.  

1.1.3. Print Media 

Newspaper 

Newspapers have traditionally been an important part of civil society, providing information to 

citizens. Newspapers convey the news to groups about events and issues. Newspaper is a source 

of information as well as a place where critiques use it as a tool to highlight injustices of society. 

There are almost eighty newspapers being published in Pakistan. The most popular English 

newspapers are Dawn News and The News etc.  The most popular Urdu newspapers are Jang and 

Nawa e Waqt etc. 

1.1.4. Electronic Media 

Television 

Television is a system for transmitting visual images and 

audio that are reproduced on screen. It is used to broadcast 

programs for entertainment, information, education, and 

religion. The television set has become routine in many 

households, businesses, and institutions. Television is also a 

major tool for advertisement. 

Activity 

Group Discussion on role of media production in society and Quote Examples from real life 

scenario. 

A discussion activity for students to share their favourite media type with fellows. Also state 

some advantages of media in society. 
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Some notable categories of TV channels in Pakistan are; entertainment, kids, sports, education, 

news, and religion. Major news channels in Pakistan are PTV news, Geo news and ARY news etc. 

Some other channels include QTV, PTV Sports, ATV etc.  

 

 

 

1.1.5.Social Media  

Social media is revolutionary media. It emerged in the late 1990s when yahoo provided the first 

communication platform for people. Social media became most popular since the advent of cellular 

phones. 

Social media platforms have many categories. Some are based on functionality like textual 

messaging, video calling, sending voice notes, and many more.  

Some of the examples of social media are stated below: 

YouTube is the biggest platform for searching videos of almost any kind. YouTube provides you 

with the facilities as a search engine. You can also learn educational material from this platform.  

Facebook is most famous platform being used to create and interact with family, friends and other 

communities of our choices. It also has some business-related integrations for small and large 

businesses. 

Instagram is a platform for people who enjoy taking pictures and making an album of their daily 

life. People usually use Instagram for their daily blog while sharing a picture with some captions. 

Twitter is a platform for those who are more aware of current affairs and have an interest in 

microblogging style. People interact with messages called tweets.  

LinkedIn is used by professionals or beginners to grow with other industries’ professionals. It also 

helps beginners in building their career profiles by engaging with professionals. 

WhatsApp is a free social software that allows people to connect and interact with family, friends 

and colleagues by means of text, images or videos.  

Activity 

Make lists of at least five TV channels in following categories: 

News, Entertainment, Sports, Education and Religion. 
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Pinterest is a famous platform for graphics designers and illustration artists. They use this platform 

to showcase their artwork and illustrations. The registration on this platform is also free of cost. 

 

 

1.5. Software Applications for Media Production 

Software is used to ease the work of media production. Adobe Creative Cloud (Adobe CC) is the 

most widely used software, which includes the latest versions of industry-standard software. This 

suite has other software as well such as Photoshop, Illustrator, InDesign, Premiere Pro, and After 

Effects etc. 

People also practice on a variety of other software including Microsoft Office, Final Cut Pro, 

Motion, Compressor, Camtasia, Red Giant effects suites, and several other high-quality 

applications including open-source apps.  

The software used in this book is Adobe After Effects which will be discussed in detail in later 

chapters. Here is a list of some more software that you might find helpful while practicing media 

production: 

Software Usage 

Power Director To create animation/ multimedia 

Protool To edit sound 

Quark Express To layout page 

CorelDraw / Photoshop Graphic Design 

FCP Audio/ Video Production 

WriterDuet For screenwriting software 

PreProCloud For budgeting and scheduling 

WrapBook Payroll and accounting-related tasks 

Sharegrid For equipment renting on the production side 

Frame.io. For post-production work 
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1.6. History of Electronic Media 

The earliest forms of print media were found in ancient Rome. The citizens were informed via 

handwritten notes and read loudly in public areas. The invention of the printing press has stopped 

this manual writing process.  

In the mid-1800s, the invention of the telegraph changed monopoly of print media. Suddenly, the 

information started to be transmitted in a few minutes. 

In 1895, the Italian inventor Guglielmo Marconi became the first person to “cut the cord” of 

electronic communications, sending wireless signals across the Italian countryside Print 

Newspaper 

With the invention and widespread use of television in the mid-20th century, newspaper circulation 

steadily declined. In the 21st century, more people enjoy internet news sites and other forms of 

new media which declined further the importance of newspapers.  

This adjustment in the role of newspapers as a source of information seems to had a significant 

impact on the world. To attract large audiences and maintain offerings, information must be 

available to a highly diversified audience with a high level of proficiency of scope and neutrality. 

With the demise of newspapers, news sources have become more complex, providing each 

audience group to decide whatever they want to hear and what they don't need to hear. 

To stay relevant, newspapers are also being published on Internet.  

Television and Radio 

Radio transmission was transformed towards television, Both of these mediums shape people's 

lives in much the same way. Either way, you can enjoy the news (and entertainment) at home, with 

immediacy that newspapers cannot provide. 

Television has a powerful socializing effect, providing reference groups while reinforcing social 

norms, values, and beliefs. 
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Film 

The film industry appeared in 1930s when color and sound were first incorporated into feature 

films. Much like television, the early films had a great impact by uniting the society. People were 

used to gather at the cinema to watch the new films. There they used to laugh, cry, and feel other 

emotions together. Films have diversified topics i.e., historic, documentaries, war, entertainment 

etc. Hollywood and Bollywood are the two major industries producing films for commercial 

purposes.  

Now a days, People are also watching movies online through Netflix, Hulu, Amazon, and other 

streaming services. 

1.7. Transformation of Print Media 

Transformation means to change the shape from one to another. The transformation of print media 

includes all forms of interactive information exchange. These include social media sites, blogs, 

podcasts, wikis, and virtual worlds. This list is continuously growing. However, there is no 

guarantee that the information provided is correct.  

1.7.1 Product Advertising  

Companies use advertising to sell products to consumers, but the way they reach the audience have 

been changed.  As technology and media allows consumers to bypass traditional advertising 

methods, advertising also has been changed from traditional ways towards latest technological and 

more technological methods. 

With the invention of remote control, which allows us to skip TV commercials without leaving 

our seats, traditional television commercials are emerging ‘collapse’, but, the print media are no 

such exception. 

 

Activity 

Give presentations on the topic of History and Transformation of media. Students should also 

portray the cultural values in their presentation. 
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1.8. Career Opportunities in different Industries 

Understanding each career field will help you choose the right career based on your talent, 

education, and interests.  

Arts, Culture and Entertainment 

This professional field is dedicated to enriching the lives of people through the exchange of culture, 

art, and self-expression. There are formal educational programs in these fields, but these 

occupations also include talented self-taught individuals. Part of work in this field includes: 

 Singer/songwriter 

 Music producer 

 Art curator 

 Animator/video game designer 

 Filmmaker 

 Graphic designer 

 Fashion designer 

 Photographer 

Communications 

The professional communication field is to learn the art of conveying information to different 

groups of audience. Some positions in this field includes: 

 Journalist 

 Copywriter 

 Communications manager 

 Public relations specialist 

 Meeting / event planner 

 Social media manager 

 Brand manager 

1.9. Job Roles for Media Production 

We learned in the previous section about different roles in diverse industries. The advent of 

electronic media has generated many roles for individuals and contributed to building the 

economy. The following are the jobs roles in media production industry: 

Marketing, Promotions and Advertising Managers 

These media and communications experts work to stimulate public interest in the products or 

services provided by their employers / client. They plan promotions together with department 

heads or product managers and often meet with customers to determine their needs. 
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These professionals conduct market research to understand the needs of consumers and acquire 

new audiences. Marketing managers usually have a bachelor's degree in communication or 

marketing and have strong skills in marketing trends, fashion, analytical thinking, social 

understanding, and creative problem-solving. 

Technical Directors 

These professionals convey complex messages to a wide audience or user groups in an easy-to-

understand manner. They make the abstract information easy to understand by creating easy-to-

use operating guides, instruction manuals, white papers, and other documents.  

Technical directors also ensure that the content is aligned with the needs of the company’ vision. 

The objectives of a company are fulfilled when a technical director manages things correctly. Most 

technical directors have a bachelor's degree in a communications-related field, pay attention to 

details, and have strong writing and critical thinking skills. 

Writers and Authors  

Writers and authors usually have a bachelor's degree in communications, English, or journalism, 

as well as some professional experience.  These professionals produce compelling and engaging 

content that usually attracts their audience. Some focus on fiction, while others deal with 

biographies, scripts, and lengthy articles. 

In advertising and marketing, writers create clever scripts to attract new customers or potential 

customers. In journalism, they conduct investigation reports to inform the public. 

Art Directors 

The art director is responsible for visual style and imagery for magazines, newspapers, product 

packaging, and film and television production. They create the overall design and guide others 

who develop the artwork or design. 

Editors 

Most editors come from a communications background and use their language skills or journalism 

background to supervise content production. They can manage a group of writers, usually with 

professional writing experience. Typical tasks include reviewing published content, verifying 

sources, and checking facts, as well as formulating policies related to style and tone. 
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The editor works with the scriptwriters to develop content ideas with broader strategic goals. They 

need good judgment, strong communication, and management skills. 

Reporters, Correspondents, and Broadcast News Analyst 

These reporters keep the public informed of current affairs. They study topics of general interest, 

analyze reports, and investigate stories based on editorial insights and clues. Reporters conduct 

interviews and communicate their work through news articles and commentary articles.  

Some of these professionals work in print media or broadcast journalism, but many others write 

articles for online media platforms. They need a relevant bachelor's degree, excellent 

communication skills, and some professional experience. 

Sound Technicians 

Sound technicians support other media professionals, such as journalists and news anchors, in 

ensuring that the broadcast maintains consistent quality. They operate audio equipment, record 

broadcasts, and monitor production behind the scenes. In post-production, these technicians 

synchronize audio and visual elements and convert recordings for public use. 

Interpreters and Translators 

Interpreters and translators convert information between languages for clear communication 

channels. These professionals can provide written translation or oral interpretation in real-time, 

whether in oral language or sign language. Interpreters and translators must be proficient in at least 

two languages and be able to switch freely between the two languages. They usually have a 

bachelor's degree and strong listening skills and cultural sensitivity.  

Graphic Designers 

Graphic designers create visual aids in magazines, websites, advertisements, and other channels 

manually or using the software. These professionals design layouts, create original illustrations 

and images and present their work to current or potential clients. Some graphic designers focus on 

certain forms of media or work with certain types of clients. These tech-savvy people need relevant 

bachelor's degrees and artistic design skills. 
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1.10. Role of Media Production in Education, Fashion and Textile 

Role of Media in Education 

The role of media in education is important as it paves the way for students to learn easily. Students 

have ample resources to get themselves equipped with new skills.  

A platform for learning on television can be seen in E-Schools by the government of Pakistan. The 

TV channel runs content from grade 1 to grade 12 according to pre-scheduled programs. Another 

initiative is a virtual university whose channel broadcasts its university-level content. Some 

universities have radio channels for students to learn about radio broadcasting. 

Introducing multi-media in education has improved pedagogical ways. An instructor can make 

interactive slides and convey more knowledge than it was done in past. Students get attracted and 

listen to more visuals as they see through PowerPoint presentations. 

Role of Media in Fashion 

Media production has also revolutionized the fashion industry as it was observed earlier. People 

had less exposure to fashion and they kept to buy more from local traditional markets. With 

penetration of media in fashion industry, the industry got boom resulting huge revenues throughout 

the world.  People can now have access to more brands and fashion designers via media. They 

know whose work has more value and which brand has more fashion sense.  

Instagram and Pinterest both have imagery galleries, it mostly conveys the messages through 

images taken by users. Such platforms are being utilized in promoting the fashion industry and 

thus opening gates for further job opportunities. 

Role of Media in Textile 

The textile industry of Pakistan has a significant place in Asia. Textile have always been 

considered the main export of Pakistan. Many brands that come under the banner of fashion started 

their business with textile industries. 

Since media support these businesses and allowed many business owners to sponsor in their media 

groups. We are in habit of watching textile-based advertisements either on TV, billboards, or on 

internet. In the past, when the only media for advertisement purposes was newspapers and 

magazines, covers of those mostly contain the textile related advertisements.  
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Key Points 

 Media has defined the way of communication between a group of people. 

 Media production is the process of producing videos and films with some pre-defined stages. 

 The three main types of media include print media, electronic media, and social media. 

 The media history starts with print media. 

 Social media is another powerful and impressive tool for expressing opinions. 

 Everything that is heard on media may not always be true. 

 Media jobs require talent and experience. 

 

Notes for Teacher: 

 Brief students that why Media Production is a valuable profession 

 Ask students about their interest from various jobs roles of media production 

 Discuss with students about future of various types of media 

EXERCISE 

A. Select the Most appropriate option 

1. How many newspapers are published in Pakistan? 

a) 80 b)  34  c)  56  d)  98 

 

2. How many sports channels do we have in Pakistan? 

a) 2 B)  3  c)  4  d)  5 

 

3. Media is not 

a) Communication b)  Current Affairs c)  TV  d)  Internet 

 

4. Media is 

a) Plural of medium b)  Communication c)  Transportation  d)  Sharing 
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5. Who invented paper? 

a) China  b)  Japan c)  Korea d)  Maldives 

 

6. Social Media app does not include the one 

a) Facebook b) Twitter c)  LinkedIn d)  Ms-Word 

 

7. Identify a Religious Channel. 

a) Madni Channel b)  CNN c)  Geo News  d)  92 News 

 

8. The role of media in society is 

a) To educate society   b)  provide entertainment  c) To enjoy   d) To make  dispute 

 

B. Write short answers to the following questions  
 

1. Define media and write about media production. 

2. Describe any two platforms of media with elaboration. 

3. People seem to share a lot of things on their social media. What would you do if you 

have the liberty to post anything on your social media? 

4. Who published the first newspaper? 

5. List down channels of PTV. 

6. How many categories do each channel have? 

7. Define digital media. 

8. How false news can be identified. 

C. Write detailed answers to the following questions  
 

1. Write about the transformation of media in your own words. 

2. Why is media considered false? Do you quote any example in this context? 

3. List any three job roles that you find interesting. Give a reason for choosing those roles. 

4. Write down the advantages and disadvantages of social media. 

5. Write a detailed note on the role of media in education. 

6. List down five national channels and explain what part these channels play in society. 
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CHAPTER 2 

HEALTH, SAFETY AND ENVIRONMENT 

 

 

 

After completing this chapter, student will be able to: 

 Define Health, Safety & Environment. 

  Know basic principles of safety.  

 Understand standard operating procedures regarding health and safety.  

 Apply basic rules of health & safety in workplace environment. 

 Understand the types of hazards and preventive measures.  

 Adopt basic certification of safety.  

 Learn awareness on physically transmitted diseases.  

 Learn sanitization process for office safety. 

 Know about Ventilation and illumination.  

 Know about importance of personal hygiene. 

 Learn about importance of personal protective equipment (PPE). 

 Know about use of personal protective equipment (PPE). 

  Know about fire triangle. 

  Identify types of fires and fire extinguishers. 

 Learn correct evacuation/emergency procedures. 

 Identify and report hazards to concerned. 
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2.1. Health, Safety and Environment 

Health, safety and environment belongs to the department within the company responsible for protecting 

basic health & safety, thus protecting the environment. Safety is the responsibility of everyone in every 

industry and so in media production industry. 

 

As an employer or a builder, the builder / contractor is responsible for taking the required precautions to 

protect the health and guarantee the safety for all workers related to production. Health, Safety and 

Environment (abbreviated as HSE) is a collection of tools, systems, and processes designed to prevent 

health of employees against any injury / problems as well as to protect the environment. 

Employees are responsible for working safely and complying with applicable health and safety rules. The 

main goal of having a health, safety and environmental management system is to protect workers from 

accidents. The occurrence of accidents may result in injury or even death of workforce in industries. With 

the passage of time, workers began to demand greater safety at workplace and successfully forced the 

governments and employers to thing about their valid demands and to take action. The Governments and 

other regulatory bodies made legislations requiring employers to ensure the health and safety of their 

employees at the workplace and also to pay health insurance and other compensations for injuries, deaths 

and illnesses caused by work activities. 

Need of HSE 

Thousands of deaths have been reported each year in accidents at workplace and over millions of people 

get injured. Over two million suffer illnesses caused by, or made worse by, their work. So, preventing 

employees from such accidents and ill health caused by work should be a key priority of every employer.  

Purpose and Importance 

Providing health & safety information and training helps you to: 

 Ensure you or your employees are not injured or made ill by the work they do 
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 Develop a positive health & safety culture at workplace which will create a fearless environment 

for workers 

 Find out how you could monitor and manage health and safety better 

 Meet your legal obligation to protect the health & safety of your employees.        

2.2. Principles of Safety  

In organizations where policies have been implemented to conduct all business activities in a responsible 

manner, assures the health, safety and security of people and thus taking care of the environment by 

compliance with all applicable legal & regulatory requirements. 

2.3. Standard Operating Procedures regarding HSE 

Standard Operating Procedures (SOPs) is a set of instructions that explains 

how to perform work safely. It involves hazardous (Electrical, mechanical, 

indoor, outdoor, office, and different workplace) equipment, or risky 

operations. Safe operating procedures are a set of safe work practices and 

step-by-step instructions required to identify and control hazards in the 

workplace to help ensuring safety of employees. 

2.4. Rules of Health & Safety 

In many cases, workplace accidents are preventable. Here are ten rules for workplace safety that you can 

implement at the workplace.  

Responsibility 

Everyone has a responsibility of making sure a safe workplace. Your personal safety is your responsibility. 

When everyone takes charge of their own safety, it creates a safe place for all employees. 
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Observe Dress Code 

Keeping arms and legs covered properly, avoiding extra jewelry, and wearing closed shoes in workplace 

minimizes common workplace injuries and accidents. We always wear personal protective equipment 

(PPE), and inspect it for damage before and after use, so that it can be repaired or replaced promptly. 

Keep Work Areas Clean 

At the beginning of work and end of each shift, clear dustbin, 

pick up PPE and cables, and put office supplies away. Collect 

any materials that you will need later to complete your work. 

Clean your office regularly. Avoid eating habits in any 

workplace.  

Follow Rules  

Keep following rules & regulations of the industrial workplace and do not take unnecessary risks.  

Report Workplace Accidents or Safety Incidents. 

If some incident happens, report it to your immediate supervisor so that relevant actions can be taken. These 

can add a taking care for an injured worker, fixing the issue that caused the injury.  

Follow Emergency Procedures 

All workers should be prepared (well trained) and follow crisis methodology in response to the incident. 

This helps security teams and crisis administrators to deal with the circumstances and decide the most 

appropriate way of managing it. 

Lift, bend, and stretch with care to avoid injury. 

Musculoskeletal issues caused by when picking up boxes or heavy objects are a typical reason for wounds. 

In case you are uncertain of the most ideal way of lifting, twist, or stretch at work, consult your director or 

organization security official. 

Don’t use irrelevant tools 

Apparatuses or hardware might appear to be instinctive; it is ideal to keep away from objects except if you 

are prepared to do it in correct way. This isn't just for your safety, but, also for the security of people around 

you. 
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Avoid Drugs/Alcohol at Work. 

Using drugs and alcohol can impact your work capacity badly because these can weaken the ability of your 

judgments, physical and mental approach. Thus, the chances of any incident at workplace are high.  

Take Breaks 

Proper rest helps employees maintain their focus on their work, which contributes to workplace safety. In 

specific industries, break time can be determined by the supervisors according to the nature of the work. 

2.5. Types of Hazards and Preventive Measure 

2.5.1. Hazard 

A hazard is a source or circumstance that can cause 

individual injury, instrumental equipment, medical 

issues, or property damage. A mishap is a circumstance 

that can cause an unwise risk. 

2.5.2. Types of Hazards 

There are many types of hazards that may cause any harm 

to workers, equipment, building other another thing. 

Below are the common types of hazards. 

2.5.3.  Security Hazards 

Security hazards are the most common workplace risks. 

They include:  

 spills like cords, rough edges of floor mats, etc.  

 falls like working from heights, ladders, roofs, etc.   

 Unsafe and moving machinery parts that a worker can accidentally touch.   

 Electrical hazards like ragged cords, missing ground pins, improper wiring Confined 

spaces, etc.                                                                                                                                                                                                                       

Electrical Hazards  

The main hazards of working with electricity are: 

 Electric shock and burns from contact with live parts 

https://www.google.com/search?q=What+are+the+7+types+of+hazards?&sxsrf=AOaemvLqqCgD_OPU8Dr1EkMMp1j16gedkg:1633233455904&tbm=isch&source=iu&ictx=1&fir=o4s8yw1ypT82DM%252CL6tnjHR6-nPHLM%252C_&vet=1&usg=AI4_-kRMZYgVg8C1ZN44CObuwn_74UN_Mg&sa=X&ved=2ahUKEwjYreXfrK3zAhU6DGMBHeKpBZkQ9QF6BAgFEAE#imgrc=o4s8yw1ypT82DM
https://www.google.com/search?q=What+are+the+7+types+of+hazards?&sxsrf=AOaemvLqqCgD_OPU8Dr1EkMMp1j16gedkg:1633233455904&tbm=isch&source=iu&ictx=1&fir=o4s8yw1ypT82DM%252CL6tnjHR6-nPHLM%252C_&vet=1&usg=AI4_-kRMZYgVg8C1ZN44CObuwn_74UN_Mg&sa=X&ved=2ahUKEwjYreXfrK3zAhU6DGMBHeKpBZkQ9QF6BAgFEAE#imgrc=o4s8yw1ypT82DM
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 Injury from exposure to arcing, fire from faulty 

electrical equipment or installations 

 Explosion caused by unsuitable electrical 

apparatus or static electricity igniting 

flammable vapors or dusts, for example in a 

spray paint booth 

 Electric shocks can also lead to other types of injury, for example by causing a fall from 

ladders or scaffolds etc. 

Preventive Measures 

You must ensure that an assessment has been made for any electrical hazards, which covers: 

 Who could be harmed by these? 

 How the level of risk has been established? 

 The precautions taken to control that risk  

 The risk assessment should take into consideration the type of electrical equipment used, 

the way in which it is used and the environment that it is used in. 

You must make sure that the electrical installation and the electrical equipment is: 

 Suitable for its intended use and the conditions in which it is operated 

 Only used for its intended purpose  

Fire Hazards 

A fire needs three elements - heat, oxygen and fuel. 

Without heat, oxygen and fuel a fire will not start or spread. A key 

strategy to prevent fire is to remove one or more sources 

of heat, oxygen or fuel.  The risk assessment should include details 

on all three elements to minimize the risk of a fire starting / 

spreading.  Emergency procedures must also be in place and 

practiced to ensure safe evacuation in the event of a fire. All workplaces should have arrangements 

for detecting fire. IS 3218 gives a basis for assessing what type of detection system will be 

appropriate for a workplace and will also give guidance of its installation. Smoke detector are 

generally installed for this purpose. 

https://www.hsa.ie/eng/Topics/Fire/Fire_Prevention/#hea
https://www.hsa.ie/eng/Topics/Fire/Fire_Prevention/#oxy
https://www.hsa.ie/eng/Topics/Fire/Fire_Prevention/#fue
https://www.hsa.ie/eng/Topics/Fire/Fire_Prevention/#hea
https://www.hsa.ie/eng/Topics/Fire/Fire_Prevention/#oxy
https://www.hsa.ie/eng/Topics/Fire/Fire_Prevention/#fue
https://www.hsa.ie/eng/Topics/Fire/Fire_Prevention/#hea
https://www.hsa.ie/eng/Topics/Fire/Fire_Prevention/#oxy
https://www.hsa.ie/eng/Topics/Fire/Fire_Prevention/#fue
https://www.hsa.ie/eng/Publications_and_Forms/Publications/Safety_and_Health_Management/Guide_to_Risk_Assessments_and_Safety_Statements.pdf
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Slip, Trips and Falls Hazards 

Trips and falls for any reasons (uneven ground, wet 

ground, loose cables, etc.) can easily become the 

most common cause of injuries on the job. Workers 

must pay large sums of money to cover the cost of 

all these accidents. if safety regulations are 

followed correctly, most of these accidents can be 

avoided. Employers and workplaces both are responsible for ensuring that workforce is working 

in a safe environment.  

2.6. Certification for safety  

Employer must encourage the employees to get knowledge and get standard certifications related 

to work safety so that everyone can work safely throughout their careers. Below are some 

certifications. 

 Certified Safety Professional (CSP), Board of Certified Safety Professionals (BCSP) 

This is the utmost license among safety experts — and for good reason. On average, Certified 

Safety Specialists are more likely to get hired, can get attractive salaries, and receive more 

upgrades and management openings than their peers. 

 Certified Industrial Hygienist (CIH), American Board of Industrial Hygiene (AIBH) 

If you’re thinking to advance your profession in health and safety, the Certified Industrial 

Hygienist (CIH) certification is an outstanding option. The CIH certification is a universally 

accepted qualification that validates your assurance to shielding the health and safety of 

workers and the public.  

 Certified Safety and Health Manager (CSHM), Institute of Hazardous Materials 

Management (IHMM)  

Another famous certification among safety experts is the CSHM. This certification emphasizes 

both technical knowledge as well as business administration skills. Professionals with this 

certificate are in high demand. According to IHMM, this certification is ideal for people who 

https://www.bcsp.org/CSP
http://www.abih.org/
https://ihmm.org/cshm/
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are seeking executive positions in their organizations, such as manufacturing, construction, 

healthcare, education, and more.  

 IOSH Level 3 Certificate, Institute of Occupational Safety and Health (IOSH) 

If you’ve operated in the field of safety and health even for a while, you’ve likely seen the 

IOSH title in your colleagues’ email signature or on their visiting card. IOSH is the world’s 

largest affiliation body for safety and health specialists, and their certifications are commonly 

recognized. IOSH's Level 3 Certificate is a well-accepted qualification that delivers an 

understanding of safety and health in a business framework.  

2.7. Awareness on Physically Transmitted Diseases 

There are numerous irresistible infections that might 

affect the wellbeing and efficiency of the workforce. 

Microorganisms can be found at almost every 

workplace. Infectious disease can cause great hazards 

in working environment. 

Infectious hazards are also known as biohazards. They include:  

 Blood and other body fluids  

 Fungi/mold  

 Bacteria and viruses  

 Plants  

 Insect bites   

 Animal and bird droppings  

Common Diseases Spread at work 

Although it would be impossible to discuss every infectious disease 

that could potentially affect individuals in the workplace. Some of 

these infectious diseases include: 

  

Do You Know: 

Some types of bacteria Many live 

in your body without causing 

mischief, and some might even 

assist you stay healthy. 

https://iosh.com/training-and-skills/iosh-training-courses/safety-and-health-for-business-level-3-general-certificate/
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Tuberculosis (TB) 

TB is spread through the air from one person to another. Tuberculosis (TB) is caused by bacteria 

Mycobacterium tuberculosis that most often affect the lungs. workers nearby may become infected 

by breathing in the air that contains TB bacteria. 

Spread of drops 

During sneezing and coughing, you can taint someone else through droplets. This type of 

transmission happens immediately. The droplets may be breathed in by people who are nearby and 

polluted an object or surface.  Examples of diseases spread by droplet. 

 Common Cold. 

 influenza (the flu) 

 COVID-19. 

Through Contact with Skin 

Some infections are transmitted directly if the skin is exposed. Infections can be spread when the 

skin touches with a contaminated object.  

2.8. Sanitization process for office safety  

Keeping a clean workplace helps us from spread of diseases at workplaces. Microbes can be 

developed on surfaces that has not been sanitized. Since the work surface looks perfect doesn't 

mean it's sterile and germs free. 

2.8.1Cleaning Procedure and Schedules 

Normally soap and other basic level cleaning materials are used only in cleaning process of the 

workplace but actually it also need to be disinfected. Simple cleaning will remove any dirt or 

grease from surface, but it will not necessarily kill any bacteria or other germs. Only proper 

disinfectants can kill these harmful germs and can ensure that the area can safely be used to work.  
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2.9. Ventilation 

Ventilation is the process of removing contaminated air from workplace and injecting clean air. 

The general purpose of ventilation in buildings is to provide healthy air for breathing.  

Air Conditioning 

Air conditioning is a system that is used to maintain the temperature in an interior space by 

eliminating the heat and humidity from the workplace. Our air conditioner quickly converts gas to 

liquid and vice versa using chemicals that remove hot air from indoor place. Broader speaking, an 

air conditioning system controls the temperature, humidity, and air quality in indoor spaces. 

2.10. Importance of Personal hygiene  

Effective personal hygiene is very important. Develop good personal hygiene habits to help 

maintain good health and hygiene. It needs to keep your hands, head and body clean to forestall 

the spread of germs, gases and chemicals etc. Your own cleanliness is useful for your own 

wellbeing and furthermore affect the lives of everyone around you. 

 

    

               

 

 

 

In order to reduce the risk of infection by biological agents follow good occupational hygiene 

practices: 

 Wash hands regularly and especially before eating, drinking or smoking. 

 Wash any cuts and grazes immediately with soap and running water. 

 Cover any existing cuts, abrasions or breaks in the skin with waterproof dressings and/or 

gloves. 

https://www2.hse.ie/wellbeing/how-to-wash-your-hands.html#:~:text=Wet%20your%20hands%20with%20warm%20water%20and%20apply,wash%20between%20fingers.%20Repeat%20with%20the%20other%20hand.
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 Avoid hand to mouth/eye contact. 

 Take rest breaks, including eating meals and taking drinks, away from potentially 

contaminated work areas. 

Hygienic Clothes 

Dirt and bacteria can also surface on clothes. As part of your 

personal hygiene habits, it is important to take care of your 

clothes through regular washing and changing especially if 

you or your family are unwell. To ensure that your clothes 

are hygienic and clean, use disinfectant to your clothes to 

kill any bacteria.  

2.11. Personal Protective Equipment  

It's the equipment that shields laborer from wellbeing and dangers at work environment. This 

includes defensive clothing, uniform, shoes, cap, goggles, gloves or other dress to protect the 

wearer's body from injury or disease. 

The importance of PPE 

PPE looks different in various environments. Medical staff 

may wear masks and protective clothing, face shields and 

outfits, construction workers may wear helmets and work 

boots, whereas electric workers use insulated gloves etc.  

PPE is similarly significant in all settings, since it limits 

the danger of workers becoming genuinely harmed 

because of a risk. 

As a front-line worker in any sector, your safety is 

supreme when working on-sites. PPE is significant on the grounds that it sets you up for any 

wellbeing and dangers and furnishes you with extra insurance in case of a mishap or catastrophic 

event. 
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List of Personal protective Equipment  

 Gloves 

 Face Shields  

  Goggles and glasses 

 Masks 

 respirators 

 Eye Protection 

 Hard Hats 

 Gowns 

 Hearing protection device 

 

Safety Measure 

Following are the safety measures related to Personal Protection at work: - 

 Physically eliminate the hazard from the workplace. If dangerous Equipment causes 

multiple injuries, the manager should remove it. 

 Replace the hazards with safer alternatives. If a worker on a construction site is injured by 

using a specific tool, the manager should replace the tool with a safer and more effective 

tool. 

 Ensure that workers have the personal protective equipment needed to complete the job 

without being injured. 

However, use of PPE is equally important in all environments because it minimizes the risk of 

fatal injuries to employees due to danger. 

Training of Using PPE 

Employers should ensure that employees who use PPE understand why it is required, when to 

utilize it, and to whom to report if the PPE is damaged. 

Employer should prepare and train workers on the best way to utilize PPE accurately and guarantee 

they do as such. Manager and supervisors should monitor and guarantee that workers realize how 

to utilize PPE accurately. It is significant that worker should consistently wear PPE when the 

workplace is dangerous. Employers should not allow exemptions for jobs that just take a few 

minutes. Employers should routinely check whether PPE is fit to be utilized. 
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2.12. Using PPE 

The term personal protective equipment (PPE) refers to a vast group of products e.g., safety 

helmets, safety footwear and harnesses, eye protection, gloves, high-visibility clothing, etc. 

designed with the aim to protect users against low, medium and high-level hazards. 

 Head hazard: all kinds of helmets, safety helmets and anti-collision caps are suitable 

personal protective equipment to avoid head hazards. 

  Eye hazards: The PPE series includes safety glasses, goggles, face shields and face 

shields. 

 Breathing hazards: breathing systems / devices and air-supplied helmets are some of the 

PPE options for breathing hazards. 

  Physical hazards: typical work clothes, jumpsuits and specially designed protective 

clothing can be selected as effective PPE. 

 Foot and leg hazards: preventive measures can be taken by using safety boots / shoes, 

waterproof midsoles, leggings, etc. 

 Hand and arm hazards: Potential PPE include gloves, hand guards, wristbands, armbands, 

etc. 

 Masks should be used as part of a comprehensive do it all. which includes maintaining 

physical distance, avoiding crowded, closed and close contact environments, good 

ventilation, washing hands, and covering sneezes and coughs. 

                 

                           

 

 

 

2.13. Fire Triangle 

The fire triangle's three sides represent the three components of fire hotness, fuel and oxidization. 

Each side of the triangle represent one of three parts expected to have a fire, fuel and hotness. Fire 
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is a synthetic response and without one of these parts, fire can't exist. The air that encompasses us 

contains around 21% oxygen.  

 

Types of Fire 

Fire extinguishers are designed to specific types of fire. There are six different classes of fire and 

several different types of fire extinguishers.   

Classes of Fire 

Class A fires involving strong materials like wood, paper or materials.  

Class B fires involving combustible fluids like petroleum, oil and diesel.  

Class C fires involving gases.  

Class D fires involving metals.  

Class E fires including live electrical contraption.  

Class F fires including cooking oils, for example, in extreme fat fryers. 

 

Types of Fire Extinguishers 

Water Extinguishers 

Water extinguishers are one of the most effective tools to fight against Class A flames produced 

by strong materials like paper, wood and other materials. Water fire extinguishers have a red mark. 
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There are four distinct kinds of water extinguishers water jet, water splash, water with added 

substances and water fog or haze. 

 

 Water Jet Extinguishers work by splashing a jet of water at the consuming materials, 

cooling them and forestalling re-start. They should not be utilized on live electrical 

equipment.  

 Water Sprinkle dousers utilize an exceptionally fine splash of water drops; every bead is 

encircled via air which is non-conductive.                

 Water with added substance works by adding the synthetic compounds to the water implies 

that a more modest extinguishers can deliver a similar fire rating as a bigger douser.  

 Water haze or dimness, dousers apply water as fog, or mist, the beads are a lot more 

modest than those from the water splash extinguishers 

Foam Extinguishers 

Foam extinguishers can be utilized on Class A and B fires. They are more qualified to 

smothering fluid flames like fuel or diesel and are more flexible than water stream extinguishers 

since they can likewise be utilized on solids like wood and paper. They are not reasonable for use 

on free streaming fluid flames. Foam extinguishers have a cream-hued mark. 

 

 



35 
 

Powder Extinguishers 

Powder extinguishers are a decent multipurpose fire douser in light of the fact that they can be 

utilized on Class A, B, and C flames. They can likewise be utilized on flames including electrical 

equipment, but they don't cool the fire so it can walk out on. Powder fire extinguishers can likewise 

make a deficiency of visibility and can make respiratory issues. Powder fire extinguishers have a 

blue mark. 

Carbon dioxide extinguishers (CO2) 

CO2 fire dousers are great for places with numerous electrical gears, for example, workplaces or 

server rooms, since they can be securely used to smother fires including electrical equipment. 

Dissimilar to froth fire quenchers, carbon dioxide fire dousers don't leave any buildup. They can 

likewise be utilized in Class B fires, which are fires including flammable fluids like paraffin o fuel. 

The functioning guideline of a carbon dioxide fire douser is to smother the fire and remove the air 

supply. Carbon dioxide fire extinguishers (CO2) have a dark name. 

Wet chemical extinguishers 

Wet compound fire dousers are appropriate for Class F fires including cooking oils and fats, like 

fat, olive oil, sunflower oil, corn oil, and spread. Whenever utilized appropriately they are 

extremely viable. Wet synthetic compounds rapidly extinguish the fire, cool the consuming oil and 

artificially respond, framing a cleanser like arrangement, fixing the surface and forestalling restart. 

Wet compound fire extinguisher has a yellow mark. 
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Fire blankets 

Fire covers are mostly utilized for hot oil fires, for example, browning skillet or little profound 

singing container. They can likewise be utilized for individuals whose garments are on fire. They 

used by extinguishing blazes, keeping oxygen from entering and smothering it. 

2.14. Evacuation / Emergency Procedures 

Set out directions for what should be done in case of a crisis. plainly state what is to occur in a 

crisis and who is answerable for each step at the help. Before an emergency occurs, determine the 

exit closest to your location, the safest route, and alternate exits. Leave the nearby area, but it is 

still available for emergency rescuers. If time permits during the evacuation, please ensure that 

your workplace is safe and take away personal belongings such as keys, wallets, medicines and 

glasses. If there is a fire or other dangerous situation, please evacuate immediately and leave your 

personal belongings. 

Evacuation of a Building 

 Walk fast but do not run. 

 Do not use lift. 

 Gather outside at your assigned get together region, where 

your administrator will consider for all staff.  

 If you can't get back to your building, hang tight for 

guidelines from Public Safety, your building supervisor or 

any other person in control.  

When you hear fire alarm 

 Pull the closest alarm (situated at any exit)  

 Clear the building and continue to a get together across the road and away from the 

building 

 Keep access ways and streets clear.  

 Anticipate directions from Campus Security. 

 At the point when the all-clear signal is given, reappear the building through the main 

door. 

 Report the fire. 
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Mobility Impairment:  

Unless authorized by the police or firefighters, do not use the elevator when the building's fire 

alarm is sounding. If you or the person with you cannot be evacuated, ask someone to tell 

emergency responders your identity and location, and you or the person with you cannot be 

evacuated due to a disability. 

If smoke is detected and you cannot safely reach the emergency exit landing site, move to a room 

with windows and close the door. Go to the window and open it. Get the attention of someone 

below by wavy arm or colorful fabric. 

Deafness or Hearing Impairment 

Numerous buildings are furnished with visual signals for alarms. If someone does not realize that 

the alert is sounding, please draw the person's attention through eye contact, and touch it if 

necessary. Gestures may be helpful, but if the person does not read lips, if it's not too much trouble, 

be ready to compose a short statement. 

2.15. Hazard identification & reporting 

Hazard identification is the procedure of noticing possible causes of harm or damage from doing 

a job task in a specific work area. Detecting workplace hazards is critical to implement controls 

that will help safeguard the safety of workers and other stakeholders. Hazard identification is part 

of a hazard assessment, or assessing risks related with a hazard and taking action to remove it or 

reduce risks involved with it. 

Hazard identification assesses potential risks (e.g. noise, manual handling, excavation, etc.) 

observed within the work premises.  

Hazard Assessment 

A hazard assessment reduces the probability of workplace accidents from occurring and ensures 

the safety of your employees. Easily perform (fire risk) assessments by following the steps below: 

Look – Walk around the facility and look for out-of-place items. Identify potential or 

existing hazards. Learn how to identify common workplace hazards. 

https://safetyculture.com/topics/risk-assessment/
https://safetyculture.com/topics/workplace-hazards/
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Think – Evaluate identified hazards and determine their underlying causes. Set appropriate 

controls to mitigate the likelihood of recurrence. 

Act – Implement corrective actions or controls. 

Monitor – Perform regular inspections and reviews to ensure that standard operating 

procedures and safety control measures are followed. 

Hazard Prevention and Reporting 

Below are the important points related to prevention and reporting: 

 If anybody at workplace notices any kind of potential hazard, he / she should immediately 

report to the supervisor / manger. The reporting could be written, verbal or any means that 

is possible that time. 

 Describe the nature of work and select the protective equipment available and needed to 

protect the employees from harm. Proceed with identifying the hazards present. 

 Capture photo evidence of the situation or object that may cause serious problems to 

workers. 

 Assign an action to a supervisor for review and immediate resolution. 

 State observations and rate the overall assessment if the work site is safe or not. 

Key Points 

 Hygiene is important in the workplace because it contributes to a healthy workforce. 

 HSE is a collection of tools, systems and processes designed to prevent health problems 

and injuries for our employees and to protect the environment 

 Although medical staff may wear masks and protective clothing, construction workers may 

wear helmets and work boots. 

 Safe operating procedures are a set of safe work practices and step-by-step instructions 

required to control identified hazards in the workplace to help ensure employee safety 

 Replace the hazards with safer alternatives. If a worker on a construction site is injured by 

using a specific tool, the manager should replace the tool with a safer one. 

https://safetyculture.com/topics/corrective-action/
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 Fire triangle's three sides represent the three components of fire hotness, fuel and 

oxidization. 

 Class A fires including strong materials like wood, paper or materials. 

 Powder extinguishers are a decent multipurpose fire douser in light of the fact that they can 

be utilized on Class A, B, and C flames.  

 The bacteria are put into the air when a person with active TB Disease of the lungs or throat 

coughs or sneezes. 

 Ventilation is the process to clean the air by providing outside air and eliminating dirty air. 

Activities 

1. Discuss the standard operating procedures (SOP’s) regarding basic safety (personal hygiene and 

vaccination, first aid treatment, allergy test, age limit policies, environmental hygiene etc.) 

2. Perform the use of PPE kits, gloves, Uniforms, Shoes, Hair net, beard net, masks etc. 

3. Perform the experiment of fire Extinguishers and Fire Safety Equipment. 

4. Perform correct evacuation procedures and incidents reporting through role play. 

Notes for Teachers 

 Discuss with students that why Health, Safety and Environment is a major concert about 

any workplace 

 Tell students that almost every industry may have some types of hazards 

 Ask students about various types of protentional hazards in various industries 

 Ask Students about their interest about doing certifications related to Safety 

 Help students to make a formal form for hazard detection and reporting 
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EXERCISE 

Select the most appropriate option 
1. The primary goal of the safety and health is to prevent workplace _____________ 

(a) Injuries                                           (b) Object 

(c) PPE                                                  (d) Media 

2. Which voltage can hurt people whether they touch it directly or indirectly through some kind of 

conductive material? 

(a) Voltages above 10 volts AC          (b) voltage below 30 volts         

          (c)  Voltages below 50 volts AC          (d) Voltages above 50 volts AC 

3. What is the first step of avoiding accidents at work place? 

              (a) Follow safety precautions                     (b) don’t do anything 

              (c) None of these                                         (d) don ‘t touch  

4. Ventilation is the process of providing _____ in room. 

                 (a) Inside air                                              (b) Dirty Air  

                 (c) Random air                                         (d) outside Air 

6. PPE stand for 

                 (a) Power protective Equipment                     (b)Personal productive equipment  

                 (c) Personal protective Equipment              (d) Poor productive equipment 

7. What is class of fire caused by fluids like petroleum, oil? 

                 (a)Class A                                                   (b) Class B  

                ( c) Class C                                                (d) Class D 

8. Powder fire extinguishers have a_______ mark. 

                 (a) Green mark                                               (b) Yellow mark  

                 (c) Red Mark                                                (d) Blue mark 

9. Which fire extinguishers is suitable for the line electrical fire? 

                 (a) Foam                                           (b) Water  

                  (c) Halon                                         (d) Sand 

10. How to stop bleeding in injured person? 

                (a) Apply  bandage                              (b) Apply pressure on the wound 

               ( c) Drop water                                     (d) Supply more blood 
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Give short answer to the following question 

 
1 What is HSE? 

2. What is purpose of Health, safety and environment? 

3. Define the Hazard. 

4. Define Ventilation. 

5. Describe three personal hygiene. 

6. Describe personal protective equipment. 

7. Enlist Personal protective Equipment. 

8. Describe two rules of HSE. 

9. What is Fire Triangle? Write four types of fires. 

10. Describe Water extinguishers. 

Answer the following questions in detail 

 
1. Define Hazard? Explain different types of Hazards and which preventive measures are adopted. 

2. Which diseases can be transmitted physically at workplace? 

3. Define classes of fire and discuss different types of extinguishers. 

4. Define PPE? How and when we use personal protective equipment (PPE).  

5. Discuss the standard operating procedures (SOPS) regarding basic safety personal hygiene and 

vaccination. 



42 
 

CHAPTER 3 

PHOTOGRAPHY 

 

After completing this chapter, students will be able to: 

 define photography  

 know purpose of photography 

 describe different techniques of photography 

 understand components of camera (lens, light, chassis, battery, tripod, memory card, 

shutter, lcd screen and image sensor)  

 know about handheld shooting process  

 learn about tripod shoots  

 know about adjustment of focus 

 learn about exposure of camera 

 know about density of camera 

 learn about shutter speed of camera 

 learn about white balance and iso for image stabilization 

 learn about indoor and outdoor shooting 
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3. Introduction to Photography 

3.1. Photography 

The word Photography literally means ‘drawing with light’, which derives from the Greek ‘photo’, 

meaning light and ‘graph’, meaning to draw. Photography is the process of making pictures by 

means of capturing light on a light-sensitive medium, such as a sensor or film. Light patterns 

reflected or emitted from objects are recorded onto a light sensitive medium or storage chip 

through a timed exposure. Traditionally the product of photography is called a picture, an image 

or a photograph. The term photo is an abbreviation of photograph. 

3.2. Purpose of Photography 

Photography is another development of media forms. Just like other media technologies, 

photography extended the ability of communication. It serves various purposes such as, conveyers 

of news, scientific evidence, historical documents, work of art, and record of family. Photography 

is done in various fields and for various purposes. Some of the purposes are briefly discussed 

below:  

 Making photographs for commercial and advertising purposes. The goal is to sell products, 

services, or ideas. 

 Making photographs for recording moments such as wedding, get-togethers, and birthday 

parties etc. 

 Photography is used at a professional level for portrait making. 

 Making photographs for entertainment such as doing photography for magazines and 

picture-based stories. 

 Photographs can provide legal evidence about something that happened for a specific 

purpose. Something is proven when we are shown a photograph of it. For example, the use 

of photography for crime investigation. 
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Activity 

Group presentation on  techniques photography 

 

3.3. Techniques of Photography 

Different techniques of photography can be adopted to achieve professional results which can 

fulfill the purposes of photography. Some of the techniques will be highlighted in this topic.  

 Photographic techniques can be divided into two categories on the basis of camera 

handling, which are as follows: 

a. Handheld photography b. Tripod photography 

 Photographic techniques can also be divided on the basis of the environment in which 

photography is being done. On this ground, photographic techniques can broadly be 

divided into following categories: - 

 Outdoor photography 

 Indoor photography 

 High Speed Photography 

 Night Photography 

 Motion Blur 

 Black and White Photography 

 Monochromatic Color Photography 

 Smoke Art Photography 

 Macro Photography 

 Long Exposure Photography 

 

 

 

3.4. Components of Camera  

In this topic, we will learn basic components of the professional quality cameras. Some of the most 

essential components of a camera are listed as follows: 

 Chassis 

 Viewfinder 

 LCD screen 

 Shutter 

 Shutter release 

 Mode dial 

 Memory card 
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 Image sensor 

 Lens 

 Battery  

 Flashlight 

 Zoom ring and focus ring 

 

Chassis / Camera Body 

The camera body is the main box, to which all the components of camera are attached. It is the 

part of the camera which is held when using the camera. It contains image sensor, LCD screen, 

shutter release button, shutter, and associated circuitry. Camera lens(es) can be attached and 

detached from the camera body.  

Viewfinder  

The viewfinder is what you look through to compose the picture. A 

photographer finds a spot to focus on, by looking through the viewfinder. There 

are two types of viewfinders, i.e., optical and digital. Optical viewfinder is the 

rectangular-shaped eyepiece on a camera that is held close to the eye, allowing 

the photographer to see what is being photographed. Optical viewfinder and 

the way it is used have been shown in the figure.  

LCD Screen 

An “electronic viewfinder” is a camera viewfinder in which the image captured by the lens is 

electronically projected onto a micro-screen. The LCD screen acts as the electronic viewfinder as 

shown in the figure. 

Shutter 

The length of time for which the image sensor is exposed to light is controlled by part of camera 

called “shutter”. The shutter functions like a door that opens and shuts. The shutter is made of 

different materials depending on the type of camera and manufacturer. 
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Shutter release  

The shutter release is the button that must be pressed in order to take the 

photograph. It is usually found on the right front as you hold the camera. 

Mode Dial 

Mode dial is used to change the camera modes. Different scene modes can 

be chosen by rotating the dial. Some of the mode dials of different cameras 

are shown in the figure.  

Memory card 

Memory card is a type of storage medium used to store photos and 

videos. Two most popular Memory Cards are the SD (Secure 

Digital) and CF (Compact Flash) cards. Memory Cards come in 

different sizes and storage capacities. Some of them can be tiny in 

size also called Micro SD Card. As the images and videos taken by digital cameras take a lot of 

storage space. Therefore, mostly memory cards having capacity of more than 16 GB are used. 

Image Sensor 

Image sensor is a sensor that detects and conveys information used to make an image. When light 

passes through the lens, aperture, and shutter, it hits the recording medium, which records the 

image. 

Lens 

The basic purpose of a lens is to focus the available light so that it can be recorded by the recording 

medium. Different types of lenses have their own characteristics, which can control focal length, 

and viewing angle. Different types of lenses can be used to capture wide area image, closeups, 

sports or an object at a great distance. 
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.  

Battery 

Like other digital devices, camera needs a power source to operate, which is provided through 

battery. 

Flashlight 

Flashlight can be embedded or detachable on front side of the cameras. The purpose of flashlight 

is to produce a flash of artificial light where natural light is not enough to photograph something.   

Focus Ring and Zoom ring 

“Focus ring” is rotated to adjust the focus of the camera whereas “zoom ring” is rotated to change 

the focal length. Zoom ring allows to zoom in and out of the scene being recorded.   

3.5. Handheld Photography 

Hand-held photography is the technique in which a camera is held in the camera operator's hands 

as opposed to being mounted on a tripod. Hand-held camera shots often result in a shaky image, 

unlike the stable image from a tripod-mounted camera. This method is used to get quick 

photographs and the photographer must be expert / trained to get these shorts. To prevent shaky 

shots, a number of image stabilization technologies have been used on hand-held cameras 

Activity for students 

1. Students will perform assembling of camera. 

2. Set camera with tripod 
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including optical, digital and mechanical methods. However, settings of the camera can also be 

adjusted for the hand-held photography. For example, increasing the shutter speed etc. 

3.6. Tripod Photography 

A tripod is a three-legged device which is used to securely and steadily 

hold a camera. Most tripods have a central pole and height adjustable 

legs and are used in conjunction with mount to which a head is fixed. 

Tripods are used for still as well as motion photography to prevent 

camera movement and provide stability. When photographs with slow 

shutter speed need to be taken, it is necessary to use tripod because even 

a little camera shake will produce a blurry image. Use of a tripod in 

such situations will maximize sharpness of objects in the image by 

reducing the camera shake. A tripod can also help achieve precise composition of the image, or 

when creating multiple images of the same scene. Tripod is also helpful in photographing at certain 

heights. 

Do You Know: 

When describing a digital camera, the term "resolution" refers to the number of pixels of the digital 

image produced by the camera, usually expressed in "megapixels". For example, a camera that 

captures 1600 x 1200 pixels, produces an image with a resolution of 1.92 million pixels, which is 

called a 2.0-megapixel camera. By multiplying the vertical and horizontal dimensions, you can get 

1.92 million pixels. For marketing purposes, this number is then rounded to 2. Higher resolution 

means better quality, the quality of lens and the image capture chip are also important. 

3.7. Adjustment of Focus 

Focus, in terms of photography or videography, is the point where the objects in the frame are 

sharpest. When taking a photograph, it is essential that at least a part of the image is in focus. 

Adjusting this focus can be done by following two ways:  

Automatically: Using autofocus option, the camera can automatically select the focus point(s). 

This is done by pressing the shutter halfway. When using autofocus, there are two factors to 

understand: focus points and focus modes. Focus points are the squares that can be seen in the 
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viewfinder when framing the image. These Adjusting the focus determine where the point of focus 

in an image will be. The other factor is focus modes. Types of focus modes available vary between 

cameras. However, most cameras have at least two autofocus modes:  

 Single shot focus mode: The single shot focus mode keeps the focus point once 

the shutter is half pressed, even if you reframe the image.  

 Continuous focus mode: Continuous focusing continuously recalculates and 

readjusts the focus until the image is taken. 

Manually: Focus point can also be selected manually. This can be done by rotating the focus ring 

on the lens until the area you want in focus becomes sharp / clear. 

3.8. Exposure of Camera 

Exposure of camera refers to the amount of light that touches the camera's sensor while taking a 

photo or video. Exposure of a photograph refers to the level of brightness or darkness in it. The 

exposure settings of camera can be adjusted by changing ISO, shutter speed and aperture size of a 

camera. A correct exposure in a given scenario is obtained by properly tuning these settings. 

Larger aperture size and ISO values are associated with increased exposure of the image. Likewise, 

lower aperture size and ISO values produce lesser exposure. However, the faster shutter speeds 

are associated with lesser exposure and slower shutter speeds are associated with increased 

exposure.  

3.9. Density of Camera 

When any image or video is displayed on a screen or printed, it has physical properties that is pixel 

density. Pixel density of a camera refers to the concentration of pixels on a particular surface or 

device. It is measured in pixels per inch (ppi) and pixels per centimetre (ppcm).  

3.10. Four Essentials of Photography 

Photography is a form of communication that can be understood universally. Since photographs 

can be so widely understood, we should be concerned with whether what we have to say is worth 

saying. The four essentials of photography are light, composition, aperture, and shutter speed. 

These must be considered while taking the photograph. 
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Light 

Light is an important part of the image, and there are many different types of light. Each of them 

can be used to create different emotions or feelings in the picture. The photographer's job is to 

control this light to obtain the best and required results. Indoor and Outdoor photography has 

different requirements of light.  

Composition 

In photography, composition refers to the placement of various elements of the scene within a 

frame. “Composing an image” means arranging the elements in the way that best suits the central 

idea or purpose of your work.  

Aperture: Depth of field 

Aperture refers to a hole in the lens through which light passes before reaching the recording 

medium. It controls the amount of light and the depth of field recorded. The aperture size is 

measured in f-stop/f-value e.g., f/16, f/11 and f/8. Aperture size can also be written in numbers 

such as, 16, 11 and 8. The higher the f-stop value, the larger will be the opening in the lens. 

Whereas the smaller is the f-stop value, the smaller will be the opening in the lens. Lower f/stops 

give more exposure because they represent the larger apertures, while the higher f/stops give less 

exposure because they represent smaller apertures. The maximum and minimum aperture sizes 

vary between cameras.  
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Besides exposure, the aperture size also determines the depth of the field, which is the sharpness 

of the area behind the subject which is being focused. The lower is the f/stop value, the less depth 

of field will be recorded, hence the blurrier will be the background. The higher the f/stop, the 

greater the depth of field will be recorded; hence the sharper will be the background. 

Shutter speed: Time 

Shutter speed refers to the time the shutter remains open and is recorded in units of seconds, tenths 

of a second, or hundredths of a second (e.g. 1, 1/10 or 1/2000). The higher the shutter speed, the 

lesser light is recorded (and vice versa). The right choice of shutter speed is important especially 

when objects to be recorded are moving. Shutter speed controls how long we capture light and the 

amount of movement recorded in the image. Most cameras have shutter speeds between 1/1000s 

and 1s. Common shutter speeds are: 1, 1/2, 1/4, 1/8, 1/15, 1/30, 1/60, 1/125, 1/250, 1/500, and 

1/1000. When you use a faster shutter speed, the shutter stays open for a shorter time. This freezes 

the movement but reduces the light recording time. Slower shutter speed means the shutter stays 

open longer, which blurs the motion but allow lighter to be recorded. Fast shutter speeds over 

1/100 are good for hand-held shot, and slow shutter speeds lower than 1/100 are better for low 

illumination conditions. 

3.11. White Balance 

For a correct white balance of the camera, "color temperature" of the light source must be taken 

into account. The color temperature refers to the warmth or coldness of white light. The more 

orange the light is, the warmer the color temperature is. Likewise, the bluer the light is, the cooler 

is the color temperature. Direct sunlight at noon is considered to be a “normal” color temperature, 

so all light sources are compared to this as the standard. For example, light from an incandescent 

light bulb appears to be more orange than the sunlight at noon. White balance setting in camera is 

used to adjust the color temperature of the scene being captured.  

The following white balance presets are also available in cameras: 

Do you know? 

In photos and videos, the subject refers to the object (or person or creature), shown in the 

photograph or video. Subject is prominent point and is the focus of the scene. 
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 Auto(A): This preset automatically adjusts the white balance depending on ambient light. 

 Shade (House with a Shadow): This setting adds orange color to the photograph.  

 Choose Color Temperature (K): Color temperature can be changed manually. 

 Incandescent (Light bulb): It is used under tungsten light bulbs. 

 Fluorescent (Glowing Tube): It is used under fluorescent lights or if the photograph looks 

too green.  

 Direct Sunlight (Sun): This white balance setting is used in shooting outdoor shooting 

with the sun shining on the subject. 

 Flash (Lightning Bolt): It is used when flashlight of the camera is being used while 

making pictures. 

 Cloudy (Cloud): It is used while making pictures in shades or on cloudy day. With this 

white balance setting, images produced have warmer color than sunlight. 

Figure below shows camera shots captured with different manually selected white balance values.  
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ISO 

ISO is the sensitivity of the camera's sensor to light. The higher the ISO, the more sensitive the 

sensor is to light. However, if ISO is increased too much, the lens of camera will produce grain or 

noise. Standard ISO values are 100, 200, 400, 800, 1600, 3200, 6400, etc. Whenever ISO is 

decreased, it decreases the amount of light by half.  

A high ISO of 800 and above allows you to use a faster shutter speed in low light conditions, but 

it adds noise to the image making it look grainy. If too high ISO is used, the image looks washed 

away, however it would appear dark if too low ISO is used.  

3.12. Indoor Versus Outdoor Photography 

Indoor photography refers to taking photographs inside a building or structure. For example, taking 

shots inside a restaurant, a photo studio, home or office etc. The term outdoor photography is 

mostly used when referring to taking photographs without using artificial lights. Outdoor 

photography is done outdoor in natural lighting conditions.   

Do you know? 

While taking landscapes and group shots, you can get wonderful results with aperture of 

around f / 11. 
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Both indoor and outdoor photography have certain requirements, settings, pros and cons. But one 

factor which must always be taken into consideration and never overlooked is “Light”. Good 

lighting is vital if you wish to shoot mind-blowing photos. So, finding a spot with sufficient 

lighting is essential, whether you are taking photos, indoor or outdoor. In this perspective, indoor 

photography is easier because the photographer has full control over the light sources. For indoor 

photography, several light sources can be used. The direction of light, intensity of light sources, 

and their distance from the subject have influence on result of photograph. Flashlight of camera 

and other light sources can be selected and used depending upon the requirement for the photo 

shoot. However, obtaining balanced, well spread and well illuminated environment indoor is costly 

as compared to outdoor in daytime. For creating natural effects in the photograph shot indoor, 

natural lighting sources can be used, e.g., illuminating the shooting location by opening all 

windows and doors.  

An example of a good outdoor shot 

In indoor photography, the photographer has more control over the background as compared to 

doing photography outdoor. For outdoor photography in the daytime, lower ISO and smaller 

aperture size is required as compared to doing photography at night.
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Key points 

 Photography literally means to ‘draw with light’. Photography is the process of making 

pictures by means of capturing light on a light-sensitive medium, such as a sensor or film. 

 Photography serves various purposes such as, conveyers of news, scientific evidence, historical 

documents, works of art, and record of family events. 

 Shutter is the component of a camera which opens and closes according to the adjusted shutter 

speed. 

 Shutter is the component of a camera which is used to control the shutter speed of a camera. 

 Shutter release is the button which needs to be pressed in order to take the photographs. 

 In photography, a tripod is a three-legged instrument which is designed to hold a camera 

securely and steadily. 

 In tripod photography, camera is mounted on a tripod while doing photography. 

 In hand-held photography, camera is held in the photographer’s hands  

 The term “resolution” refers to the number of pixels of the digital image produced by the 

camera. 

 The term “pixel density” refers to the concentration of pixels on a particular surface or device. 

 White balance is used to balance the color temperature of the image. 

 Overall, the image can be evaluated based on the shutter speed, ISO, white balance, lens type, 

density of camera and exposer of camera. 

 

Activities 

1. Capture image (portrait and landscape) of indoor by using different setting of camera.  

2. Capture image (portrait and landscape) of outdoor by using different setting of camera. 
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Notes for Teachers 

 Help students in understanding the assembling and disassembling different kinds of 

cameras. 

 Discuss the use of ISO, Shutter Speed, Focus, Exposure and other parameters (various 

combinations) in detail and their usage. 

 Discuss with students about the photography as a career. 

 Discuss with students about the requirements of indoor and outdoor shooting 
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EXERCISE 

Select the most appropriate option 

 
1. The literal meaning of “Photography” is _________________________ 

a. making a picture                b. drawing with light 

c. recording      d. capture  

2. ________________________ is used as a display technology in cameras. 

a. LCS screen     b. LCD screen 

c.   camera lens     d. Camera Shutter 

3. Photographs captured by the camera can be stored on _________________ 

a. Memory card     b. ATM card 

c.   Image sensor     d. Printer 

4. The basic purpose of a _____________ is to focus the available light so that it can be 

recorded by the recording medium. 

a. Shutter      b. Lens 

c.   LCD screen     d. Printer 

5. In photography, a tripod is a ____________ legged instrument which is designed to hold a 

camera securely and steadily. 

a. two       b. three 

c.  four      d. five 

6. When any image is displayed on a screen or printed, it has a physical property that is 

______________________ 

a. Pixel density     b. pixel weight 

c. Pixel Density     d. Pixel Accuracy 
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7. _________________________ is the sensitivity of the camera's sensor to light. 

a. ISO      b. shutter  

c. Image sensor     d. Lens 

8. _______________ of camera refers to the amount of light that touches the camera's sensor 

while taking a photo or video. 

a. ISO      b. shutter speed 

c. Exposure     d. white balance 

9. Larger aperture size and ISO values are associated with _______________ exposure of the 

image. 

a. Increased     b. decreased 

c. Minimal     d. Maximum 

10. The _________ shutter speeds are associated with lesser exposure and ____________ 

shutter speeds are associated with increased exposure. 

a. Faster, slower      b. slower, faster 

c. Faster, faster      d. slower, slower 

Answer the following short questions 

 

1 Define photography. 

2 How ISO effects our pictures? 

3 Enlist different components of camera. 

4 What is shutter speed of camera? 

5 What is the function of camera shutter? 

6 State at least four purposes of photography. 

7 Differentiate between density and exposure of camera. 
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8 Describe the purpose of flashlight in camera. 

9 What aperture settings do we need for outdoor shooting? 

10 What will be aperture settings for far-away subject in indoor and outdoor shooting? 

 

Answer the following long questions 

 

1. What are techniques of photography? How can we use these to produce quality photography? 

2. Elaborate the functions of major components of a camera. 

3. Define density of camera. Also explain how focus can be adjusted for photography. 

4. Write necessary conditions and requirements of indoor as well as outdoor photography shooting. 

5. Describe basic implications of handheld as well as tripod photograph shooting. 
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CHAPTER 4 

VIDEOGRAPHY 

 
After completing this chapter, students will be able to: 

 learn about concept of videography. 

 identify purpose of videography. 

 know about video formats. 

 describe different techniques of 

video production. 

 understand components of camera  

 know about hand-held shooting 

process.  

 learn about tripod shots. 

 understand different types of 

lighting system 

 learn about location selection for 

recording 

 

 

 

 

 understand about studio lights. 

 learn about warm and cool lights 

equipment 

 understand about intensity of light 

 know about adjustment of focus  

 learn about exposure of camera 

 know about density of camera 

 learn about shutter speed of camera 

 learn about white balance and iso for 

video stabilization 

 learn about indoor and outdoor 

video shooting 
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4. Videography 

4.1. Introduction  

From a technical point of view, videography refers to the use of a camera (smartphone camera, 

pocket camera, electronic camera, etc.) to record video electronically. The person who records the 

video is known as the "videographer". Technically, a “video” is actually a series of images 

(frames), that are captured and finally displayed at a particular frequency. A single image or frame 

can be obtained by stopping the video at a specific frame in the sequence. 

Do you Know 

Motion Pictures are works that contain a series of related images that are intended to be 

shown with a projector, digital display, or other device.  Examples of motion pictures include 

movies, television shows, video games, animations, and similar types of works. 

4.2. Purpose of Videography 

In the past, films were only shown on a large projection screen in a movie theater. Today, we are 

watching a lot of content every day on smartphones, laptops, tablets, TVs etc. Now the access to 

video content is easy, which benefits both individuals and businesses. People can create all kinds 

of videos and share them with anyone. Today's smartphones can record high resolution 4K video. 

In short, technology advancements have given access to videography to almost everyone. Video 

styles and techniques depend on the purpose for which the video is created. Some of the purposes 

of doing videography are mentioned below: 

 Brand awareness  

 Advertisement of a product 

 Documentary films 

 Capturing moments in an event such 

as a wedding 

 Webinars 

 Animations 

 Educational or tutorial videos 

 Presenting reviews of a product or 

place  

 Testimonial videos 

 Recording interviews 

 Entertainment, dramas and movies 
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4.3. Video Formats 

Different video capturing devices record videos in different formats. With the passage of time, the 

interoperability between devices playbacks got improved. Now a days, a single device can record 

video in various formats. These formats, however, have different properties and qualities. 

Understanding the format that a camera shoots in, helps in estimating how much storage space will 

be required to shoot a video footage. Most of the video editing software can handle major formats. 

Different video formats have been briefly discussed as follows:  

 AVCHD 

AVCHD is an abbreviation of Advanced Video Coding, High Definition. This is the default format 

jointly developed by Panasonic and Sony, this file format is used for recording videos with cameras 

of both the brands. Due to the high video-quality it supports, this format is very popular among 

professional videographers. 3D videos can also be recorded in AVCHD format. 

 MKV 

Matroska or MKV is a free and open-source format. It was originally developed and used as a 

standard video format for multimedia files such as movies and shows. A single MKV file can 

comprise a large number of images, subtitle tracks, and audio. 

 AVI 

AVI is an abbreviated as Audio Video Interleave. This video format was once considered the 

absolute best choice in the market. It was developed by Microsoft in the 1990s, and although its 

popularity has declined with the emergence of new compression formats, it is still widely used. 

Some camera brands such as Olympus and Nikon use this format. It offers full compatibility with 

PC and Mac devices. 

 MP4 

MP4 is another Apple product. MP4 video format was created for low bandwidth compression, 

which means that the image quality is significantly lower than other file types. Since it is 

compatible with Apple devices as well as other devices (such as Xbox360), it is being used in 

iTunes store. 
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 FLV 

FLV stands for Flash Video Format. It is complementary to another Flash video format, SWF. 

FLV is one of the most common video formats, however, it has some major shortcomings. For 

example, IOS devices do not support Flash, which means it cannot be played on iPad and iPhone. 

 MOV 

MOV is Apple's QuickTime movie format. This video format was created for movies and allows 

videographers to break down files into different tracks to store different types of data. Canon DSLR 

cameras uses a variant of MOV. 

 WEBM 

WEBM, as the name suggests, was developed to be used on websites. This video format together 

with HTML5, produces very small-sized videos that can be easily streamed with almost no-load 

times. Due to the improvement in performance and limits of online platforms, its popularity has 

recently declined significantly. 

 WMV 

WMV is an abbreviation of Windows Media Video. It was created by Microsoft to dominate the 

field of online streaming. This is the smallest video size available and is ideal for email sharing. 

Major shortcoming of this format is that the video quality during and after compression is 

drastically reduced. 

Do You Know: 

There is no one size fits all when it comes to video sharing. The good news is that it is actually 

easy to transfer between video formats. If you do, make sure to always save the original file to 

avoid degradation of image quality due to file compression. 

4.4. Different Techniques of Video Production 

The production techniques adopted to produce a video vary from country to country, person to 

person, and business to business. Different videography techniques depend on the purpose for 

which the video is created.  

Based on camera and voice recording, video production can be divided into two types: 

 Multicamera production  Off screen voice 
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Multicamera production: In this type of video production, multiple videos of the same subject are 

captured at the same time, which are then integrated to make a single video. For example, a scene 

of drama or film is recorded by using multiple cameras, then the final video is made by cutting and 

editing specific parts of scene from each camera.  

Off screen voice: In this technique of video production, video does not capture and present the 

voice of the captured scene. However, the voices and videos are recorded separately and then the 

final video is a video with a dubbed voice. 

Planning about which elements or shots need to be taken in order to tell a story or demonstrate 

something, is important. For example, close-up shots are used to capture details of the subject, 

such as the facial expressions of an actor in a movie scene. Based on composition of the frames, 

techniques can be categorized into four major groups: 

 Close-up Shot 

 Medium Shot 

 Long Shot 

 Extreme Long Shot 

Close-up Shot: A close-up shot is a shot of an object or person to capture the details of the subject. 

When filming a scene of movie, close-up shots are used to frame the face of characters in order to 

convey their emotions to audience.  Close-up shots are also used to reveal details of an objects or 

the environment in which the video is being shot. For example, close-ups can be used to show the 

viewers that attention needs to be paid to certain symbol that is being carried out throughout the 

video. 

Medium Shot: A medium shot is taken with a medium distance of subject from the camera. In 

dramas and film making, videos are captured with medium shot where back and forth dialogue 

between the characters are shown. Medium shot allows the viewers to see the details of the subject 

as well as the surrounding settings. For this reason, medium shot is also called “sweet spot”. 

Long Shot: A long shot is also referred as wide shot. Long shot is used to show full length of the 

subject as well as a considerable portion of the surrounding area. In filmmaking, a long shot is 

often used as an establishing shot. 

Extreme Long Shot: Extreme long shot is used to capture larger areas e.g., landscapes. This type 

of shot is also called extreme wide shot. In this shot, subject is so far away in the frame view, that 
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Activities 

 Group presentation on techniques of videography 

 Video shooting using handheld, floating and drone 

 

it is not necessarily the focus anymore. This shot is used to show the audience where the action is 

taking place.  

Based on camera movement, techniques can be divided into following categories: 

Handheld shot: These shots are taken with video camera in hand instead of being mounted on 

tripod. 

Floating cam shots: The shots taken by moving subject as well as subject mounted on dolly, are 

called floating shots. 

Crane / jib shot: A crane / jib shot is the one captured at hights. It is captured by using a crane 

or jib to lift the camera and videographer. This technique has been replaced by drone video 

recording. 

 

 

 

4.5. Components Of Video Camera 

Almost all modern digital photographic cameras can be used for recording videos as well. 

However, cameras designed especially for videography, provide more useful features for recording 

various kinds of videos. Variety of video cameras are available today (Web cams, camcorder, 

professional cameras), each varying in components, technology, and sizes etc. However, there are 

some essential components which are common in all video cameras. These components are briefly 

discussed below: 

Lens:  

The lens on a video camera serves as the same function as a still camera's lens. It draws in light 

and captures the image at which the camera points. This telescopic piece can have multiple lenses 

within it. A number of dials on the tube will shift the lens positions by turning them, and this 

controls how the lenses focus the light they receive to clarify the picture. 
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Image Sensor 

Image sensor is a sensor that detects and conveys information used to make video frames. While 

making a video, light passes through the lens, aperture, and shutter, then it hits the image sensor, 

which records the frames of the video. 

Viewfinder 

The viewfinder is directly connected to the lens and is meant to provide access to the image for 

the user. This can be a simple eye-sized window, or it may be a small pixel screen that folds into 

the camera when not in use; many models have both versions. Viewfinders also double as a video 

screen for playing back the recorded image. 

Microphone 

The lens picks up only the visual images for the camera, meaning this alone would create a silent 

picture. Video cameras, therefore, also include microphones that record sound in the area. The 

microphone is usually mounted next to the lens and pointing in the same direction so the audio and 

video are closely in sync. 

Recorder 

The recorder processes the images received by the lens and the sound from the microphone and 

records them to memory. On older analog cameras, this would record the image onto a magnetic 

tape within a cassette. Some cameras would take full VCR tapes, but others require miniature 

versions of these cassettes or other formats like Hi8. Digital cameras eliminate the need for 

cassettes. The camera instead records the image as a computer video file. In most cases, this file 

is in JPEG format. 

Controls 

The camera's main controls include the Power switch and the Record button. It will also include 

playback buttons such as Play, Stop, Rewind, Fast Forward and Pause. The controls also include 

output ports to connect the camera for playback. All cameras should include the basic 

red/white/yellow RCA cables to connect to any playback machine, but they can also include USB 

or FireWire controls for connection to a computer. 
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Battery 

Battery power is essential for camera use. Every camera is equipped with a rechargeable battery. 

Most batteries are lithium-ion based, and each is made and designed to work specifically with its 

camera model only. A full battery charge can usually take 12 hours, meaning an overnight charge 

will suffice 

Quadcopter Drone 

 A “Quadcopter drone” refers to a drone that has four rotors and is 

remotely controlled instead of being controlled by a pre-

programmed, onboard computer. Quadcopter drones with camera, 

can be used to make videos from certain height.  

Tripod 

In photography and videography, a tripod is a three-legged device which is designed to securely 

and steadily hold a camera. Most tripods have a central pole and height adjustable legs and are 

used in conjunction with mount to which a head is fixed. A tripod is a supplementary component 

in videography to hold camera.   

4.6. Handheld Videography 

Handheld videography is recording the video with the video camera in hand. There aren’t any 

devices used to stabilize the shots and to keep the motion uniform. The videographer uses his 

hands and his motion to capture video. Videos that are recorded using handheld videography are 

shaky and the motion in the scene is not uniform. Some special scenes are captured with handheld 

approach e.g., display of rush or urgency. People who don’t own tripods also use handheld 

videography. 

4.7. Tripod Videography 

Tripod videography is easier and can produce quality shots as compared to handheld recording. 

As we know, tripod provides stability in the shots, sing tripod is essential in professional  
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videography. Other than stability, tripod also provides other functions. For example, time lapse 

videos are shot using tripod.  

4.8.Types of Lighting Systems 

 

Various factors contribute in making a successful video for a specific purpose. One important 

factor among those is lighting. It is important that you understand the advantages of each method 

and be able to make full use of these to achieve the purpose for which video is being made. The 

following are different types of lighting systems used in making videos:  

 Key lighting 

 Fill lighting 

 Backlighting 

 Side lighting 

 Practical lighting 

 Motivated lighting 

 Bounce lighting 

 Soft lighting 

 Hard lighting 
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Key Lighting 

The key light refers to the main light source being used for shooting a video. It is the most direct 

and intense source of light in the video. If the key light is placed behind the subject, it would darken 

the frame however the scene would look dramatic. Placing camera too close to key light should 

also be avoided because the lighting will seem extremely flat.  

Fill Lighting  

Key light sometimes creates shadows, and fill lighting is used to illuminate these 

shadows. Fill lighting is also used to decrease contrast in the scene, by 

illuminating the objects that are not subject but need to be shown. For example, a 

fill lighting can be observed in Figure 4.11.  

 

Backlighting 

Backlighting deals with lighting up the background of the shot in a certain way. 

For example, If the scene is supposed to dark and mysterious then small red lights 

are used. Background lighting gives the whole frame a nice contrast and makes 

the video interesting. 

Side Lighting 

Side lighting, as the term suggests, reflects your scene from the side, parallel 

to the object. Sidelight highlights the texture or edges of the scene. It creates a 

better sense of depth in a certain way. For example, by using side lighting, the 

distance between the subjects can be highlighted and manipulated. Side lights 

can also be used to add mystery to the image.  

Practical Lighting 

Practical lighting is about using daily life light resources for example candles, 

lamps, television screens, tube lights and other sources whose light will be shown 

onscreen. These are usually used to bring the emotion of a night scene in a movie 

shoot. Sometimes practical lighting is used to create skillful artistic effect of 

lighting on the subject.  
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Motivated Lighting 

 

Motivated lighting is about using artificial lights to imitate a natural light 

source such as sunlight, moonlight, and street lamps at night. Motivated 

lighting is also used to enhance practical lights.  

 

Bounce Lighting 

Bounce lighting is basically bouncing or reflecting the light from a high intensity 

light source towards your subject or scene using foam, or any light-colored 

surface or silk boards. Arranging lights in this formation creates a wider area of 

light which is more evenly spread out. Bounce lighting is used where a clean 

and wide spread of light for the whole environment is required.  

 

 

Soft Lighting 

Soft lighting is a balanced lighting setup. It is used for both the situational and 

aesthetic purposes. In term of situational purpose, it is used to produce lighter 

contrast in the frame being shot. When soft lighting is used, the transition between 

the light and shadows is smoother and less noticeable. In terms of aesthetic 

purpose, soft lighting is used for beautification of the subject by minimizing the 

blemishes, wrinkles etc. Devices such as, soft boxes, octas and rotaluxes are used 

to soften the lights being used for videography. 

 Hard Lighting 

Hard lighting refers to strong and focused light. It creates harsh shadows and 

highlight the contour of the subject. Hard lighting is used to create an intense look 

to the frame or scene being recorded. Hard lighting is used to draw attention of 

viewer towards the main subject or to the main area of the scene.  
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1.1. Location Selection 

One of the important aspects of videography is location selection. As it gives the context of what 

is happening in the scene. For example, for natural videography, a beautiful mountain or forest is 

selected. There are several things that are kept into consideration while selecting a location: e.g. 

the purpose of shooting, aesthetic of location, background noise, lighting and sufficient place.  

1.2. Studio Lights 

Studio in terms of videography refers to the building or room which contains 

setup for producing a specific video. A studio has various lightings and sets, 

which are used according to the purpose and requirements of the video. A set 

consists of scenery and props which are required to be shown for shooting a 

specific video. The imporant things to work with are Foreground, background, 

midground, lightining grid, dimmers and reflectors    

1.3. Warm And Cool Light Equipment 

Colour temperature of light is actually the “colour” of white light radiated by a perfect black body 

at a given temperature. It is measured in degrees Kelvin (K). Smaller kelvin value, that is below 

4000K is considered “warm light” whereas a high Kelvin value, that is, above 4000K is “cool 

light.” Warm light appears in orange, yellow and red tones. Whereas a cool light appears having 

predominantly blue factor. Some of the cool and warm light equipment are discussed below: 

Tungsten Lights: These lights work at high temperatures and produce warm light. Tungsten bulbs 

are often used to simulate sunlight because they produce warm light. 

HMI Lights: HMI is an abbreviation of “Hydrargyrum medium-arc iodide”. HMI bulbs emits a 

6000K colour temperature light to mimic daylight. These lights are bright, cool and flicker-free. 

Fluorescent lights: The colour temperature of a fluorescent varies between 2700K to 6500K. 

These lights are used to light interiors and are more compact and cooler than tungsten or HMI 

lighting. 
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LED lights: LED is an abbreviation of “light emitting diode”. Various LED light bulbs are 

available ranging in colour temperatures. For example, vintage and filament LED bulbs produce 

light around 2700K, while some LED bulbs produce light as low as 1900K. 

1.4. Intensity Of Light 

Intensity of light refers to the power of light at a given position. The intensity of light source is 

measured in lumens. Light intensity controls both, the brightness and illumination of the subject. 

The objects closer to the light source appear brighter as compared to the distant objects. This 

happens because the light spreads out as it travels farther. Intensity of light captured in a video is 

dependent on following factors: 

 Exposure settings of camera  

 Intensity of light source used  

 Distance of objects from the light source(s)  

1.5. Adjustment Of Focus 

 

Focus is a combination of lens aperture and light. Focus, in terms of videography, is the point 

where the objects in the frame are sharpest. In videography, the focus in videos is adjusted using 

lights and camera settings. Camera settings can be adjusted manually or by using the autofocus 

system of the camera. Lighting grids can also be used to focus on the objects that are more 

important than others. By adjusting the camera lens, different types of focus can be achieved, 

which are discussed as follows: 
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Deep Focus: Deep focus is used when all the subjects in the frame are important to be shown. In 

this type of focus, all the objects are in the focus, whether they are in the foreground, background 

or midground. Everything in the scene is clear and sharp. Hence, there is a balance in the frame.  

Shallow Focus: In shallow focus, subject is in focus (i.e., clear) whereas the background is out of 

focus (i.e., blurry). Shallow depth of field is used in shallow focus. Shallow focus is used to convey 

emotions and to direct the eye towards specific objects. 

Soft Focus: Soft focus is somewhat similar to shallow focus, as subject is in focus (i.e., clear) 

whereas the background is out of focus (i.e., blurry). However, as opposed to the shallow focus, a 

glow is added around the subject. Soft focus is used to indicate that the shown scene may be a 

dream or fantasy; it’s not entirely real.  

Rack focus: Rack focus is used to shift attention from one point to another in successive frames 

of the video. That is, the camera changes the focus from one subject to another while the video is 

being recorded. 

Tilt Focus: Tilt-focus is used to create a miniature effect, by defocusing parts of the frame being 

shot. In this type of focus, foreground and background is out of focus, whereas particular objects 

are in focus.  

1.6. Exposure Of Camera 

In videography, exposure refers to the amount of light that touches the camera's image sensor while 

recording video. Exposure in a video is mainly dependent on two things, that are, lighting condition 

and camera settings. Videos that are shot in different lightings but with same camera setting, have 

different exposure to light. In a given lighting setup, the settings for exposure of camera can be 

adjusted by changing: 

 Aperture 

 ISO 

 Shutter speed 

Do you know? 

Resolution of a video is the number of pixels contained in each frame. The more the resolution of 

camera, the clearer and more realistic the video appears. 
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1.7. Density Of Camera 

When any video is displayed on a screen or printed, it has a physical property, that is pixel density. 

Pixel density of a camera refers to the concentration of pixels on a particular surface or device. It 

is measured in pixels per inch (ppi) and pixels per centimetre (ppcm).  

1.8. Shutter Speed of Camera 

Shutter speed is the amount of time the camera sensor is exposed to light, while capturing frames 

of the video. It is measured in seconds or fraction of a second, e.g., 1 second and 1/60 seconds etc. 

By decreasing or increasing the shutter speed, the rate at which shutter opens and closes is actually 

being increased or decreased.  

A frame rate of 24 fps with a shutter speed of 1/48 or 1/50 will give your footage a smooth 

cinematic look and feel. Higher frame rates, such as 60 fps with a shutter speed of 1/120, will allow 

you to slow down your footage at the editing stage and create ultra-smooth slow-motion scenes.  

1.9. White Balance and ISO  
 

Most digital video cameras have a “Native ISO” or “Optimal ISO” setting, which is the ISO on 

that camera that gives you the best signal-to-noise ratio, that is, the best picture with the least noise. 

If you're shooting mostly outdoors, maybe you want a camera with a lower native ISO.  White 

balance is the camera setting that is used to set the color temperature of the frames. Color 

Do you know? 

The frame rate is the number of consecutive occurrences of a single image per second. There is 

no perfect frame rate for videography. They all produce different results. When trying to capture 

the slow motion of a subject, video can be shoot at higher frame rate. 
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temperature affects the perception of coolness or warmness of the scene. Figure 4.21 shows frames 

captured with different manually selected white balance values. 

 

Generally, the following white balance presets are available in cameras: 

 Auto(A): This preset automatically adjusts the white balance depending on ambient light. 

 Shade (House with a Shadow): This setting adds orange color to the photograph.  

 Choose Color Temperature (K): Color temperature can be changed manually. 

 Incandescent (Light bulb): It is used under tungsten light bulbs. 

 Fluorescent (Glowing Tube): It is used under fluorescent lights or if the photograph looks 

too green.  

 Direct Sunlight (Sun): This white balance setting is used in shooting outdoor shooting 

with the sun shining on the subject. 

 Flash (Lightning Bolt): It is used when flashlight of the camera is being used while 

making pictures. 

 Cloudy (Cloud): It is used while making pictures in shades or on cloudy day. With this 

white balance setting, images produced have warmer color than sunlight. 
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Indoor and Outdoor Video Shooting 

Whether to shoot outdoor or indoor depends on the purpose and requirement. In outdoor video 

shooting, the videographer has lesser control as compared to indoor video shooting. The control 

here refers, especially to lighting and voices. For example, for outdoor video shooting, wind can 

interfere voices of characters, natural light can have stronger or lesser intensity than needed, and 

so on. In indoor lighting, audio as well as lighting is more controllable. In outdoor shooting a 

slower shutter speed and smaller aperture size is better to be used.  

Notes for Teachers 

 Discuss with students that how videography is different from still photography 

 Discuss with students that how indoor shooting is different from outdoor shooting 

 Educate students about how to use different types of studio lights and light effects 

 Explain videography as a profession 

Key Points: 

 Videography refers to the use of a camera to record video. 

 Videos can be captured by holding camera in hand, mounting on tripod, fixing on 

quadcopter drone, or mounting on jib etc. 

 The basic purpose of lens is to focus the available light so that it can be recorded by the 

medium. 

 Image sensor is a sensor that detects and conveys information used to make video frames. 

 In a digital camera, videos are stored on memory card. 

  Handheld videography refers to recording the video(s) with the camera in hand. 

 Tripod videography refers to recording the video(s) with camera being mounted on a 

tripod. 

 The key light refers to the main light source being used for shooting a video. 

 Each light source has intensity as well as colour temperature. 

 

 

Activities 

1. Record indoor by using different setting of camera 

2. Record outdoor by using different setting of camera 
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EXERCISE 

1. Select the Most appropriate option 

A “video” is a series of ________ that are captured and finally displayed in a sequence. 

a. media                    

b. images                          

c. frames                         

d. pictures 

2. WMV stands for _____ format: 

a. Windows Media Video       

b. Web Media Video         

c. Web Movie Video        

d. Windows Mobile Video 

3. The basic purpose of _____ is to focus the available light so that it can be recorded by the 

medium. 

a. shutter                                 

b. lens                              

c. flashlight                      

d. chassis 

4. Chassis of a camera is also called ________. 

a. LCD screen                         

b. camera body                 

c. image sensor                

d. camera lens 
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5. A device used to steadily hold a camera while shooting a video is called________. 

a. camera body                        

b. tripod                            

c. lens                              

d. camera stand 

6. Exposure of camera can be adjusted by changing__________. 

a. aperture and lens                              

b. shutter speed                

c. ISO and contrast                               

d. aperture, shutter speed and ISO 

7. Main light source used while shooting a video is called________. 

a. fill lighting                          

b. practical lighting           

c. key light                       

d. indoor light 

8. At a given position, ________ refers to the power of light. 

a. white balance of light         

b. intensity of light           

c. ISO of light                  

d. Contrast of light 

9. Density of camera is measured in __________. 

a. pixels per inch                     

b. pixels per centimetre     
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c. pixels per centimetre            

d. points per inch 

10. While capturing frames of the video, _________ determines the amount of time the camera 

sensor is exposed to light. 

a. shutter speed                       

b. white balance                  

c. ISO                             

d. lens 

Give Short answer the following questions 

1. Define videography. 

2. What is white balance of a camera? 

3. Name at least four types of videos formats. 

4. Elaborate multi camera production. 

5. Describe the uses of a tripod in videography. 

6. What is the function of LCD screen of a camera? 

7. What is a reflector in terms of videography? 

8. What is meant by background in videography?  

9. Which light is used to highlight midground of a scene? 

10. What is the function of lens of camera? 

11. Define chassis of camera. 

Answer the following questions in detail 

1. Elaborate the importance of using different types of lighting systems in making videos 
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2. Discuss adjustment of focus in videography. 

3. What are different components of a camera. Discuss in detail. 

4. Describe techniques of videography in detail. 

5. Discuss the factors to be considered for location selection in videography. 
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Chapter # 5 

Script Writing 

 

After completing this chapter, student will be able to: 

 define script writing. 

 know the purpose of script writing.  

 know the basic structure of script writing (beginning / setup, middle / conflict, and end 

/resolution) 

 generate different ideas about script writing.  

 demonstrate story telling.  

 develop plot of story (dialogue, scenes and formatting.  

 know about working on story board. 

 learn about scripts for tv commercials.  

 know techniques of scripts for reporting.   

 comprehend the structure of script for documentaries. 
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5. Script Writing 

5.1 Introduction 

The word Script is derived from the Latin word scrībĕre, that means "to write". We may write a 

script for a film, a movie, a play, a school drama, a wedding function. Even the grocery list you 

write was also considered as script in old fashion. However, in the modern era, script writing is 

the process of lettering stories in the screen play. Script writing is also known as screen writing. 

Scriptwriting is the process of writing down the movement, actions, expressions and characters in 

screen play format. Mostly writers pen down for films, video games, commercials, screen plays, 

television, online web series, commercials, documentaries and reports etc. We need to understand 

that writing a novel is entirely different from writing a screen play. So, if you write a simple 

sentence, it would not be understandable until we add some more elements in it like adding 

flashbacks of pasts etc. For example, if a writer writes an ad of a washing powder, the writer needs 

to take care this script depicting cleanliness, healthiness, quick stain removal, freshness and ease 

of use etc. The ad duration is normally 15-90 seconds. The scriptwriter has to deliver all these 

messages within this short frame of time in the mind of audience. Another example of this is sad 

scene of a drama. It is the responsibility of the script writer to pass the feelings of grief in the 

audience. They may use depressive words, set up in the room, past flashbacks etc. 

Types of Screen Plays 

The six main script types are: 

 Cinematic Film script 

 Live-Action TV Series.  

 Short-Form Film and Video Content 

 Animated TV Series like cartoons  

 Video Games.  

 Short Web Series and Mini-Series. 
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5.2 Purpose of Script Writing 

Pacing scenes for screen is always challenging. The first most important step to create any video 

project is screen writing. It is equally necessary for each type of project i.e., motion picture, a 

webinar, short training video, YouTube video etc. Script actually describes each shot and dialogues 

of the video. Script is not only limited to writing dialogues. It is a complete package of planning 

the entire video. It involves dialogues, expressions, locations and all other things for each shot. 

Some basic questions that each script answers are: 

1. What is going to be shot in the video? (Main purpose) 

2. Where this scene is going to be filmed?  (Location) 

3. What is going to happen in this second of film? (Time frame) 

4. What dialogues are going to be delivered in this shot by actor or voice over? (Dialogues 

writing) 

5. How much action will happen in this shot? (delivery /acting) 

6. Is the shot really depicting the real idea what the writer wanted to convey? (Final results) 

The script answers all these questions for every second of the screen. So, by this we conclude that 

a script is basic ingredient to any screen project. We cannot work without a script. Having a script 

in hand makes it really easy to shoot. It not only saves time but a huge expense as well. 

5.3 Basic Structure of Script Writing 

There are various structures of screenwriting. But the most common 

used is the classic one. It is also known as Three Act Structure. It is 

the most common used structure. The reason of its excessive use is 

its simplicity. Everything, has, for sure, the start, middle and the end. 

It works on the same frame. The classic structure divided the screen 

play into three parts. The parts are the set-up, conflict, and resolution. 

Numerous screenplays and films follow this format. This is a basic 

go-to-structure for each film of cinema. No film can be said completed without this structure.  
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Numerous screen and script writers and consultants have written volume of books on writing 

script and handling it properly. While the story of films and plays may differ, but the basic 

layout of the plot remains the same. It includes a beginning, a mid and end, shaped and 

paced by few elements or moments. 

Setup 

Setup is the start of your screenplay.  Setup is the introduction to your film, it consists of the 

opening image, defines characters of the story and the main idea of the film. It needs to be 

interesting so the reader and viewer both remain engaged in the story. The setup usually takes start 

pages with lots of visual and emotional drama to keep the audience engaged. Making it clearer we 

are not talking about the turns and twists of the story, just the main idea is enough to keep 

captivating.  One great example of setup is the trailers we see before films. They mention actors, 

main idea and starting line of the film. 

The Catalyst 

The catalyst is actually ‘Call to Action’. It is the 

event that makes your protagonist part of the story. It can be a piece 

of information or an event that drives the main character which is 

usually named as “hero” of the film to set the rest of the story events 

in motion. 

Plot Point One 

We need to plot a point to mold the story. It is the turning point of 

the story, which is commonly named as intermission of the film. 

Usually, in films and plays the hero ushers into second act. He 

leaves his normal world and commits to begin the new life of story. 

In screenwriting, the end of act one is where the hero reaches their 

first major turning point. 

  



85 
 

The Despair 

This is the disappointment point of the screen act. All the hopes and good wills are lost. The 

main character feels disappointed and aimless. The goal of the hero seems to be unreachable. 

The external and internal conflicts are heighted and main character reaches low point. This is 

where the heroes feel defeated, and perhaps they won't succeed in their endeavors. 

The Redemption 

At this stage, the main character either conceive of a winning plan or the hero is emotionall y 

strengthened to solve the problem and resolve conflict once and for all. We can say this is the 

energetic stage to defeat the problems. As the redemption progresses, the hero pushes forward 

with an attempt that might save the day. 

The End 

This is the wrapping stage of your script. It is not necessary that story should reach a happy end 

or a neat button ending. The end should give a conclusion or sense of closure. The end is the 

most important part of any screen play. People usually carry the end part in their minds to their 

homes. We may not exactly remember the whole story of the film or dramas after few years of 

watching. But we may easily remember its ending. The scriptwriter should keep the end more 

engaging for viewer.  

5.4 Generating Different Ideas about Script Writing 

The first step of script writing is generating an idea. Idea generation is the key to write a solid 

script. It is like putting the train on track. Being human, we may have many ideas or may take 

inspirations to generate ideas. Here are few inspirations for idea generation for a screen play: 

 Surrounding Real Life Events 

The easiest and common way to take inspiration is your own life. You can write on the 

happenings related to you or your surroundings. Sharing travel experiences, life stories , sad 

and happy moments and cultural differences are a good way to start with.  

 Media Inspiration  

Media plays a vital role in inspiring youth. It is a common practice to take inspiration from 

films, music, peer groups and adapt them in your own way. Tiktok challenges like Ice bucket 
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challenge is one of the popular inspirations from media. Usually, films carry same genre and 

code, like love and horror films. It is easy to write on defined norms and code.  

 Be Your Own Inspiration 

You can write about your own happy and sad moments. Biography and lesson-based scripts 

are written by people with great pain or happiness. 

 Work Backwards 

You can write your script on your passion. Twitch is the new social media that is 

promoting people to play video games with voice over. This is great technique for people 

who love video games. 

 Stick to a Typical Genre 

Some people write scripts for all types of work. But few restrict themselves to a specific 

genre like romance, horror, entertainment, history or action etc.  Writing in one domain 

makes it easier to play around in the start of the career.  

Examples of scripts based on ideas generation 

1. Based on a true story Joy, The Wolf on Wallstreet 

2. Influenced by other films Star Wars, Kill Bill 

3. Based on legends  Mulan, Gladiator 

4. Based on a novel Dexter TV series, Blade Runner 

5.5 Story Telling 

Storytelling or narrative is a method to present connected events to tell an interesting story. A 

great narrative unites sets of distinct concepts, ideas or plot into a narrative essay, novel or film. 

Narrative is an ancient practice from people talking and sharing their daily basis stories and 

poetries.  
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Types of Narrative Writing 

Linear Narrative 

In linear narrative, the scenes and events are presented in the order of which they are occurring. 

In linear narrative, scenes are created by delivering the dialogues of the first person, second 

person and third person in order. The reader discovers the events of the character’s life unfold 

in chronological order.  

Non-linear Narrative 

In non-linear narrative the events of the story are not presented in order of happening. In this 

type of narration, the scenes are clarified with the help of supporting elements. We often 

visualize flashbacks and other fictitious devices to shift the chronology of a story. Novels are 

true example of non-linear narrative. These types of projects usually build the feeling of 

suspense throughout the project. 

Quest Narrative 

In quest narrative, the story is usually based on one main goal and its achievement of the 

character. The character works tirelessly to achieve its goal. In this type of narration, the 

character is in another space like foreign or any island and the issue is situated in another land. 

The hero faces great difficulty to reach the desired location and achieves his goal.  

Viewpoint Narrative  

Viewpoint narratives are usually a type of narration designed to express the opinions of 

viewpoint or personal experience in the story. All the moods, feelings, and other sensory details 

are presented through the narrator’s own life and thinking.  

5.6 Develop Plot of Story 

Once the script is ready and checked, now it is time to plot the story. Although, script has given us 

a lot of information about when and how of the project. Plotting the story now involves producers, 

directors, and management boards to actually visualize and plot the project. Each task is assigned 
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to a team.  In narrative writing, a plot is the sequence of events that make up a story, whether it’s 

verbal, written, filmed, or sung. The plot is the story, and more specifically, how the story 

develops, unfolds, and moves in time. Plots are typically made up of five main elements: 

1. Exposition: At the beginning of the story, characters, setting, and the main conflict are 

typically introduced. 

2. Rising Action: The main character is in crisis and events leading up to facing the conflict 

begin to unfold. The story becomes complicated. 

3. Climax: At the peak of the story, a major event occurs in which the main character faces 

a major enemy, fear, challenge, or other source of conflict. The most action, drama, change, 

and excitement occur here. 

4. Falling Action: The story begins to slow down and work towards its end, tying up loose 

ends. 

5. Resolution / Denouement: Also known as the denouement, the resolution is like a 

concluding paragraph that resolves any remaining issues and ends the story. 
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5.7 Working On Storyboard 

 

The story board is similar to any organizer, that graphically arranges your script. They are a 

powerful method to present script in the form of graphics. Each scene is visually described with 

the help of drawings call by cell. Each cell presents the story, explain the happenings, and presents 

the passage of time. They are the sequential drawings to narrate the story. Story boards are bit 

sized chunks that allows the author to pay attention to each cell of the script.  

5.8 Script for Tv Commercial  

The time span of TV commercial is short. The time to win over the target audience lies between 

15, 30, 60 or 90 seconds at maximum. A well-paced TV commercial script can only be conveyed 

in this little time. 
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The best commercials scripts can be achieved by defining a clear storyline, the obvious tone for 

the target audience, an engaging theme, and a clear call to action. The below picture depicts the 

story with timeline. 
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Defining a Clear Storyline 

A simple screen story can never be boring because It’s always easy to understand it. The beginning, 

middle, and end of a script should be in a logical sequence and clear. Unique and interesting stories 

capture the audience quickly, introduces tension and provides with a solution in the end. 

Many TV ads follow approach of pain and solution point. We need to develop an emotional 

response in the audience. Emotional response is a blend of both visual and audio running together. 

Set the Tone 

A funny commercial is enjoyed by everybody. But in real life, it is the most difficult script type 

for client’s approval. It is difficult to find the right tone and align it with the brand. You need to 

select words that resonates with the target audience. In the month of Ramzan, we see usually 

donation ads and tone is spiritual in those ads. 

Types of TV ad tone may be: Powerful, interesting, happiness, energetic, reliable, trustworthy 

and sophisticated, classy, sincere, or soothing etc.  

Pick a Call to Action 

The brand develops an awareness in ad and then translate into a tangible call to action. If a script 

does not have a call to action, it is failure for sure.  

5.8 Script For Reporting: 

Scripts for reporting are different from script of a TV ad. In reporting there 

are no stories, but, the facts about the event or incident. In the start of the 

news, the reporter usually greets the viewers, tell date and time, goes for 

headlines in the beginning, the then reports the news in detail.  

Elaborating The Headlines 

After the small greeting and the main headline, now the reporter starts with brief description of each 

headline. The first headline is the most important and surprising.  
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After the first phase of headline short greeting, the reporter opens up on headlines. Initially, they start with 

shocking and major topic to grab audience attention. It has a very limited period of time but more than TV 

ad. 

5.9  Script for Documentaries 

Scripting a documentary is unique in its own. Documentaries may be based on real time scenarios, animal 

habitat, and people living in rural areas or special ethnic groups. We can only have a major goal of the 

documentary. The script is only shortened to main idea, location, setups and time. What to say and how to 

say is usually determined on the set. Editing software are used to cut the pieces that are not suitable 

according to the goal.  Most documentaries are funded by the relevant organizations or NGO’s.  
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EXERCISE 

 
Select the Most appropriate option 

 
1. The average time span of a television commercial is between ___ to _____ seconds. 

2. Script writing is the process of writing down the________________________, 

expressions and characters in screen play format.  

4. Script is a complete package of _____________ the entire video. 

5. A ______ ad is loved by all 

6. Storyboards are used in business to show_______________________________. 

7. The news caster first _____________________. 

 

Give Short answer the following questions 
1. Define script with examples. 

2. What questions do a good script answer? 

3. Discuss basic structure of script writing. 

4. Describe any two steps of writing a script in detail. 

5. What are types of narration writing. 

6. Describe storyboarding in detail. 

 

Answer the following questions in detail 

 
1. Draw the flow diagram of TV commercial in detail. 

2. Write down steps of reporting in detail. 

3. Write a script based on moral story. 

4. What is storyboard and why it is used? 

5. Describe types of narrative writing. 
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Chapter 6 

ADOBE AFTER EFFECTS 

(BASIC)
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After completing this lesson, students will be able to: - 

● Define Adobe After Effects. 

● Describe purpose of Adobe After 

Effect. 

● Know about installation steps for 

Adobe After Effects Software. 

● Learn about source material (audio, 

video, still image) 

● Understand concept of the file 

extension. 

● Use Motion Graphics 

● Know the attributes of Motion 

Graphics 

• RGB Color Model 

• Frame size of the composition 

• Resolution. 

• Pixel Aspect Ratio. 

• Alpha Channels 

• Frame Rate 

• Time Code 

• Interpreting Footage 

● Start working in After Effects 

● Create a new project  

● Customize workspaces  

● Set a project by using attributes of 

motion graphics  

● Add a composition and arrange 

layers  

● Know types of shapes. 

● Create Custom Shapes. 

● Know about default properties of 

shape layers 

● Add/ Edit properties. 

● Create shape groups. 

● Learn about Masks. 

● Create a mask with Pen tool. 

● Edit mask as per requirement. 

● Learn about feathering the edges of 

a mask. 

● Learn to replace the content of the 

mask. 

● Understand mask interpolation. 

● Learn about Text Animation. 

● Create and format point text vs. 

paragraph text. 

● User Animation preset. 

● Learn Text Animation on the path. 

● Animate imported Photoshop text. 

● Animate text using a path animation 

preset. 

● Describe Puppet tool. 

● Understand Deform pins. 

● Define areas of overlap. 

● Understand stiffening an area. 

● Animate pin positions. 

● Record animation. 

● Comprehend working of the following Time remapping 
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• Motion sketch. 

• The smoother. 

• The wiggler. 

• Auto orient. 

• Splitting a layer. 

• Adjustment layers 

● The effects and presets panel Import video clips. 

● Import stills. 

● Import a sequence of stills. 

● Import multilayered Illustrator file. 

● Import multilayered Photoshop files. 

● Apply Composition as per requirements. 

● Apply effects to a layer 

● Change parameters as per requirement 

●  Create keyframes (auto, Continuous, and Bezier interpolation Temporal and spatial) 

● Learn about Roving 

● Learn Animation preset 

● Preview your work 

● Learn creating Templates for the Render Queue. 

● Templates for Render Queue. 

● Export using the Render Queue 

● Render movies using Adobe Media Encode
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6. Adobe After Effects 

6.1 Introduction 

Adobe After Effects is a 2D and 3D animation software used to create animations, visual outcomes, 

motion graphics, compositions and other post-production work.   

Animation 

Animation is a methodology within which figures are manipulated seem like moving pictures. 

Composition 

Compositing is the method or technique of mixing visual components from different sources into 

one unite image, typically to create an illusion that each one of those elements is considered as parts of 

a similar scene. 

Visual Effect 

In filmmaking, visual effects (VFX) are the creation or manipulation of any on-screen imagery 

that does not physically exist in real life. VFX allows filmmakers to create environments, objects, 

creatures, and even people that would otherwise be impractical or impossible to film in the context 

of a live-action shot Purpose of Adobe After Effects 

6.2 Purpose of using After Effects 

After Effect is a multipurpose software having many interesting features to create attractive 

productions.  Major purposes of using it are: - 

 Create cinematic movie titles, intros, and transitions. Remove an object from a clip. Start 

a fire or make it rain.  

 Animate a logo or character. Even navigate and design in a 3D space. With After Effects, 

the industry-standard motion graphics and visual effects software, you can take any idea 

and make it move. 

  Animate titles, credits, and lower thirds. Start from scratch or with presets available right 

from the app. From spin to swipe to slide — your text is on the move.  

https://www.adobe.com/products/aftereffects/motion-graphics.html?promoid=L7NVTR46&mv=other
https://www.adobe.com/products/aftereffects/vfx-visual-effects.html


98 
 

 Set anything in motion with keyframes or expressions. Or use presets to kick off your 

designs for unique results. Change a scene’s setting. Add a moving object. Make selective 

color adjustments. Or choose from hundreds of presets and effects to quickly bring your 

videos to life. 

6.3 Installation: 

The installation of the software can be done easily from adobe.com website. 

Step 1: Go to the URL https:/ /www.adobe.com/products/aftereffects/free -trial-

down-load.html as, shown in figure. 

 

Step 2: Click on the “Try for free” button, you will be redirected to the next page, where you will 

be asked to choose between After Effect or all the  creative cloud applications. Click on the “Start 

free Trail”, as shown in figure                  

http://www.adobe.com/
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Step 3: On the next page, you will see the complete payment summary. Enter your email ID and 

other credentials and click on continue. 

Now you can start your installed software 

 

 

Home Screen: 

The following figure shows us the home screen and user interface of Adobe After Effects, as 

shown in figure. 
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6.4 Source Material 

Source materials are the files that are used in After Effects which include videos, images and 

audio etc. The following terms are explained in detail below. 

Audio 

Audio is defined as sound, especially when recorded, transmitted, or reproduced. An audio file 

format/source material is a file format for storing digital audio data on a computer system. The 

file extension of audio file for- mate includes MP3, WAV, M4A, WMA, so on. 

Video 

Video is defined as the recording, reproducing, or broadcasting of moving visual images. The file 

extension of video file format includes.MOV, WMV, MP4, F4V. 

Still Images: 

A still image is a picture in which a grid or formation of  image components (pixels) has been 

mapped to represent a visual subject.  The file extension of the still image file format includes 

JPEG, PNG, TIFF etc. 

6.5 File Extension 

AEP 

An AEP file is a video piece of a written project created with Adobe After Effect. It contains 

video composition that has audio, image and video clip, a timeline and numerous effect which 
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will be applied to the movie. AEP files are used for making professional quality video 

productions. 

 

AET 

A guided project is a file with the extension name “.aet”. You will produce templates that are 

supported by your projects. After effect create a new “untitled project” based on the template. 

Saving changes to  the current project does not have any effect on the template project. 

6.6  Uses of Motion Graphics 

Graphics design and motion design don’t have hard and fast, right or wrong ways to do things 

like others fields do. It depends on your creative mind and imagination. How will you  portray an 

idea in the form of motion graphics? 

Motion graphics are best for outlining or emphasizing facts and illustrating a point you’re trying 

to make. Motion graphics are used when there’s no need for narrative or storytelling. 

Motion graphic videos can break down your complex services or products and present them in a 

memorable way. Remember, motion graphics are at their core visual aids, so they excel at 

teaching hard-to-understand ideas through visuals. 

6.7 Attributes of Motion Graphics 

Motion graphics is actually graphics style created video. This style combines sound, text, charts, 

symbols and animation to convey hard information and written information in a compiling and 

clear way. 

Color Model 

The color model is an added substance shading 

model in which the red, green, and blue essential 

shades of light are added together in different 

ways to repeat a comprehensive exhibit of tones. 

The model's name comes from the initials of the 

three added substance essential tones, red, green, 

and blue. RGB colors are primary colors and best 

for onscreen display. 
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Frame Size 

Frame Size portrays the size of a solitary video 

outline: width x height, esti mated in pixels. The 

width of the frame can be different, contingent 

upon whether the pixels in the casing are square 

pixels or non-square pixels. PC designs utilize 

square pixels, though camcorders utilize non-

square pixels. If making illustrations for video 

along these lines, utilize the square pixel outline 

size as shown in figure 6.10. To create a video, sequential pictures are used in frames per second 

technique.  

 

Resolution 

The resolution is the number of pixels (individual 

marks of shading) contained on a presentation 

screen, communicated by the number of pixels on 

the lever pivot and the number on the upward hub. 

The bigger the screen, typically the higher the 

number of pixels it upholds. The higher the screen 

resolution means that more objects can be placed 

on one screen (but smaller in size). 
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Pixel Aspect Ratio 

Pixel Aspect Ratio portrays the connection 

between the width and tallness of a solitary pixel. 

Distinctive pixel angle proportions are the 

justification for why two video pictures with 

indistinguishable casing sizes can show up as 

various sizes on screen. Simply, aspect ratio means 

the dimensions of the picture. These may be square 

1:1, wide 1:4 or extra-wide 1:9.  

 

Alpha Channels 

Consider it like an imperceptible fourth channel, which saves any straightforwardness settings for 

the picture. Alpha channels also allow you to confine a specific part of your frame, so it can be 

altered and stored for later use. An example of the alpha channel is shown in figurer 6.13. Alpha 

channels are used to create transparent (see through) images / part of images. 

 



104 
 

6.8 Working with After Effects 

Adobe After Effects is a great software to produce quality videos in less time. Now, you will start 

working on your first project, customize workspaces, and add compositions. 

6.9 Creating a new project 

 Following are the steps to create a new project. 

Step 1: 

Launch Adobe After Effects. After launching, you see the main interface (workplace). You can 

see new project buttons as shown in figure 
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Step 2: 

After clicking on the new project button, you are presented with the de fault workspace of Adobe 

After Effects. Here you can successfully create your first project, as shown in figure 

 

6.10 Customize workspaces 

Everyone has their preferences and his / her way of work. Adobe After Effects allows us to 

customize the workspace according to  personal needs. For example, if someone want to create an 

animation, there is an animation workspace already, which includes essential tools for animation. 

Review and concealing boards 

To change your work area, you can open, stow away, move, resize, or dock boards. This 

usefulness makes the After Effects interface adjustable to meet your inclinations and working 

style. Following are the means to view and conceal boards. 
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Step 1: 

After clicking on the new project button, if you want 

to view a panel in      your workspace. Follow these 

steps:  

Select Window button > Click on Workspace > 

Animation to change the current workspace. As 

shown in figure.  

Step 2: 

After clicking on animation, you would notice changes, 1st the workspace name has been changed 

to “animation” and 2nd the workspace panels have been changed as well as shown in figure. 

Hiding and collapse panels 

You can also hide unnecessary or not required panels from your current 

work space, or you can collapse those not required / not in use. 

Docking and Un-Docking 

Panels are docked to the sides of the application window and stacked one 

another. This makes a genuinely steady, interlocked interface that can 

scale to fit a broad scope of screen goals. Periodically, you may track 

down that the default docked arrangement isn't profitable. In such cases, 

you can change the default by docking and undocking boards to suit your 

work tendencies. 

 

Snap the tab at the highest point of the Align board. Press and hold the Ctrl button while hauling  
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the Align board to the focal point of the screen. This eliminates the board from the docked 

interface, making it an undocked, or skimming, board as shown in figure 6.20. 

Using drop zones 

The drop zone is where you can place the panel's Adobe  

After Effects 

Resizing 

As well as stowing away, opening, docking, and undocking 

boards, interface let you effectively resize docked boards, 

so they occupy pretty much room on the showcase. 

To do this, Spot the cursor on the dim, dark, vertical 

splitting line between the Composition and Project 

boards. The cursor changes to a twofold bolt when it 

is drifting over the isolated line. 

Saving workspace 

You can save changes of your workspace and save 

them as a new or revamp the workspace. Custom workspaces grant you to display the panels  you 

require. Here you will save a custom workspace. Steps for saving a workspace are listed below. 

Select panels which you wish to be in your 

new workspace. Close or rest the boards from 

your workplace. e.g., there are only two panels 

in the current workspace, and we want to 

create a new workspace of only these two 

panels.  

 

After you clicked either “save as a new 

workspace” or save changes to current 

workspace,” a new pop-up will appear. You 

can give “name” Your  new workplace and click OK as shown in figure 6.27. 
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Your new saved workspace would appear on the upright of your layer bar, as shown in figure  

Resetting workspace 

If you want to undo the settings of your current 

workspace layout, you can reset your current 

workspace setting to default. Select Window button 

> Tap work Workspace > Select Reset ‘Animation’ 

to open the Reset dialog > Click to Rest to Saved 

Layout. 

 

6.11 Project with Motion Graphics Attributes 

So far, we have learned how to create our first Adobe After Effects project without any motion 

graphics attributes or settings. In this section, we will  walk you through how to develop projects 

based on motion graphics attributes. We will learn how to add our first composition and arrange 

layers in our timeline. 

Before creating any sort of project, first, we need to set the requirement and attributes of that 

particular project. Which includes setting the frame size, frame rates, pixel shape, time code. 

Steps for setting project with motion graphics attributes are given below. 

6.12 Adding Compositing 

A composition in After Effects is almost similar to a film cut in Flash Professional or in Premiere 

Pro. You render a sequence to make the frames of the last yield film, which is encoded and 

exported. Steps to add compositing to a project are listed below. 

Name the Composition 

A new menu will appear after clicking on New Composition button called Composition Setting. 

This Composition settings contains serval option which includes composition name, frame size, 

presets, pixel aspect ratio and frames. 

● Step 1: 

First set up the composition name, by double clicking inside the box on the right of Composition 

name as shown in figure. 
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Do you Know: 

You can set up Frame Size and Frame Rates by using a Presets as well. 

PRESETS are already saved frame sizes of different multi-media screens. 

 

A drop-down menu will pop up and you select desired setting according to your requirements. As 

showing in the figure. 

You can create a New Composition in several possible ways. Following are the ways you can 

create a new composition. 

Click on the new Composition button appear in the center of your workspace as shown in figure 

or Press CTRL + N to create a new Composition.  
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cording to the requirements, select your Composition Settings as mentioned in picture below 

 

You can select any preset according to your need 

 

Step 2: 

Set up Pixel Aspect Ratio. By default, it is set to “square pixel”, it is utilized essentially in advanced 

video programming, where movies should be changed over or reconditioned to utilize video 

frameworks other than the first as shown in figure 
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Step 3: 

After setting up the desired Height and Width of the Frame. The next    step is to set the Frame 

RATE of the composition button as shown in figure. 

You can enter the number of frame rates manually or click on the arrow and open drop-down 

menu and then select the required frame. 

Step 3: 

Rendering resolution is basically a quality of frames shown while preview the media. Remember, 

this resolution depends on your system capability as shown in figure 6.36. 
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Step 4: 

Set the duration of the composition. Duration of a composition means how long you composition 

would be. Following is the syntax to set duration of a composition. For instance, you want to set 

duration of a composition to 1 minutes and 10 seconds and 20 frames follows the syntax as 

shown in figure 6.37 (A) and insert it into the duration box   

as show in figure. 

 

Step 5: 

You can also change the background of the composition by clicking on the Background Color 

Box in figure 6.38. 

 

After you clicked OK button, a regular workspace opened with the composition name on the 

PROJECT panel on the left side of composition panel as shown in figure below as shown in 

figure. 
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6.13 Arrange Layers 

Layers are the components that make up an arrangement. Without layers, the project has no 

starting edge. Use however many layers as important to make your project. With the help of an 

example let’s look in details what the layers are and how we can add layers in  Adobe After 

Effects composition. After creating a new composition in your project, lets add a “solid color” 

into our time space. Steps to add a layer on a composition are listed below. 

 

Step 1: 

After creating a new composition in your project, lets add a “SOLID COLOR LAYER”: Right 

Click on Time-Space > New > Solid > Left Click. 
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Notice, when you create a solid layer two things that happen. First  add new layer is created in 

time bar and a drop down folder was created  in project panel called “SOLID”. Inside that folder 

there was a solid later named “BLACK SOLID 1” as shown in figure. 

6.14 Shapes 

Rectangle, Rounded Rectangle, Ellipse, Polygon, and Star shapes offered in the software. Draw a 

shape straightforwardly in the Composition panel. After Effects adds another shape layer to the 

composition. You can apply stroke and fill settings to a shape and apply activity presets. Similar 

drawing tools can make the two shape and mask. Mask are applied to layers to uncover regions 

or as contribution to impacts. Shapes have their own layers. At the point when you select a 

drawing tool, you can indicate whether the tool draws a shape or a mask. 

Drawing 

We have already understand what are shapes and how many types  of shapes After Effects 

includes. Now let’s see how to draw shapes     on a composition. Following are the steps to draw 

different types of shapes. 

 

Step 1: 

You can locate different types of shape tools visible on top of the tool bar as shown in figure 6.42. 

 

 

 

 

 

 

 

Step 2: 

Click and hold the rectangle shape to expand the full tray set of shape as shown in the figure. 
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Step 3: 

Drag down to one side to make the shape. The shape appears  in the  composition panel, as shown 

in figure. The following layer has a tag called “SHAPE LAYER 01”is also added to the timeline 

panel as shown below. 

 

 

 

Step 4: 

You can change the color of a shape by modifying its Fill settings in the Tools panel. Clicking on 

to the Fill box opens the Color Picker if the fill is solid, or the Gradient color. You can change 

the outline color and width of a shape by adjusting its outline (stroke) settings in the Tools board. 

To change click on Stroke and menu will pop up, then you can apply changes to the stoke of the 

shape as shown in figure 6.45 (A) and figure 6.45 (B). 

6.15 Custom Shape 

 

 

You can utilize the five tool to make a wide variety of shapes. Nonetheless, the genuine force fit 

as a fiddle layer is that    you can draw any shape. You'll utilize the Pen tool to draw a shape that 

takes after a tick mark. 
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Step 1: 

Draw a shape that matches with a TICK mark, show in figure 6.47 (A). 

At the point when you make the primary vertex After Effects naturally 

adds a shape layer to the Timeline board as shown in Figure 6.47. 

Step 2: 

To draw a tick shape using pen tool, follow these steps: 

Select Pen Tool > Click in the middle of composition > Drag as show in the figure below. 

 

Step 3: 

Repeat this step until you can draw a TICK shape as shown in figure. Apply fill color and stroke 

as shown in above  sections. 
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6.16  Default Properties of Shape Layer 

 

Default properties of shape layer includes, “anchor point, position,  scale, rotation, opacity”. 

To view these properties, follow the steps listed below: Choose Shape Layer > Click Drop Arrow 

on left side of selected shape layer, after that selected shape layer default properties will expand as 

shown in the Figure 6.50. 

6.17 Add New Properties to Shape Layer 

 

 

 

 

 

 

 

 

 

After effects allows us to add properties to shape layers. Which can  give artists more flexibility 

to work and customize their content.  

Step 1: 

Select the shape layer > Tap to expend transform properties. 
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Step 2: 

After clicking on “ZIG-ZAG” property, you will notice a “ZIG-ZAG 1” 

 

 

Edit New Properties Shape Layer 

 

 

 

 

 

 

 

 

 

 

 

 

We have added new property into the shape layer as shown in figure 6.54 above. Adobe After 

Effects allow us to customize new  property “ZIG-ZAG” attributes as well. To customize 

attributes of new property, follow the steps listed below: 
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Click on left side arrow of ZIG-ZAG 1 as shown in Figure 6.4.21 > Drop down menu will pop 

up as shown in Figure > Click any of the attributes to change its values as shown in figure 6.54. 

 

 

You will notice that the “ZIG-ZAG” property is already applied to a TICK  shape layer as shown 

in figure 6.55. 

6.18 Creating Shape Groups 

As we discussed in the sections above, that shapes play an important role in motion graphics. 

Let’s jump further with shapes, and   combine two or more shapes in a single group. Nesting 

multiple shapes in one shape layer helps designer to quickly customize and maintain order of 

multiple layers in large projects. Follow the steps below to create your own shape groups. 

 

 

 

Step 1: 

Select Shape > Draw Shape > New shape layer creates > as  shown in the figure 6.56. 
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Step 2: 

Click on shape layer 01 in timeline panel > Select SHAPE layer 01> Choose new Shape > Draw 

it on Composition You have created  a group having two shapes inside as shown in the figures 

6.57: 

6.19 Masking 

Masks are a fundamental that are included in After Effects that allows you to remove and join 

various components together, form fast and simple advances, and are the premise of enhanced 

visualizations and compositing work moving plan. Masks in After Effects permit you to decide 

the perceivably of explicit pieces of a layer, like provisions that may as of now be recognizable 

on the off chance that you use Photoshop, Illustrator, or other picture altering applications. You 

can hide an item in a photograph or video,  make a pattern, make shapes, or even supplement your 

companions into their number one music recordings. Mask are made by drawing ways on any 

layer with a visual part; that is, anything you can make or bring into After Effects that you can 

really find in a piece. 

6.20 Creating Mask with Pen Tool 
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6.21 Edit Mask 

To draw a mask on a layer. Follow these steps  

Step 1: 

Select your layer > select any shape layer to draw a shaped mask as shown in figure below 

Step 2: 

Select pen tool to and draw shape on composition viewer as shown in figure 6.60 (A) and 6.60 

(B). 

 

Step 3: 

After creating a mask you will notice a property was declared inside shape layer as shown in 

figure (6.61). 

6.22 Feathering the edges of a mask 

Feathering is Adobe After Effects term for "soft edges." Making a  delicate edge around a 

determination is a pleasant way of mixing pictures, feature an article inside a picture, or change 

brutal edges for web illustrations. To apply feather on a masking follow the steps listed below: 
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Step 1: 

Expend the mask attributes by click on the drop-down arrow located on the left side arrow of 

mask as shown in the figure 

 

Step 2: 

In the wake of using the default ascribes of the cover, you will discover different properties of 

the mask. Increment the size of the feather until you have arrived at the ideal worth as shown in 

figure 6.63 (A). After setting up the value to you see on to your composition  feather has been 

applied on your selected mask as shown in figure 6.63 (B). 

6.23 Understand mask interpolation 

Smart Mask interpolation is very useful tool which helps in creating masked shapes tending not 

to animate smoothly. Smart Mask Interpolation creates intermediate keyframes based on the 

settings you choose to create smoother mask shape transformations. By default, smart mask 

interpolation plugin was off. If you need Mask 
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Step 1: 

Click on windows > Find MASK INTERPOLATION > Click on it 

You will find Smart Mask Interpolation panel as shown in figure  

> Click. 

 

Step 2: 

Smart Mask Interpolation panel on right side of composition viewer as shown in Figure  > Click. 

 

 

Step 3: 

Create a KEY FRAME in mask path attributes Figure. 
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Step 4: 

After setting keyframes for 5 sec, select both keyframes as shown in figure : 

 

 

Step 5: 

You can play with different values in mask interpolation, but we are looking only at bending 

resistance and change its value to as desired you want and hit apply button as shown in figure 

6.69: 

 

Step 6: 

After you have applied the changes, you will notice in the timeline two more keyframes were 

added as shown in figure  
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Step 7: 

If you slide the play head to two seconds, you will notice some changes in the mask path in the 

composition viewer. MASK path has been smoothing out, and if you play the animation, you 

will find 

smoothness in animation as shown in figures  

 

6.24 Text animation 

Text plays a vital role in telling a story to the audience. The Type tool            allows you to add text to 

your document. Adobe After Effect provides us more in-depth control over text and the ability to 

customize every bit of a text form (Characters, paths, offsets, lines), and much more. To animate 

text in Adobe After Effects, follow the steps listed below: 

 

Step 1: 

Let’s assume you have already created a composition. Select Text Tool       from the toolbar as shown 

in figure 6.6.01 > Click on any area on com position as shown in figure 6.72 and type any text. 

Key Note: 

IF YOU CLICK ONCE USING THE TEXT TOOL ON COMPOSITION VIEWER AND 

DO NOT INCLUDE ANY TEXT, THE CURSOR WILL 

Step 2: 
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Click on a drop-down indicator to expand the text attributes > Tap on the arrow located on the left 

side of Transform to expand the “transform” attributes of text as shown in figure 6.73. 

 

Step 3: 

Click Position property of text. Set the 1st keyframes at 0 seconds, as    shown in Figure 6.74.  
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Step 4: 

Set last keyframes at 5 seconds. After selecting the 2nd keyframe drag the text from one place to 

another between the composition. You will notice dotted lines from the start point of the text to 

the end-point. It is called setting up a path for a position, as shown in Figure 

 

Step 5: 

You have successfully animated your first animation, as shown in figure 

6.76 below, moving text from top to bottom. 

6.25 Creating Point and Paragraph Text 

Well, you have to create your paragraph text while creating your first text animation, as shown in 

figure 6.76 When you click on composition using the text tool, After Effects by default, makes 

point text  in the Horizontal axis. 

6.27 Paragraph Text: 

After Effects offer the same methods to implement the paragraph Text. To  apply paragraph text, 

select the ROI (Region of Interest) where you want to add text and Select Text tool-type any text 

in the bounding box, e.g. “after effects,” you have created your first paragraph text as shown in 

figure. 
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6.28 Use text animation preset 

Think of the scenario if you want to need a text animation, but 

you do not  want to create it from scratch, you can use 

PRESETS. 

PRESETS are premade created animations to avoid the 

repetitive task. To use text presets, follow the steps listed below: 

Step 1: 

Open “effects and presets” panel as shown in figure 6.79. Your 

effects and preset panel were located on the right side of the 

composition. If You cannot find effects and preset panel, follow 

the steps: 

Click > Windows > Scroll Down > Find Effects and Preset and Click. 

 

 

Step 2: 

After opening Effects and Preset panel, locate TEXT panel by Clicking Drop down arrow of 

“ANIMATION PRESET” > Clicking Drop down the hand of “TEXT” > Choose your desired 
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Preset, we are going to use “CONTRACT - EXPAND,” you can search this in the “EF- FECTS 

AND PRESETS” search bar as shown in figure 6.80. 

 

Step 3: 

Double-click on the preset. You have successfully applied a preset as shown in Figure (6.6.10) 

before and after results > If you want to add your text, you can use that as well.   Figure 6.81 (A) 

shows the default preset text, and Figure 6.81 (B) shows Custom text. 

6.29 Text animation on Path 

In this section, we’ll learn how to animate text on a custom path, e.g., line path, circle path, etc. 

Follow the steps below to animate text on the custom path. 
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Step 1: 

Type custom Text on composition > Select Text layer, create a   mask of any Shape we are using 

pen tool shown in figure 6.82. 

 

 

 

 

 

 

Step 2: 

Click on Dropdown arrow of text layer > Expand Text attribute > Expend path attribute > 

Expend path Drop down menu > Select Mask as shown in Figure . 

After changing the shape path from “none path” to the “mask path” option, your Text is placed 

on your desired way by itself. Adjust the spacing of text as well. After setting all the things, open 

“FIRST MARGIN.” attribute by expending “More” path options found under PATCH options as 

shown in the figure: 

Step 3: 

After locating FIRST MARGIN,> Set its value to (-1110), so it was completely away from the 

composition >Set 1st keyframe at 0 sec and change the FIRST MARGIN value to 0, set 2nd 

keyframe at 2 seconds as shown in the figure 6.84. 

Press the SPACE bar to play the animation, and you will notice text to moving on its path from 

left to right. 
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6.30 Describe Puppet tool 

The Puppet device allows you to add "pins" in the picture, then at that point,  move and twist the 

image depending on where you drive the pins. Each time  you click on the image with the Puppet 

tool, you add a "pin," which goes about as a sort of delicate joint. When working with picture 

resources (particularly vector plans), unpretentious utilization of the Puppet tool in After Effects 

can add life to your movement. You can discover PUPPET PIN TOOL in the device as shown in  

figure (6.7.01). 

6.31 Deform pins 

Where you place the Deform pins will decide how an item continues on the screen, so setting the 

disfigure pins turns into a significant piece of the mani- kin impact, yet additionally turns into a 

technique. Setting the Deform pins is additionally the initial phase in making a making impact. To 

deploy the hooks, follow the steps below: 

Step 1: 

Import an Image to your composition > Select the Puppet Pin Tool as shown in the previous figure 

6.85. 

Step 2: 

Click on the first area in your object that you want to be able to add a moment. As you can see 

in the Figure below, the Puppet Pin is labeled as a yellow circle. Continue the process until the 

last pin as shown in figure 6.86. 
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Step 3: 

Exped Mesh 1 > Tap expend to see the properties as shown in figure 6.87 

 

Step 4: 

 

Tap on the mark to visualize the mesh on composition as shown in figure  6.88. 

 

 

Your composition should look like this, as shown in the figure 6.89 below: 
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6.32 Areas of overlap 

Areas overlap mean two pins intersect each other at the same spot. This is called AREA 

OVERLAP. You can use the PUPPET Overlap tool to overcome this. Simply grab, Puppet 

overlap tool and pin it between two intersections as shown in  
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6.33 tiffing tool 

The Puppet Starch tool gives you pins to figure out what 

portions of the space stay unbending and are not mutilated so 

a lot. You will utilize the Puppet Starch device to characterize 

the regions that you would prefer not to have the measure of 

"movement" as different regions as displayed in figure 6.91. 

.  

6.34 Animate pin positions 

To verify it, select the layer in the Timeline board. Press “U” so you can see all the keyframes. 

Then, change the position of the Deform pins. Make more keyframes to additionally invigorate 

the pins as displayed in figure 6.92. 
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6.35 Record Animation 

Adding keyframes and changing the position property to stimulate the Puppet can be a huge load 

of work. It can moreover be extremely drawn-out. You can use the Puppet Sketch mechanical 

assembly to save. The Puppet Sketch mechanical assembly allows you to drag the articles into 

position. Postponed results record the development as you pull pins. Use the Puppet Sketch 

mechanical assembly by picking Puppet in the Timeline load up, then picking a pin in the 

position board as displayed. 

 

6.36 Comprehend Time Remapping 

Motion Sketch 

Motion Sketch is an element in Adobe After Effects that allows you to record keyframes to develop 

any layer with your mouse continuously. This is the reason it is called 'Movement Sketch': you are 
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in a real sense outlining the movement of an article in your scene. 

Step 1 

To see the Motion Sketch panel, go to the main menu and select View > Motion Sketch as shown 

in figure 6.94 (A) and 

Figure 6.95: Composition 

Step 2 

Draw a shape in composition > Decide the path > Click on the Shape layer > Then Click on the 

Start capture in motion sketch as shown in figure 6.95. 

Figure 6.96:  Composition 

Step 3 

Click Start > Draw Path. It will create several keyframes on the position attribute of shape. If you 

play the video, it flows the same path you draw as shown in figure 6.95 
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The Smoother 

 

 

Figure 6.96: Before using Smoother  Figure 6.97 : After using Smoother  

Smoother is a handy tool. It is used to smooth out curves. For instance, with a created path with 

motion sketch as shown in Figure 6.08.01, you will notice it is not smooth. So here comes smoother. 

Simply select the path > open smoother from > window > smoother > Increase the tolerance level. 

Higher tolerance is smoother but less detailed. Lower tolerance is more precise but less smooth. 

And you are done as shown in the Figure 6.96. 

  

The Wiggler 

As the name shows, it is used to wiggle any shape and text. To view Wiggler > Windows > Wiggler 

as shown in figure  
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Use of Wiggler 

Create a shape in composition > Set 2 keyframes on position attributes as we did in the above 

sections > Select two keyframes > Adjust wiggler setting > Play the animation as shown in the 

figure 6.99. 

Auto orient 

In some cases, we need to shape to auto orient its position along the path to look more realistic. 

After Effects provides a feature called Auto Orient. If you toggle it on a layer, the layer will allow 

auto orient itself. Following are the steps to apply auto orient on a layer. 

 

 

 

 

 

 

 

 

 

Step 1 

Select the layer > Create a path using pen tool > Copy mask path > select layer again > press P to 

bring up position attribute > and paste the copies of mask path as shown in the Figure 6.100. 
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Step 2 

Select the layer > Go to Layer > Transform > Select Auto orient > Done as shown in Figure 6.101 

 

Splitting a layer 

The splitting layer is used for any reason, and it is very 

handy. One reason I find myself coming back to time and time again is when working with freeze 

frames. I want to make a freeze frame but not for the rest of the layer. So I split the clip, moved 

for- ward a frame, and split the clip again. Let's take a look at these steps to understand how to split 

a layer. 
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Step 1 

Splitting a layer in After Effects means that you take the selected layer and break it into two layers 

where the Current Time Indicator is. Nothing else is affected. Keyframes don’t move. The layer’s  

start and endpoints don’t move. It is just karate chopped at the Current Time Indicator into two 

layers, as shown in Figure 6.102 

 

Step 2 

After selecting splitting time > click edit > split layer. 

Make sure to select the layer while doing this process, as shown in Figure 6.103. 

 
After splitting, your layers look somewhat like this, as shown in the Figure 6.104 

 

Adjustment layers 

When you apply an impact to a layer, the effect applies just to that layer and not to another layer. 

Be that as it may, a product can exist autonomously on the off chance that you make a change layer 

for it.  Any impacts applied to a change layer influence all layers underneath it in the layer stacking 

request. A change layer at the lower part of the layer stacking request has no noticeable outcome. 
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Step 1 

Choose Layer > New > Adjustment Layer as shown in figure 

6.105 (A). You will notice an “Adjustment Layer 1” in the composition as shown in figure 6.105(B). 

6.37 Import Video Clips 

It is easy to import video clips in Adobe After Effects. Following are the steps to import video 

clips in after effects. 

Step 1 

Launch After Effects, Go to files > Import > Files as shown in Figure 6.106 
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Step 2 

A dialog box will appear > Locate the File > Click Import > as shown in Figure 6.107. 

Step 3 

You have successfully imported a file as shown in Figure 6.108 

6.38 Import still and sequence of stills 

It is the same process as you would import a video file. For import ing a sequence of stills, select 

multiple images at once, as shown in Figure 6.109 
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You have successfully imported an image as shown in  Figure 6.110. 

 

6.39 Import multilayered Illustrator Files 

Adobe gives us a great ecosystem of different work and sync together very well. So we can use 

illustrator file in After Effect directly without converting or doing any other additional conversion, 

follow the steps to import AI files in Adobe After  Effects. 

 

Step 1 

Create a separate layer of each object illustrator, this step is very helpful import layers as they set 

up in illustrator as shown in figure 6.111. 

Step 2 

Import AI file by press CTRL + I > Select Import COMPOSITION > Click Ok as shown in figure 

6.112 
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After importing, your project will look something like this, as shown in Figure 6.113. 

 

6.40 Import multilayered Photoshop File 

In order to give a unique and professional look, designers 

always add some fine details to their project and content. These 

final details can come through altering their work down to a fine 

cut, blending the sound, and surprisingly fostering the opening 

titles or illustrations for the substance. 

Adobe Photoshop allows us to develop these graphics and titles 

in the adobe ecosystem and import them directly after effect. 

Follow the steps below to import a multilayered Photoshop file 

in Adobe After Effects Adobe After Effects. 
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Step 1 

Open Photoshop >Create New Project as shown in figure 6.114: 

 

Step 2: 

Set the properties of the project in Adobe Photoshop shown in figure 6.115: 

Step 3 

Create your required graphics or text as shown in figure  6.116. 
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Step 4 

Finally, save the graphics you have created in Photoshop in PSD  file format as shown in figure 

6.117. 
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Step 5 

After saving graphics of adobe photoshop, now import  that file in Adobe After Effects: Click on 

File Button > Select  Import Button > Select file as shown in figure 6.118. 

Step 6 

Import layer in Adobe After Effects as “Composition Retain layer size” > Click Ok button. As 

shown in figure 6.119. 

 

 

Step 7 

You will notice a new composition with the tag “FILE-NAME” is created in the Project panel. 

Double click on this composition  as shown in figure 6.120. 
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Step 8 

After opening this “Filename” composition, After Effects  will arrange all of the layers in the same 

order as in photoshop, as can be seen in figure  

6.41 Key Frame Types 

Delayed consequences insertion is how the product computes the qualities between two focuses. 

This means that if you animate a component utilizing keyframes After Effects, figure out the move 

ment of that component between the keyframes you set. 

 

 

Spatial 

Postponed results inclusion is the way the item registers the char acteristics between two core 

interests. This implies that if you breathe life into a part using keyframes After Effects sorts out the 

development of that part between the keyframes you set. 

Temporal 

Utilizing the worth diagram in the Graph Editor, you can make exact acclimations to the fleeting 

property keyframes you’ve made for your movement. The worth chart shows x qualities as red, y esteems 

as green, and z esteems in 3D only as blue. 

Continuous Bezier interpolation 

Like Auto Bezier interjection, Continuous Bezier addition makes a smooth pace of progress 

through a keyframe. In any case, you set the places of Continuous Bezier course handles 

physically. 

Suppose you apply Continuous Bezier introduction to all keyframes of a property after Effects 

changes the qualities at each keyframe to make smooth advances. Eventual outcomes keep up with 

these smooth changes as you move a Continuous Bezier key- frame on either the movement way 

or the worth diagram. 

6.42 Bezier 

Bezier interjection gives the most exact control since you physically change the state of the worth 

chart or movement way portions on one or the other side of the keyframe. 
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In contrast to Auto Bezier or Continuous Bezier, the two-course handles on a Bezier keyframe 

work freely in both the worth chart and movement way. If you apply Bezier addition to all 

keyframes of a layer property After Effects make a smooth change between keyframes. The 

underlying situation of the bearing handles is determined utilizing a similar technique used in Auto 

Bezier introduction. Eventual outcomes  keep up with existing course handle positions as you 

change a Bezier keyframe esteem. 

In contrast to other interjection techniques, Bezier's addition allows you to make any blend of 

bends and straight lines along the movement way. Since the two Bezier course handles work freely, 

a bending movement way can out of nowhere transform into a sharp corner at a Bezier keyframe. 

Bezier's spatial introduction is great for drawing a movement way that follows a complicated 

shape, for example, a guide course or the diagram of a logo. Existing course handle positions 

endure as you move a movement way keyframe. The transient introduction applied at each 

keyframe  

In contrast to other interjection techniques, Bezier's addition allows you to make any blend of 

bends and straight lines along the movement way. 

Since the two Bezier course handles work freely, a bending movement way can out of nowhere 

transform into a sharp corner at a Bezier keyframe. Bezier spatial introduction is great for drawing 

a movement way that follows a 

complicated shape, for example, a guide course or the diagram of  a logo. 

Existing course handle positions endure as you move a movement way keyframe. The transient 

introduction applied at each keyframe controls the speed of movement along the way. 

6.43 Auto Bezier 

Auto Bezier's addition makes a smooth pace of progress through a keyframe. You might utilize 

Auto Bezier spatial introduction to  make the way of a vehicle turning on a bending street. As you 

change an Auto Bezier keyframe esteem, the places of Auto Bezier heading handles change 

consequently to keep smooth progress between keyframes. The programmed changes change the 

state of the worth chart or movement way sections on one or the other side of the keyframe. 
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On the off chance that the past and next keyframes likewise utilize     Auto Bezier introduction, the 

state of the portions on the most distant side of the history or next keyframes additionally changes. 

On  the off chance that you change an Auto Bezier bearing handle physically, you convert it to a 

Continuous Bezier keyframe. 

Roving Keyframe 

Roving keyframes retain their values, but their position in time is adjusted automatically so that 

the property's speed becomes consistent, and the property's speed graph flattens out, as shown in 

Figure  6.121 

6.44 Template Creation 

If you have express render settings, for the most part, used when exchanging  After Effects video, 

this trick may save you a lot of time. Maybe then retrying each renders physically, you can save 

and proposition Render Templates in After Effects without a very remarkable stretch. This is 

staggering if you work in a gathering environment or fundamentally need to save some time. 

 

Step 1: 

Select Composition > Edit >Templates >Render Settings as shown in  figure 6.122. 
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Step 2: 

Adjust the settings according to your requirements and tap “Ok,” and name your template as 

shown in Figure 6.123. 

 

6.45 Export using render queue 

 

Step 1: 

Select your composition > Add to Render queue as shown in figure  6.124. 
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Select your composition in adobe render queue as shown in figure  

 

 

 

 

 

Step 2: 

Click on >Render Button. Later, the rendering process starts as shown in figure  

Step 3: 

A blue color progress bar starts filling out. In the rendering panel, you can see rendering status, 

remaining time, and elapsed time, As shown in figure 

Step 4: 

After completion of the rendering process, you can hear a beep sound. And the rendering status 

has changed to “done,” as shown in figure  
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6.46 Export using Adobe Media Encoder 

Select the composition > Add to media Encoder > Set up media encoder and click PLAY button 

as shown in Figure 
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Activities 

1. Install Adobe After effect in your system 

2. Create your first project in Adobe After Effects 

3. Create a project by using attributes of motion graphics 

4. Create animation project using different shape tool 

5. Use a mask tool on an image. 

6. Create Apply text animation on student’s name. 

7. Apply puppet tool on different characters and record an animation. 

8. Apply Different effects to videos. 

9. Create animation video composition using layer. 

10. Render movies with Adobe Media Encoder. 

Key Points 

1. Animation is a methodology by using with figures are manipulated to  seem as moving 

sequence. 

2. Compositing is the method or technique of mixing visual components from  different sources into 

one unite image. 

3. Visual effects are the method by that imaging is formed or manipulated outside the context of a 

live-action shot in film-making and video  production. 

4. Audio is defined as sound, mainly when recorded, transmitted, or re- produced.  

5. Video is defined as the recording, reproducing, or broadcasting of  moving visual images. 

6. Resolution is quantity of pixels on screen. 

7. Pixel aspect ratio is connection between the width and height of pixel. 

8. Area of overlap means two pins intersect each other at the same spot. 

9. Motion sketch is an element that allows you to record keyframes. 

10. Slicing one layer into two pieces is called splitting of layer. 
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Notes for Teacher 

1. Explain purpose of after effects to students 

2. Help students to install the software 

3. Explain source material used in after effects 

4. Explain what is motion graphics with examples. 

5. Explain default properties of shape layer. 

6. Help students to set up their first after effects project. 

7. Help student to add a composition and arrange multiple layers. 

8. Help student to add different shape layer properties and edit them. 

9. Explain usage and purpose of masking in after effects. 

10. Explain different properties to render an after effects composition. 
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EXERCISE 

 

Select the Most appropriate option 

1. Adobe After Effects is used for _______________________ 

a) Animation   b) 3D Modeling   c) Compositing   D) A & C 

2. After effect save its file in the form of ______________ 

a) JPEG   B) BITMAP    C) AEP    D) PSD 

3) What is the name of color model Adobe After Effects Supports? 

a) BGR   b) RGB     C) HSV   D) CMYK 

4) Number of pixels on a screen is called _____________ 

a) Frames  b) Resolution    C) pixel ratio  d) None of these 

5) How many shapes tools after effects provides ______ 

a) 1   b)10     c)5    d) None of these 

6) Puppet tool allows you to add _______________in a picture 

a) Mask   b) Pins     c) light  d) None of these 

7) Motion sketch is an elect that allows you to record  

a) Video   B) Keyframes    c) animation   d) None of these 

8) Software used to render Adobe after effect compositions is called 

_____________________ 

a) Quick-Time  b) Adobe Media encoder  c) VLC   d) None of these 

9) ______   keyframe retain their values, but their position in time is adjusted au 

tomaticly is called? 

Easy-Ease  B) Ease-In    C) Roving Keyframe   d) Ease-out 

10) Animation or any digital footage that produce illusion of 

rotation, positioning is called ___________? 

a) Designing  B) Animation    c) Motion Graphics   d) post-production 
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Give Short answer to the following question 

 

1.Define animation in After Effects 

2.Define Composition in After Effects 

3.Define Still images in after effects 

4.What is .AET file extension used for? 

5.Name any three attributes of motion graphics 

6.Define resolution 

7.Define Pixel aspect ratio 

8.List default properties of shape layer 

9.List any two usages of masking in after effects 

10. Define point and paragraph text 

 

Answer the following questions in detail 

1.Explain purpose and usage of Adobe After Effects 

2.Explain different source materials used in Adobe After Effects 

3.Explain the following terms? 

• Alpha Channels 

• Frame Rates 

• RGB color model 

4.Explain shape in after effects? Also elaborate shape tools in the software. 

5.Explain default properties of shape layer. 
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Chapter 7 

ADOBE AFTER EFFECTS (ADVANCED) 
  

In this Section, students will be able to: 

 understand 3d concepts 

 elaborate the difference between 2d 

and 3d 

 know the role of cameras, lights, and 

points of interest 

 know the effect of repositioning the 

layers 

 rotate a 3d object  

 learn about axis modes 

 3d layer interactions, render order, 

and collapsed transformations 

 work with shadows, null object, text 

in 3d,  

 use vanishing point vpe and add 

dimension to stills 

 view, build, and render 3d scenes / 

text using cinema 4d (cine ware)  

 use particles for compound objects 

 

 apply paint effects (stroke, scribble, 

write-on, paint) 

 adjust color balance 

 replace the background 

 understand tracking and stabilizing 

 track motion 

 know about expressions 

 knowledge of using expressions to 

animate shapes 

 adjust the expression direction, 

parameters, rate of change and loops 

 explore new expressions 

 understand function of keying 

 change the background and adjust 

foreground object 

 render and export the project.  
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7. AAE Advance Level 

7.1 Understanding 3d Concept 
In the field of media production, Adobe After-Effects plays a vital part. It is used to create 2D, 

3D animation, scenes, effects, composition and helps in post-production work. After-Effects 

support multiple software to use their assets, including Adobe creative cloud software 

(Photoshop, Illustrator) and 3D software Cinema-4D. This way, you can maintain your workflow 

without hustling from one software to another. Let’s deep dive to understand the 2D and 3D 

concepts offered by After-Effects. 

7.2 Difference Between 2d and 3d 

2D in After-Effects 

2D shapes can be defined as level plane figures with just two dimensions (length and width). 2D 

shapes can be measured by the two dimensions, width, and height, as shown in Figure 7.1. 

Figure 7.1:2D Shapes 

3D in After-Effects 

A three-dimensional shape is defined as an object or shape with three measurements (length, 

width, and height). Three-dimensional shapes have depth and three attributes: faces, edges, and 

vertices, which can create a 3D shape, as shown in Figure 7.2. 

 

Figure 7.2 : 3D Shapes 
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7.3 Role Of Camera, Light, And Point of Interest 

Role Of Camera: 

You may have known about 2D and 3D, but there is another term called "2.5D". It's a visual idea 

and the core for all the work in After-Effects. At its center, 2.5D is moving 2D items in 3D 

space, somewhat like paper Mario. Cameras allow 

Figure 7.3: 2.D Scene 

Role of Lighting: 

3D lighting has a significant part of each 3D project. A blend of light sources to create a unique 

piece of setting, scene, or address regular properties like time, climate, as shown in Figure 7.4. 

Figure 7.4: Lighting Effect 
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Role Of point of Interest In 3d: 

The point of interest in 3D scenes allows users to focus on a subject while telling a 

story. It is essential to focus on the topic to connect with the scene. Point of interest uses the 

same principle in 3D to set the camera on a specific region. 

7.4 Repositioning The Layers 

After-Effects work on the stack system principle to arrange and manage layers. The logic behind 

this principle is “A layer on top of the stack has first priority and the layer below has second 

priority. First layer on stake is visible on the composition preview window.” 

To see the positioning effect, create two different shapes. Apply different colors and see the 

impact of repositioning after changing the position of layer one. As you can see clearly, the 

Top RED colored layer is on top of the Green colored layer, as shown in Figure 7.5. 

 

Figure 7.5: Positioning layers 

Figure 7.6: Rotate 3D object 

 

Red Shape 

stack on Top 

Red Shape stack on 

Bottom 
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1 Click 

Here 3 Click Here 

Steps 

Draw a shape on composition. Go to the layer on the timeline and convert the layer into 3D, 

as shown in Figure 7.6. 

Select the axis to change the direction of the layer as shown in Figure 7.6. 

7.5 Rotate a 3d Object 

Using Adobe After Effects, you can easily rote 3 d objects to watch their width, length and depth 

properties. 

 

7.6 Axis Modes in After Effects 

When you create a 3D layer, the actual layer stays the same. Yet, it takes different properties: 

Position, Anchor Point, Scale, Orientation, Rotation, and material options propert ies .  

Material  options properties determine how the layer  associates with light and 

shadows. 3D layers communicate with shadows, lights, and cameras, as shown in Figure 

7.7. 

 

2D Layer      Figure 7.7: Axis Mode    3DLayer 

After converting the shape layer into 3D, you can see the axis by following the steps: 

Click left drop-down arrow of layer > Expend Transform Property, as shown in Figure 7.8 

 

 

 

 

 

 

Figure 7.8: Axis Mode 
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7.7 3d Layer Interactions 

Transforming 3D Layer 

By expending the transform property, you can change the direction, position, and depth of the 3D 

Layer, as shown in Figure 7.8. 

Rendering Order of 3D Layer 

After-Effects continue rendering from the source file to the film. It is the order in which 

After-Effects process your source file to get rendered in composition preview or your 

exported file. 

Shape Layer Render Order 

1. Groups. 

2. Inside a group: Paths. 

3. Inside a group: Paint. 

4. Inside a group: Transform 

properties. 

5. Transform properties of the 

Layer. 

6. Effects. 

7. Track Matte. 

8. Blending Mode. 

9. Styles. 

10. Preserve Transparency. 

Composition Render order 

1. Background color. 

2. Pre-composition. 

3. Other Layers. 

4. Lights. 

5. Cameras. 

6. Motion Blur. 

7. Audio. 
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7.8 Working with Null Object, Text In 3d 

Null Object 

A “Null object” is an invisible layer with each property of a regular layer, so it is a parent 

to any layer in the composition. You use the same orders to  adjust settings for a null 

object for a solid layer. A null object is visible in the composition and Layer panels 

and shows up in the composition panel as a rectangular layout with layer handles.  

To add a null object, follow the steps below: Right-click on timeline > Click New > Null Object 

as shown in Figure 7.9 

Figure 7.9: Creating Null Object 

 

                     Figure 7.10: Null Object                     Null Object 

Creating Text In 3d 

Select the Text tool and type the text in composition. 

1st Click 

2nd 
Click 
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Convert text layer to 3D layer > Create a camera object > Right click on timeline > Click Camera. 

After Creating the Camera > Select Camera Moving tool, and take a look at your typed TEXT IN 

3D as shown in Figure 7.11 

 

Figure 7.11: Creating Null Object 

3D space in After-Effects allows us to add 3D touch within the software. Instead of learning a 

whole new 3D software to perform a simple task. 

7.9 Apply Particles: 

The "CC Particle System" is the most fundamental particle framework in  

After-Effects. If you are practicing with particle frameworks, the main drawback is that it is a 2D 

effect, meaning you are limited to the X and Y-axis. 

Particle structures allow us to simulate physics-based consequences and phenomena using 

groups, smaller objects, or sprites, which make up a larger complete photo. Let's take an 

observation of the particle structures in After-Effects. 

Let's practice creating a primary graphic using Particle World. For context, we're going to make 

a backdrop for an imaginary video star message. Following are the steps to use "CC PARTICLE 

WORLD" in Adobe After-Effects: 
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Figure 7.12: Choosing CC Particle Work Effect 

Figure 7.13: Exploding CC Particle 

 

STEP 1: 

Create a new composition > Go to Effects and presets panel > Search CC PARTICLE 

WORLD > Select CC PARTICLE WORLD, as shown in Figure 7.12. 

 

STEP 2: 

 By default, you will see a basic particle effect appear in your composition. ,as shown in Figure 

7.13. 
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Figure 7.14: Setting CC Particle Properties 

STEP 3: 

Change the settings of “CC PARTICLE WORLD” to achieve the required effect, as shown in 

Figure  

Figure 7.15: Choosing CC Particle Work Effect 
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STEP 4: 

Apply to set the desired setting for the effect. The preview composition will look somewhat like 

as shown in Figure 7.16. 

Figure 7.16: Selecting CC Particle World Texture Layer 

STEP 5: 

Change the texture of “CC PARTICLE WORLD” by clicking> Particles on timeline > Select 

Texture > Select your Stars layer, as shown in Figure 7.16. 

Figure 7.17: Final Preview 

STEP 6: 

Adjust the “CC PARTICLE WORLD” texture as per your requirement > Add some text in your 

final composition as shown in Figure 7.17. 
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7.10 Paint Effect 

The Brush tool allows you to paint on any layer, similar to an actual paintbrush. You have 

various settings to browse, which can assist you with tweaking different properties of the brush 

as per your requirements. To use a brush tool in your composition, follow the steps listed below. 

 

STEP 1: 

First, change your workspace to “paint,” which allows you to navigate brush tools and their 

properties efficiently. Click on the two arrows on the top left side in the toolbar > A drop-down 

menu will open up > Select Paint workspace. You will notice, your previous workspace panel 

replaced with the panels related with paint and brush tool, as shown in Figure 7.18. 

Figure 7.18: Workspace 
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Figure 7.19 (A): Paint Workspace 1 

 

STEP 2: 

Previous work panels change to paint and brushes panels, as shown in Figure 7.19 (A) and 

(B): 

 

Figure 7.20: Composition and Layer panel 

 

 

STEP 3: 

Select a layer on which you want to apply the “paint effect.” Double click on the composition 

window to open the layer window. Through which you apply the “pain effect,” as shown in 

Figure 7.20. 
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Figure 7.21 (A): Brush To 

 

 

                                                               Figure 7.21 (B):Pain & Brushes Workspace 

STEP 4: 

Choose the brush > Change the properties of brush from “Brushes Panel.” Choose your colors as 

per your requirement > Apply paint on your layer window, as shown in Figure 7.21 (A) and 

(B). 

                                   Figure 7.22: Composition and layer pane 

STEP 5 

After applying “paint-effect” on your layer window, your final composition look like this, as 

shown in Figure 7.22. 
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Write On Effect 

The "Write-on" effect allows us to draw on a layer like other brushes, but the difference is that this 

effect creates a new key-frame when the user creates a recent stroke. Follow the steps to create 

your first effect using this technique. 

STEP 1: 

Create a new composition > Import image/footage if necessary > Change your workspace to 

“paint,” as shown in Figure 7.23 (A) and (B). 

                   

Figure 7.24: Paint Panel 

 

Figure 7.23(A): Paint Panel 1 

Figure 7.23 (B): Brushes Panel 1 
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STEP 2: 

Select the brush tool > Change the paint duration settings to “write-on,” shown in Figure 7.24. 

Figure 7.25: Composition and Layer Panel 

 

STEP 3: 

Double click on the composition to open the layer panel on the right side of the composition 

to draw on, as shown in Figure 7.25. 

 

 
              Figure 7.26 (A): Paint Panels                                         Figure 7.26(B): Paint Panel 
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STEP 4: 

Configure your brush from the “Brushes panel” and choose your desired color form paint 

panel to meet the requirement, as shown in Figure 7.26 (A) and (B). 

Figure 7.27: Composition / Layer Preview 

STEP 5: 

Place your play-head on zero seconds. Draw a text with a brush tool on layer widows. 

While completing your first stroke, you will notice that it will disappear because the 

after-effect creates a new brush with every new stroke and places key-frames on the 

stroke's starting and ending point, as shown in Figure 7.27. 

 

Figure 7.28: Composition / Layer Preview 

 

STEP 6: 

After finishing, bring back your play-head on 0 seconds, and press space-bar to start previewing 

the final results, as shown in Figure 7.28. 
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Scribble Effect 

After-effects is already packed with significant effects, which helps us create brilliant 

animation and add life to our videos. This section will learn what the “scribble effect” is? 

and how to use this in text. Follow the steps listed below to add “scribble-effect” to your 

reader. 

Figure 7.29: Composition Preview 

STEP 1: 

Create a new composition > Select text tool to add some text in your composition, as shown in 

Figure 7.29. 

 

Figure 7.30 : Converting Text Layer 
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STEP 2: 

Convert your text layer into mask > By right-clicking on to the text layer > Click on Create 

button > Select create a mask from text, as shown in Figure 7.30. 

Figure 7.31 (A): Composition Preview Figure    7.31 (B): Timeline Preview  

 

                                     

   

STEP 3: 

After creating a mask from text, a new layer was created with each letter having its own separate 

mask, as shown in Figure 7.31 (A) and 7.31(B). 

Figure 7.32: Effect Panels 

 

 

STEP 4: Go to “Effects and Presets” panel and type “scribble” in the search bar, in Figure 7.32. 
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Figure 7.33 : Control and Effects Panel 

 

STEP 5: 

The effect values were set to default, as can be seen, is Figure 7.33. 

 

Figure 7.34 (A): Control and Effects Panel  
Figure 7.34 (B): Control and Effects Panel

       

 

STEP 6: 

Change scribble mode to All mask > Set composition mode to Revel-Original. These steps allow 

us to see the effect on the text, as shown in Figure 7.34 (A) and (B). 
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Figure 7.35 : Composition Preview 

After implementing the required setting, your final composition looks like this. Press the space 

bar to see the animation, as shown in Figure 7.35. 

 

Stroke 

This effect allows us to animate various stroke properties of a 

layer. There are a lot of ways to animate stroke. Following are 

the steps to animate the stroke of a layer. 

        Figure 7.36 (A) : Layer Preview            Figure 7.36 (B) : Composition Preview 

STEP 1: 

Draw a shape on your composition > Set fill to none > Set stroke width according to your 

requirement. A shape layer was created in the timeline, as shown in Figure 7.36 (A) and (B). 

Figure 7.37: Timeline Preview 
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STEP 2: 

Expend the properties of shape by clicking on the arrow located on the left side of the 

composition name > Expend content property > Click on the ‘Add’ property 

button located on the left front side of the content property > Add “TRIM PATH.” 

property, as shown in Figure 7.37. 

Figure 7.38: Timeline Preview 

 

 

STEP 3: 

A new “Trim Path” was created. Set your play-head on zero seconds, add END attributes 

key-frame with  0%  value  >  Move  play-head  at  two  seconds,  and set END attribute value to 

100%, as shown in Figure 7.38. 

                                      

Figure 7.40: Composition Panel 
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STEP 4: 

After applying all necessary settings, you have an animated stroke of a shape layer, as shown in 

Figure 7.40. 

7.11 Color Balancing 

Instead of changing the color of each element in a composition individually, you can use the Tint 

effect to achieve the result. Select the layer > Go to the color correction sub-menu in the effects 

menu and select the Tint Effect. Utilize the Map Black, and Map White settings open from the 

effect controls panel to calibrate the tones in the chosen layer. Changing the map black to choose 

will supplant the dark pieces of the layer with the color you chose, while Map White To feature 

enables you to return the white areas of a layer with a new color. 

The Tint effect is beneficial if you need to change the color of black or white layers, but you can 

also desaturate a layer. Just apply the effect to a color video you would like to turn black and 

white, and then you can accentuate a particular color by picking a new shade under the Map Black 

to and Map White settings. Follow the steps listed below to apply the tint effect. 

Figure 7.41 : Composition showing color balancing 

STEP 1: 

Create a composition > Add image/video on which you want to apply effect, as shown in Figure 

7.41. 

Figure 7.42: Composition with color balancing 
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STEP 2: 

Open Effect and Preset panel > Search Tint Effect > Drag and Drop the effect on the layer as 

shown in Figure 7.42. 

Figure 7.43: Color Picker 

STEP 3: 

Select the “MAP BLACK TO” and “MAP WHITE TO” to set the colors > Color 

pick-up box will open, as shown in Figure 7.43. 

Figure 7.44: Effect Settings 
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STEP 4: 

Choose the colors> Adjust the effect values as your desire, as shown in Figure 7.44. 

Figure 7.45 : Color Balancing Preview 

 

STEP 5: 

You can see the changes in the composition window, as shown in Figure 7.45. 

Figure 7.46 (A): Before Color Balance                  Figure 7.46 (B)After Color Balance 

 

STEP 6: 

Here you can see the clear difference of before and after applying the tint effect as shown in 

Figure 7.46 (A) and (B). 

7.17 Idea of  Keying 

Keying is defining transparency by a particular color value (with a color key or chroma key) or 

brightness value (with a luminance key) in an image. When you key out a value, all pixels that 

have similar colors or luminance values become transparent. Keying makes it easy to replace a 

background of a consistent color or brightness with another image, which is especially useful when 

working with objects that are too complex to mask easily. The technique of keying out a 

background of a consistent color is often called blue screening or greens screening, although 

you don't have to use blue or green; you can use any solid color for a background 
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7.12 Tracking and Stabilization 

With motion tracking, you can follow the moment of an object and afterwards apply that to another 

layer. You set up, start, and apply motion tracking through the Tracker panel. Likewise, you can 

change, edit all properties of the tracker. You can set regions to follow by setting track focuses in 

the Layer panel. Each track point contains a component area and an append point. 

7.13 Motion Tracking User Interface 

You set up, start, and apply movement following the Tracker panel. Similarly, you can change, 

animate, manage, and interface the following properties in the Timeline pane with all properties. 

Set the regions to follow by setting track focuses in the Layer panel. Each track point contains a 

component area and an append point. 

A. Search region B. Feature region C. Attach point 

Feature Region 

The feature region defines as the component in the layer to follow. The feature region should 

include a particular visual element, ideally one object. You can select different feature regions. 

Search region 

The search region defined as the region that After Effects will look to find the followed object. 

The tracked object should be particular just inside the area, not inside the whole casing. 

Attach point 

The attach-point assigns the spot of connection for the objective. The layer or impact control 

highlight synchronized with the moving component in the followed layer, as shown in Figure 7.47.  

Figure 7.47: Tracking 
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Motion tracking workflows 

There are several ways you can do motion tracking in After Effects, It depends on your workflow 

and idea, what kind of tracker do you need. 

Mask tracker 

Utilize the mask tracker to draw mask around your object to follow just specific bit in your scene. 

Face tracker 

The face tracking allows you rapidly apply effect just to a face, like a particular shading correction 

or hide an individual's face. 

However, with Face Tracking, you can track specific parts of the face such as pupils, mouth, and 

nose, allowing you to isolate and work on these facial features with greater detail. For example, 

change the colors of the eyes or exaggerate mouth movements without frame-by-frame 

adjustments 

3D Camera tracker 

Using the 3D camera tracker effects to remove camera movement and 3D scene. You can then 

effectively composite 3D layer over your 2D film. 

Point tracker 

Motion tracking and balancing out motion are similar cycles, just with an alternate 

objective and result. Use Track Motion to follow the movement and apply the 

outcomes to an alternate layer or impact control points. Use Stabilize Motion to follow 

directions and apply the results to the tracked layer to make up for that  movement (for 

instance, to eliminate camera shake). 

To balance out a layer, After Effects tracks the movement of an element in the layer that is 

used to be fix the edge and afterwards utilizes the following information to set keyframes 

to play out the composition. You can settle to eliminate any mix of changes in position, 

resolution, and scale while leaving required movement un-affected. For instance, if 

the camera is panning, deselect position, however, select Scale and Rotation as the 

properties to balance out. When choosing Rotation or Scale in the Tracker board, you 

set two track focuses in the Layer board. A line interfaces the connect focuses; a bolt 

focuses from the first append point to the second. If conceivable, place the component locales on 

inverse sides of a similar article, or if nothing else, on objects that are a similar separation from 

the camera. 
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The farther separated the districts, the more precise the computations and the better the 

outcome. Eventual outcomes work out pivot by estimating the difference in point of the 

line between the connected focuses; applying the following information to the objective 

After Effects makes keyframes for the Rotation property.Eventual outcomes work out 

Scale by looking at the distance between connect focuses on each edge. The distance 

between the append focuses on the beginning casing applying the following information to 

the objective After Effects makes keyframes for the Scale property. 

When you track motion using either equal or viewpoint corner sticking After Effects apply 

keyframes for the Corner Pin impact to scale and slant the objective layer as essential to fit 

the four-sided region characterized by the component locales. In reality, the component 

districts should lie in a solitary plane, such as on transport, on a similar divider, or the floor. 

The connected focuses should all lie in alone aircraft but not identical to the element 

districts. 

Motion tracking options 

Track Name 

You can likewise rename a tracker by choosing it in the Timeline panel and squeezing Enter on the 

primary console. 

Tracker Plug-in 

The tracker plug-in was utilized to perform motion tracking. This is built-in tracking plug-in 

included with-in After Effects. 

Channel 

The parts of the picture information are used for examination while looking for a counterpart for 

the element. Select RGB if the followed highlight is unmistakable coloring. 

Process Before Match 

Temporarily blur or sharpen an image to improve tracking. Blur reduces noise in the footage. 

Enhance colors or refine the edges of an image and makes them easier to track. You can use this 

feature in your various projects, including tracking some birds 

7.14 Expressions to animate shapes 

Expressions are pieces of code written in the JavaScript language for adjusting the After-Effects 

layer properties. When you compose an expression on a property, you can begin making 

connections between that property and different layers. Expression’s controllers found in the 

Effects and Presets window can help you with bettering control of the expression. 
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7.15 Adding Expression in After Effects 

You can add expressions to any layer and any layer property inside After-Effect. Some expressions 

are short and easy to use and understand, while other expressions are lengthy and complicated. 

Even if they seem complex, pasting them inside their dedicated space should do the trick, as 

shown in Figure 7.48. 

 

Figure 7.48: Expressions 

 

7.16 Animate shape using Expression 

 

 

 

 

 

 

 

 

 

                                   Figure 7.49 : Expression in position propertyk 
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Step 1 

Draw a shape on composition, and Hit P to bring position property of shape as shown in Figure 

7.49. 

Step 2 

In the property section click + alt button on a stop watch of position property > Then past your 

expression. 

7.17 Adjust the expression direction, parameters, loops 

To change the expression attribute, you have to understand how the expression works. For example, 

in previous example, we used a Wiggle phrase, the syntax of expression is as follow: 

org=value; temp=wiggle (3,25); [temp [0], org [1]]; 

If you look at the expression, it has three sections. The first ORG= Value defines the original shape 

or layer where the following expression is applied. 

TEMP = Wiggle (3, 25), which defines the wiggle axis of the moment. 3 is the x-axis, and 25 is the 

y-axis, so if you want to reverse the direction, add - to revert the action. The same goes for every 

attribute to change it. 

To add a loop in an expression, we can set the number of rotations of the expression, so in the 

following example, org [1] is defined to get the expression in loop so, here we can type 0 or 1 to 

add loop effect in an expression. 

KEY NOTE: 

Every expression has different sort of approach, so it is recommended to read the notes of an 

expression which is being used in any project. 

7.18 Explore New Expressions: 

Understanding how after effect can take expression is pretty tricky because creating a new 

expression would take along. So to fix this, you can use a free expression offered by multiple 

websites online. Here is some cool expression to practice. time – returns a composition’s current 

time in seconds. time.to Fixed (2) – limits how many numbers are allowed after the decimal. 

time*n – just like time, but it multiplies the value it provides, “n” can be any number you want. 

Expression are really powerful tool if you want to quickly to get a job done. 
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7.19 Changing Background of Object 

To change the background of an object using the “keying effect”, follow the steps listed below. 

Figure 7.50: Green Screen Car 

STEP 1:Import Image/footage in your composition, as shown in Figure 7.50. 

Figure 7.51: Key Light panel 
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STEP 2: 

Open “EFFECT and Preset panel” > Search Key-light effect > Drag and Drop this effect on the 

layer. A new window, the Effects control panel, will open on the left side of your composition, 

as shown in Figure 7.51 

Figure 7.52: Keying car 

STEP 3: 

Select a screen color to apply effect on that particular color in footage > Click on an eyedropper 

tool and select the color closet to the subject as shown in Figure 7.52. 

Figure 7.53: Keying car composition 
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STEP 4: 

After selecting the color, you will notice green color shading left in some parts of the footage. To 

get rid of this, click on the screen mat drop-down button > Increase value of “clip-black” and 

“Clip-white” as per your desired preference, as shown in Figure 7.53. 

Figure 7.54: Timeline Preview 

STEP 5: 

Let’s change the background of the footage > Import your background in the 

composition and place the background layer under your original footage, as shown in 

Figure 7.55. 

Figure 7.55: Composition Preview 

STEP 6: 

After changing the background, your final composition will look like this, as shown in Figure 7.55. 

7.20 Exporting The Footage: 

In the above section, we have already discussed how to Render the final footage using render 

queue/adobe media encoder. Check chapter 6, section 10 (rendering and output) section. 
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Key Points 

1. 2D shapes can be characterized as level plane figures with just two measurements 

length and width. 

2. 3D shape can be characterized as a strong figure or an article or shape with three 

measurements Length, width, and tallness. 

3. An invalid object is an invisible layer that has every one of the properties of a noticeable 

layer, so it very well may be a parent to any layer in the creation. 

4. Color balancing is defined as applying an effect or preset to change the look of the 

composition instead of changing the whole color. 

5. Expressions are pieces of code written in the JavaScript language with the sole the 

motivation behind adjusting the After Effects layer properties. 

6. Keying is characterizing straightforwardness by a specific shading 

or luminance quantity in a picture. 

Activities. 

1. Create a 3D text layer in Adobe After Effects? 

2. Apply shadows and light to the 3D text layer? 

3. Create a Null object in composition? 

4. Apply multiple effects to the 3D text layer. 

5. Render and export a project using an adobe media encoder. 

6. Perform animation on objects, lights, points of interest, and auto orient. 

7. Perform the 3D operations on an image? 

8. Apply tracking and stabilization objects. 

9. Preform expressions on image / video / text? 

10. Apply rain effect in a desert scene 

Notes for Teacher. 

1. Explain the concept of 2D and 3D with real-world objects. 

2. Elaborate the “Role of lighting” in 3D Scenes. 

3. Explain “Null object” to students by performing in after effects. 

4. Explain how to use multiple effects on a layer. 
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5. Explain the term Tracking using any real-life example. 

6. Explain what an expression is and how to select a proper expression for their 

requirements. 

7. Explain, uses, and application of keying with examples. 

 

 

Exercise 

Select the Most appropriate option 

1. Which of the following describe  2D shapes? 

a) Thickness  b) Length   c) weight   d) Length and width. 

2. Which of the following describe  3D shapes? 

a) Thickness  b) Length  c) weight  d) Length, width & Tallness. 

3. ROI stands for  ? 

a) Region of Interest     B) Region of intersection   

c) Point of interest     d) Region of Interpolation 

4. 3D layers have 

 axis modes? 

        a) 1         b)5        c) 10      d) 3 

5. A null object is a  layer? 

a) Unavailable   b) Unresponsive  c) Invisible  d) None of these. 

6. Motion tracking user interface has _____________regions and points?  

a) 1    b) 6    c) 2   d) 3 

7. Expressions are a piece of code written in  ? 

a) C++    b) HTML   c) Python  d) Java-script 

8. To track a face of an object  tracker is used? 

a) Motion tracker  b) Face tracker  c) Camera Tracker d) None of these 
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9.  On which principle, repositioning of shapes works: 

a) Queues   b) Stakes   c) Array   d) Both a & B 

10. Which effect is used to balance the color of a composition: 

a) Mate effect   b) Fill    c) Smoke  d) Tint 

 

Give short answer to the following questions 

1. Define “2D”, “2.5D”, “3D” concepts in after effects? 

2. What is a Null object in Adobe After Effects ? 

3. Define the term “Region of Interest.” 

4. Define “expressions.” 

5. Define the term “Keying.” 

6. Define rendering order of 3D layer in after effects? 

7. Name motion tracking features are in after effects. 

8. Define loops of expression? 

9. Define the order of render in after effects. 

10. How to identify the 3D layer. 

 

Answer the Following Questions in detail 

2. Explain the role of Camera and Lightning in 3D space? 

3. Explain the process of keying? 

4. Explain the rendering order of 3D layers? 

5. Discuss file extension for Adobe After Effects? 

6. Explain the purpose of tracking and stabilization? 
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Chapter 8 

MEDIA PRODUCTION MANAGEMENT 

 

 

In this section, student will be able to:  

• Define Media.  

• Define management.  

• Describe media production 

management.  

• Learn techniques of media 

management.  

• Determine strategies for delivery of 

human resource services.  

• Manage the delivery of human 

resource services.  

• Evaluate human resource service 

delivery.  

• Manage integration of business ethics 

in human resource practices.  

• identify prospects for sales.  

• Learn about to pitch services to client.  

• negotiate deal with client.  

• close the sales opportunity.  

• maintain Customer Database.  

• provide customer services.  

• develop a personal budget.  

• develop long term personal budget.  

• Identify ways to maximize future 

finances.    

• Define Project Management 

• Know about the phases of PM 
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8. Media Management 

8.1 Definition of Media  

Many definitions of media are possible. if we take media as communication, we may define media 

is a generic term, ‘media as the plural form of the word medium’, which means to communicate 

through a channel.  This channel can be described with anything from newspapers to Internet news 

blogs. All these channels are part of traditional to modern media. These both serve the purpose of 

spreading information in public by giving the public awareness of the surroundings.  

Communication between channels involves media. This term is specifically used in the computing 

context. Everything that can affect or inspire the public, namely the telephone, television, and the 

Internet, is regarded as media. The communication media refers to devices used to store data (i.e. 

hard drives, CD-ROMs, floppy disks, USBs, etc.). The devices which, transmit data (cables, 

wires), or even transmit data under multiple forms (video, sound), podcasts, etc.) all are media. 

In modern times, the media is increasingly inclined to the digital aspect of the field.  

Current computerized media incorporate all types of communication that work by phenomena of 

sending electronic data across the world through PC organizations. Also, the underwater fiber 

optic cables. All these fiber optics are connected in a specific topology. A portion of these cutting-

edge types of media, like the Internet or web-based media channels (Facebook, Twitter, 

Instagram, and so on) have changed our daily life.  

Another way to categorize media is Mass media. Mass media refers to the process of sharing 

information with the public. This sharing of information can be done by any channel of media. 

These channels include film, radio, books, music, or television. The role played by an audience is 

only listening or viewing information but they cannot send feedback.    

8.2 Definition Of Management  

Management is a term we usually use in daily life by saying “how to manage something?”. Let’s 

take an example here. Suppose, you are a member of the school debating society and you are 

responsible for conducting the whole debating event. Now you know that you have some friends 

who are doing a debate in the Urdu language and some are going to do debate in the English 
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language. So, you plan with your other member of the debating society to manage (plan) the 

things. You write the names of students who are debating in Urdu. Similarly, you make another 

list for the students who are going to debate in the English language.   

This small planning activity in which you make a list, then arrange their names according to the 

order in which they will come on stage is called as management of an event. A simple definition 

of management is as under: - 

“Management is the Planning, organizing, staffing, directing and controlling functions or 

processes.”  

There are five important points in this definition that needs to be understood clearly.  

Planning  

Planning is considered the first part of management. It is a question of defining the goals, future 

directions of the organization, and determining the missions and resources necessary to achieve 

them. As it has been discussed in the previous example, where you started planning by writing 

the names of each student in two lists.  

Organizing  

Organizing is the second part of management. It means to put something to carry out a well-crafted 

plan. Organization involves how a person will assign resources and coordinate across all 

processes. To continue with our example here, first, you make a list of all students now you will 

arrange their names in the order in which they will be appeared on stage.  

Another way is to arrange a list according to the relevance of topics.  

Staffing  

Staffing is the third part of management. Staffing means finding the right person with the 

appropriate qualification and skills to complete a task. For example, you have organized the debate 

event, now you need to look for an announcer/presenter to help you in starting the event, calling 

out the names of all participants of the event and closing of the event.  

Directing  

This is the fourth part of management. process of directing is done by allowing a person to perform 

the job at right time. Just like your debating event where you will direct your presenter about the 
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plan organized earlier. This directing is also done by your teacher (supervisor) who always asks 

students to revise the previous lesson before starting a new one.  

Controlling  

The last part of management is controlling. Controlling refers to how a deviation from the planned 

task is handled by the person in control. The one who has planned and organized is also 

responsible for controlling the things that don’t appear the way they should. For example, 

Suppose, one of the debaters takes extra time in the, event, then you should be controlling the 

situation. One way is to signal the debater (participant) not to exceed the time limit. Another way 

is to shorten the time of the next debater.  

   

8.3 Media Production Management  

Media production management is a vast field. Media production management is not only limited 

to the media industry but also linked with the entertainment industry and other industries’ media 

sections. As you have known that media is not only limited to radio, TV, and newspaper. It is also 

linked with social media and multi-media. The process of media production management is 

described as   

“Managing production, direction, controlling media functions and businesses.”  

The term media production management is also known as “Operational Management.” It is a 

branch of media management. Under media management, all the process from strategic 

management to production management all belongs to it. Media production management plays an 

important role while defining processes like capturing, processing, moving, and editing media 

files.  

Media production management is about ensuring the creative use of resources. The timely 

completion of a project within its budget. The art of managing media production is closely 

connected with the analytical skills of the person.  

Activity 

Can you think about one more example of controlling? 
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The Media Production management process involves the making of a motion picture, video, TV 

show, commercial, or any audio/video element provided to viewers over the internet or 

transmitted through cable, broadcast radio wave, social media, , a satellite or in a printed form. 

The production refers to the stages required for the completion of a media project. These stages 

include Development, Pre-Production, Post-Production, and Distribution.   

Development: It is defined as the foundation of production. In the course of development, the 

production team discusses the audience, background, ideas, and intentions. The choice of 

production equipment and technology takes place at this stage.  

Pre-production: This is the planning step. Considering the type of public, description, background, 

and the production is planned. The situation is planned means how it will affect the viewers. 

Storyboards and notes are used to document things in the planning.  

Production: Production is the real filming of the video.  It is the process of working from raw 

materials.  The considered plan is recorded in this phase. It may be an individual process or it may 

include several people with specific roles. Filming of the product is highly focused in this phase.   

Post-Production: Post-Production is the stage that brings out a refined product which is either a 

video or photograph. Once the film or video is shoot, there are series of tasks require to make it a 

good quality film. Editing, color grading, adding sounds, and voiceovers all are part of this stage. 

In post-production, a raw form of film is processed to make it reach its full potential.  

Distribution: Distribution is a process, which involves selling / handing over the produced 

film/video. Once post-production is carried out smoothly, marketing of the product is the next 

challenge. Finding the right audience was done in the pre-production stage but getting to them is 

important. Getting to your viewer through the right medium includes advertisements, posters, 

banners, and social media marketing. In distribution, you also involve third parties to collaborate 

with you. This collaboration reaches different audiences at the same time. So, more people get 

introduced to your product (i.e., film/video).  

8.4 Techniques Of Media Management  

Media management is the process of defining goals and achieving them. The whole process 

involves several people who work together at different stages. There are important techniques that 

help in better media management.  
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Find the Right Channels/Medium:  

Finding the right channels is the most important aspect a media manager should know about. In 

the past, when the only medium was a newspaper and people use to share information by verbal 

communication. Till now many mediums/ (channels) have been appeared for example, TV, Radio 

and the Internet.   

The right channel can be found by learning about audience interest. Gather information about their 

age, likes, and dislikes, what kind of film/video or photographs do they like to see. All such 

questions need an answer which will help you in identifying the perfect match of audience.  

Create value:  

By creating value means the right audience will always like good quality content. To create value 

in work involves adding high-quality images, proper editing, and good textual content. Another 

example of value creation is shooting a video and some photographs for Defense Day. You choose 

to put this content on social media. Many people will like your work because you choose the right 

work for the right audience at the right time and place.  

Connecting with Audience:  

Connecting with audience technique is used to bridge the production team with an audience. The 

distribution of your produced product needs attention from the audience. In a traditional medium 

where only interaction is limited. Social media has opened a gate for endless communication 

between the media and the audience. People now like to provide feedback and ratings to things 

they watch. Such ratings help the product gain popularity.  

Use Team Skills:  

This technique is useful whether you are working in media management or at home. Every 

member of your team is skillful. Every member knows something that you don’t know. To utilize 

each member's skills, one must collaborate with his team members.  

Understand clearly their strengths (areas where a specific person is good) and weaknesses, also, 

areas where a specific person is not good enough). Decide on each member's grouping with others. 

Once you make balanced groups of people with the best skills. You have done a great job towards 

the success of your project.  
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Innovate:  

Innovation and the creation of good things will always lead you to success. Don’t be afraid to do 

experiments while learning and using a new skill.  innovation means transformation. It will help 

you learn new things in new ways. You can find several ways to do the same thing and thus 

choosing the best one. Such attitude of innovation is good in building experience for beginner to 

expert.   

 Activity 

Ask your friends about their strengths and weakness. 

  

8.5 Determine Strategies for Human Resource Services  

Human resource services are the process of finding, selecting, hiring, and training of workers. All 

those activities that involve workers are carried out by the human resource department.  

When we mix both the human resource services with strategic management. As a result, we 

determine the strategies that will help the HR service to perform efficiently.  

Human Resource Services is the discipline in which strategically place people according to their 

strength will achieve a competitive advantage as compared to other businesses.  

A strategic approach to Human Resource Services helps in achieving better job results, better 

employee recognition. It highlights the areas which need attention first. It also boosts the revenue 

of an organization.  

The following are the strategies determined for Human Resource Services:  

Precise Requirements for Employing:  

The first strategy is to determine the accurate requirements for the person being hired. The job 

description should focus on important details. Unnecessary details should be avoided to make 

things clear and short.  

The preciseness of text will also take less time for the job applicant to match his/her details.  
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Selection of Qualified Individuals:  

The second strategy for human resource services is to select highly qualified persons for the job. 

Understanding that those qualified individuals are good for your company is a strong strategy.   

Training of Employees:  

The training of employees is the process in which an organization spends its resources to train 

employees. The whole process involves experts from different departments having experience of 

different levels conduct such training sessions. In these sessions, employees are encouraged to 

learn new things. Performance is also graded. In long term, we can say that training needs time 

but is fruitful for organization prospects.  

Appraisals:  

The term appraisal means to give awards to high performers in your organization. This term might 

be new to you but it is simple as you won a race and as a reward, you were given a gift as an 

appraisal.   

Appraisals are beneficial when organizations want the growth of its employee. Employees tend to 

perform well if incentives are given on time as a reward.  

8.6 Manage The Delivery of Human Resources Services  

Human Resources Service delivery is the process of managing all things from employee hiring to 

its retirement. On-boarding and payroll are also included. The whole lifecycle of employee stay 

at one organization is managed by HR Service delivery.  

The following are the ways that allow HR persons to manage Service delivery efficiently:  

Service Level Agreement (SLA): An SLA is an important document that is signed between two 

or more parties. The purpose of this agreement is to note down all conditions. Properly note all 

important points and don’t miss anything. The rule of thumb is to not sign this official document 

before each party is satisfied with the agreement.  

Quality Assurance-QA is the way of conforming to the needs and standards of governing bodies. 

QA is defined  

as doing things according to some pre-defined standards so that desired quality is met.  
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The field of Quality Assurance is vast and many people prefer to be in this field because once a 

product is made. It should be tested against some standards. For example, you have shot a video 

and now you want to check its quality. It will be determined by watching the content, which 

editing technique is used, Is the goal of the video fulfilled or not. If you can answer these concerns, 

it means you have produced quality content.  

8.7 Evaluate Human Resource Service Delivery  

To evaluate is to assess the performance on some parameters. The following are how we can 

evaluate the Human Resource Service Delivery:  

• It can be evaluated by taking feedback in form of face-to-face sessions and comments. 

Open surveys and satisfaction surveys are also helpful in this regard.   

• After collecting feedback from all your concerned parties. Combine these surveys 

analyses. Formulate a strategy on the analysis performed. This role of action should be 

conducted within an organization. No third party is involved in the analysis.  

• Human Resource Service Delivery is responsible for correct analysis performed. 

Recommendations should align with the analysis. The new strategy plan agreement is 

drafted again. It should contain how new amendments will affect the organization? How 

these practices are implemented with change in previous agreement (SLA).  

8.8 Manage Integration of Business Ethics in Human Resource Practices  

Ethics is a fundamental part of any field. Ethics define the way of doing some work professionally. 

A person's work ethics define their role in an organization. Ethical behavior is a way of conduct 

and is divided into two parts:  

• Personal Values: Personal values are those values that you learn from home. It is related 

to your personal experience.  

• Cultural Values: Cultural values are based on individual's beliefs and expressions of a 

group.   

At the organizational level, the values or ethics determine right or wrong according to some 

business rules. As mentioned earlier, individual beliefs might affect organizational motives. Some 
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ethics which are solely drafted for business should be applied within an organization because they 

help in achieving better quality.  

One should understand properly the code of conduct, It maintains workflows according to pre-

defined or standardized solutions. Monitoring the feedback and perform better decisions on 

received feedback is also part of an integration of ethics in HR. Business ethics can be determined 

by observing organizational behavior and working environments of an organization. 

It is advised to keep organizational decisions secret so that no break/theft of information might 

happen.  

Customer Services and Sales   

Customer services refers to assistance and guidance a company provides to its customers before, 

during, and after a customer buys a product. The quality of customer services cast strong impact 

on the customer satisfaction. Customer satisfaction is one of the key factors that lead to rise in 

sales.   

8.9 Identify Prospects for Sales  

A sale is an exchange of cash for products, services or other property. A sales prospect is a person 

who could become a buyer for business products based on certain traits or metrics. Identifying 

sales prospect helps to take benefits from different available mediums effectively. Here are some 

ways through which prospects for sales can be identified:  

• Ask for referrals: Your current customers may know people who is willing to buy your 

business's products or services. Referrals can build great sales prospects because the 

referrals are already familiar with your business.  

• Use social media: Social media is a great source for sales and marketing in this era. You 

can easily use it in marketing to increase your presence. Through social media you can 

increase your brand awareness, attract your potential customer and increase your sales.  

• Use prospecting tools: There are number of tools available in the market for salespeople 

through which they can identify the prospects for sales. e.g., Prospect.io, which helps you 

find emails and contact potential customers.  
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• Use email marketing and direct mail: Email marketing is still the most effective marketing 

strategy beating all other new techniques through which you can easily identify prospects 

of sales. Potential buyers and returning customers are sent emails about new products and 

seasonal sales.   

• Website is also a right prospecting tool: With the correct and useful content on your 

website, you can convince customers to join your newsletter. You can use to your website 

to catch leads and deliver them to your salespeople.  

8.10 How to Pitch Services to The Client  

In selling techniques, a sales pitch is considered as a presentation where the salesperson explains 

the benefits of the services to the customer to try and convince him to buy it.  

Following steps can be taken to successfully pitch to a potential client.  

• Start with the problem: Always start by identifying their problem. Ask the customer 

questions to learn more about the problem. The questions help to identify the real need of 

a buyer.   

• Methodology/solution: After learning about the problem, present all of the available 

services to the customer.   

• Identify the problem your company solves:  The customer then decides which offer suits 

them best. They may ask more about the offer they are interested in.    

8.11 Negotiate Deal with Clients  

Negotiating with clients is very important for carrying your business to greater heights. It is an art 

that helps you negotiate with your clients. You will always run into someone who wants a better 

deal.  

Here are the things that you can use to easily negotiate with your clients. This will help you to do 

better negotiations with a more positive mindset.  

• Prioritize your goals: If you are going to negotiate with the client you should always 

prioritize your goals. The priorities  
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of your business are kept in mind while being flexible to the customer.  

• Must Know your alternatives solutions: This gives you strength in negotiations because at 

some point, it is more useful to try and offer the alternatives to the client. This way they 

will either be persuaded more into buying the service, or choosing another one.   

• Show that you want to negotiate with client: While presenting the alternatives, you should 

show that you want to negotiate. There should be some sort of flexibility in your offers if 

your business model allows it.  

8.12 Close The Sales Opportunity  

Closing the sale is defined as the process of obtaining an agreement from the customer to buy the 

service or product.   

Better Timing to Close: When trying to close a sale with customer, look for buyer’s signals and 

the things customers do or say to buy. These signals may include:   

• Facial expressions of customer• Body language of customer  

• Comments for services.  

General Rules for Closing the Sale:  

• Recognize closing opportunities on time   

• Help customers make the decision.   

• Create an ownership mentality for the customer.  

8.13 Maintain Customer Database  

Your customer database, no doubt, is the most useable and valuable resources in sale and 

marketing. You can reuse it in future and make your customer permanent.   

Here are the few tips that will help you to incorporate this into your business processes.  

• Capture your data correctly: Ask the buyer to give his contact info, mail and email 

addresses. Make sure that you convince the customer to give the correct credentials.  

• Contact your database often: Always be in touch with your contacts and keep updating 

them about new offers and products.   
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• Let customers make updates:  Always give your customer opportunity to update their 

contact details of their own accord.  

8.14 Provide Customer Services  

Providing great customer service means following good habits like valuing customers’ time, 

having a pleasant attitude, and providing knowledgeable and resourceful information.  

Here are the ways to deliver great customer services.  

• Know your Product: Being the seller of the product you need to know all about your 

product. Having accurate knowledge about your product is essential in pitching it to the 

customers.  

• Maintain a positive attitude: Always maintain a positive attitude towards your customer. 

Positive attitude will lead towards better customer services.  

• Solve problem with creativity:    

Bad experiences lead to losing potential future clients. If they have had a bad experience 

with the customer services or the product itself, then the customer may never come back 

next time.   

Activity 

Maintain feedback record 

Maintain record of regular client 

   

8.15 Develop A Personal Budget  

A business company must improve its budget to ensure that it spends money well and does not 

spend more than it can afford. Likewise, individuals who want to monitor their daily expenses 

must develop their own personal budget. A personal budget simply tracks money a person spends 

versus the money he/she earns.   
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Why budget is important  

Personal budget is useful in reaching certain financial plan, saving plan, and for paying debts. It 

is also important for better financial health. Developing personal budget will also prevent you 

from overspending or spending the money you need in future.  

Steps to develop personal budget:  

• Note your Income  

You may overestimate what you can afford if you do not keep your income in mind. 

Therefore, the first step to develop your personal budget is to note your personal income 

that you earn from different sources.   

• Track your spending  

It is necessary to track of your daily spending and categorize the areas where you spend. 

By doing this, you can easily identify that in which areas you should not be spending your 

budget.  

• Set your goals  

Before refining the information that you have tracked, make set of goals you want to 

accomplish in long or short term. Short term goals should not take more than one year to 

complete.  

• Make a plan   

Identify variable and fixed expenses you expect to have in coming months. After 

calculating the fixed expenses, you can easily estimate how much budget you have left 

for variable expenses.   

• Cut your want-to-have expenses  

Having documented your income and spending, it is easy to keep track of the money you 

have to put towards your goals. You should reduce the expenses being spent on things you 

want to have but you don’t need to have.   
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• Keep checking in  

To stay on track, you should keep reviewing the budget you are spending and the plan you 

made.   

8.16 Develop Long-Term Personal Budget  

Long-term personal budget is meant to achieve long-term goals. These goals can take several 

years or decades to reach. Your long-term goals often involve more money and more attention 

than short-term goals. Some of the long-term goals are:  

• Paying off a debt  

• Starting or investing in a business  

• Buying a house  

The following are the steps to develop log-term personal budget:  

1. List all long-term goals you have to achieve  

2. Estimate the money needed to achieve those goals  

3. List all of your fixed essential expenditures  

4. Estimate and list your variable expected expenditures  

5. Estimate the amount of income that is left and is available to be invested in future goals  

6. Choose investments that will help you get there  

7. Figure out how much you need to put aside monthly  

8.17 Ways To Maximize Future Finances  

There are different ways through which you can maximize your future finances. Some of them 

are mentioned below:  

• Record your expenses  

• Make a monthly budget  

• Identify your income being spent on wants and needs. Then cut out the expenses on 

“wants”  

• Find ways to cut your expenses  
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• Set saving goals  

• Do a monthly or weekly review of budget plan and the money you spent  

• Do a market survey to identify the service or product needed in your city/area. Start a 

business or invest your money in an established business  

8.18 Definition of Project Management 

Project management is the application of processes, methods, skills, knowledge and experience to 

achieve specific project objectives according to the project acceptance criteria within agreed 

parameters. Project management has final deliverables that are constrained to a finite timescale 

and budget. 

A key factor that distinguishes project management from just 'management' is that it has this final 

deliverable and a finite timespan, unlike management which is an ongoing process. Because of 

this a project professional needs a wide range of skills; often technical skills, and certainly people 

management skills and good business awareness. 

8.19 Phases of Project Management 

Phase 1: Project initiation 

The project initiation phase is the first stage of turning an abstract idea into a meaningful goal. In 

this stage, you need to develop a business case and define the project on a broad level. In order to 

do that, you have to determine the need for the project and create a project charter. 

The project charter is an important document consisting of details like the project constraints, 

goals, appointment of the project manager, budget, expected timeline, etc. 

Once you have the project goals and project scope, identify key project stakeholders–the people 

who are to be involved in the project. Create a stakeholder register with the roles, designation, 

communication requirements, and influence. 
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Phase 2: Project planning 

The project planning stage requires complete diligence as it lays out the project’s roadmap. Unless 

you are using a modern project management methodology like agile project management, the 

second phase of project management is expected to take almost half of the entire project’s 

timespan. 

Check out how to implement an effective project roadmap. 

In this phase, the primary tasks are identifying technical requirements, developing a 

detailed project schedule, creating a communication plan, and setting up goals/deliverables. 

There are several methods of setting up the project’s goals but S.M.A.R.T. and C.L.E.A.R. are the 

most popular. 

Here is our Customizable Marketing Templates to try for Free: 

– Marketing Plan Template to Streamline your Marketing Efforts 

– Social Media Calendar Template for Social Media Planning 

S.M.A.R.T Goals: 

https://kissflow.com/project/steps-to-create-successful-project-plan/
https://kissflow.com/project/agile/agile-project-management-methodology/
https://kissflow.com/project/project-roadmap/
https://kissflow.com/project/basics-of-project-scheduling/
https://kissflow.com/project/template/marketing/marketing-plan-template/
https://kissflow.com/project/template/marketing/social-media-calendar-template/
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The ‘SMART’ criteria ensure that the goals you set for your project are critically analyzed. It is an 

established method that reduces risk and allows project managers to make clearly defined and 

achievable goals. 

The acronym SMART stands for 

C.L.E.A.R. Goals: 

The ‘CLEAR’ method of setting up goals is designed to cater to the dynamic nature of a modern 

workplace. Today’s fast-paced businesses require flexibility and immediate results and CLEAR 

can help you with that. 

https://kissflow.com/project/roles-and-responsibilities-of-project-manager/
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The acronym for CLEAR stands for “Clear, Limited, Emotional, Appreciable, Refinable” 

During the planning stage, the scope of the project is defined. There is a possibility of changing 

the scope of the project demands it but the project manager must approve the change. Project 

managers also develop a work breakdown structure (WBS), which clearly visualizes the entire 

project in different sections for the team management. 

Phase 3: Project execution 

The project execution stage is where your team does the actual work. As a project manager, your 

job is to establish efficient workflows and carefully monitor the progress of your team. 

Another responsibility of the project manager during this phase is to consistently maintain effective 

collaboration between project stakeholders. This ensures that everyone stays on the same page and 

the project runs smoothly without any issues. 

You can take help from the best project collaboration tools that are available in the market. They’ll 

not only make your life easier but also improve efficiency and increase the productivity of your 

team. 

Phase 4: Project monitoring and controlling 

In the project management process, the third and fourth phases are not sequential in nature. 

The project monitoring and controlling phase run simultaneously with project execution, thereby 

ensuring that objectives and project deliverables are met. 

As a project manager, you can make sure that no one deviates from the original plan by establishing 

Critical Success Factors (CSF) and Key Performance Indicators (KPI). 

During the monitoring phase of project management, the manager is also responsible for 

quantitatively tracking the effort and cost during the process. This tracking not only ensures that 

the project remains within the budget but also is important for future projects 

  

https://kissflow.com/project/project-team-management-software/
https://kissflow.com/project/project-execution-phase/
https://kissflow.com/project/project-stakeholder-management/
https://kissflow.com/project/project-collaboration-tools/
https://kissflow.com/project/project-monitoring-and-controlling/
https://kissflow.com/project/project-deliverables/
https://kissflow.com/project/project-management-dashboard/
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Phase 5: Project closing 

This is the final phase of the project management process. The project closure stage indicates the 

end of the project after the final delivery. There are times when external talent is hired specifically 

for the project on contract. Terminating these contracts and completing the necessary paperwork 

is also the responsibility of the project manager. 

Most teams hold a reflection meeting after the completion of the project in order to contemplate 

their successes and failures during the project. This is an effective method to ensure continuous 

improvement within the company to enhance the overall productivity of the team in the future. 

The final task of this phase is to review the entire project complete a detailed report that covers 

every aspect. All of the necessary data is stored in a secure place that can be accessed by project 

managers of that organization 

Key points 

 If we take media as communication, we may define media is a generic term, ‘media as the 

plural form of the word medium’, which means to communicate through a channel. 

 Mass media refers to the process of sharing information with the public. 

 Management is the Planning, organizing, staffing, directing and controlling functions or 

processes 

 Media production management is not only limited to the media industry but also linked 

with the entertainment industry and other 

 Pre-production: This is the planning step. 

 Post-Production is the stage that brings out a refined product which is either a video or 

photograph. 

 Innovation and the creation of good things will always lead you to success 

 The term appraisal means to give awards to high performers in your organization. 

 

Notes for Teachers 

 Discuss with students about the media production management as a business 

https://kissflow.com/project/project-closure-phase/
https://kissflow.com/project/team/how-to-increase-team-productivity-at-work/
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 Help students in understanding step by step procedures of a media house 

 Ask students that which job role attracts them 

 Help students in getting sources for finance and budget management 

 Brief students about the entire cycle of project management  



 

215 
 

Exercises  

Select the Most appropriate option 

1. Mass media is   

a) For experts only  

b) For beginners only  

c) For public  

d) For students only  

2.  Management is about  

a) Controlling, Planning, Staffing.  

b) Planning,  Organizing,  Staffing,  Directing,  and Controlling.  

c) Staffing,  Planning,  Directing,  Organizing,  and Controlling.  

d) Communicating, Abstraction, Organization.  

3. One of the following is not a technique of media management.  

a) Innovate.  

b) Create Value.  

c) Connecting with the audience.  

d) Shooting Video.  

4. Which of the following is not considered as the pitching of a service:  

a) Start with the problem.  

b) Methodology/ Solution.  

c) Translation to problems.  

d) Identify the problem your company solves.  

5. Identify ways to maximize future finances:  

a) Understanding the concept of cash flow.  

b) Understanding the camera lens.  

c) Lightning of an object.  

d) Selecting the right location for an indoor shoot.  
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Give short answer to the following question 

1. Identify the five major components of management.  

2. Write any two techniques in managing HR Service delivery.  

3. Write about the concept of cash flow.  

4. Briefly explain the concept of a personal budget.  

5. Write any two strategies for human resource services.  

Answer the following Questions in detail 

1. Write a note on management.  

2. Write a note on negotiating a deal with the client.  

3. Evaluate the process of Human Resource Delivery.  

4. Write a note on the identification process of sales prospects.  

5. Write a note on maximizing your future finances.   
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